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Welcome!

 

In a few short years the world has changed. Once music making was 
strictly divided between those with access to professional studios, ex-
pensive equipment and other musicians, and those whose music mak-
ing was confined to the realms of second rate equipment, limited funds 
and a good deal of dreaming.

We at Steinberg are pleased to be part of the continuing revolution 
that has broken down these barriers, allowing anyone with musical am-
bitions to realize their true musical potential.

Cubasis VST 2.0 – the program you now have in front of you – embod-
ies the experience of over fifteen years of Steinberg history. Together 
with a Macintosh computer, it provides an excellent framework for 
making music on computers.

Karl Steinberg              Manfred Rürup
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About Cubasis VST...

 

Now that you have Cubasis VST, which is a version of Cubase, you be-
long to one of the largest music software user groups in the world. 
Cubase is a family of music software, ranging from the easy-to-under-
stand package for the beginner to professional tools for the most de-
manding applications. That's the Cubase advantage, Cubase grows as 
you develop musically. 

Cubasis VST 2.0 was created as a result of years of experience in both 
software engineering and listening to our users. The users of our soft-
ware were always an important information resource for how the pro-
gram could be further developed. With the rise of the Internet this whole 
aspect has taken off. Instead of just communicating directly with Stein-
berg, our users have now become a vibrant and dynamic group, driving 
the direction of future Cubasis and Cubase VST versions. And with the in-
troduction of the InWire technology, the interaction between our users 
has reached a new high point as they actively produce music live to-
gether in the www.cubase.net Internet studios. If anyone tells you that 
computer musicians are a lonely breed, don't believe them.

See you out there…

Your Steinberg Team.

www.steinberg.net
www.cubase.net
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How you can reach us

 

The Help menu contains direct links to Steinberg’s web pages. These al-
low you to get technical support, answers to frequently asked ques-
tions, information about new products, upgrade offers and other 
important info.

 

❐

 

For the web links to work, you need to have a working Internet connection 

 

and properly set up browser software.
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What is Cubasis VST?

 

Cubasis VST is an application that allows you to record, edit and mix 
music. Cubasis VST records two types of musical information, digital 
audio and MIDI. It allows you to do the following (among other things):

 

• Record any sound source such as a microphone, guitar, etc.
• Record MIDI data from synthesizers or other MIDI instruments.
• Play back up to 64 Tracks in any combination of MIDI and Audio Tracks (with up 

to 48 separate channels of audio)!
• Play VST Instruments – software synthesizers contained within Cubasis VST. 

Four different VST Instruments are included with the program, and others can 
be purchased or downloaded from the Internet.

• Apply cut and paste techniques to your music, to rearrange recorded parts.
• Perform detailed editing of your MIDI recordings.
• Mix your music, applying effects and EQ to your audio recordings.
• Create a mixdown audio file on your hard disk, in AIFF or MP3 format.
• Collaborate with other Cubasis VST users on the Internet, using the InWire/

RocketPower technology.
• Synchronize the music to any QuickTime movie – with Cubasis VST you can add 

music to your films!
• Make printed scores.

 

Real time

 

One specific point to note about Cubasis VST is that it operates in com-
plete real time. You don’t need to stop the music to perform any type 
of editing, switch between windows or anything else. You can even 
Save to disk while playing!

 

Undo/Redo

 

Practically any operation in Cubasis VST can be undone, using the Undo 
item on the Edit menu. After something has been undone, this item 
changes to Redo, allowing you to “undo the undo”.
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What is Digital Audio?

 

“Audio” is any sound source that you can connect to the sound input of 
your Macintosh computer (or, if your Mac lacks audio inputs, to an au-
dio interface connected to the computer), a microphone, an electric 
guitar or similar. “Digital” we say because the computer converts the 
audio signal to numbers, which Cubasis VST captures and stores on 
your hard disk. The fact that the sound is converted to numbers opens 
up enormous possibilities in terms of manipulation of recordings.

 

What is MIDI?

 

MIDI is a type of control information used with synthesizers. Let’s 
explain this with an analogy: Your computer can send messages to a 
printer about how you want a page to look. The printer then takes care 
of converting this information to the actual “ink” on paper.

With MIDI the synthesizer works much like a “musical printer”: the com-
puter sends information to it, specifying which notes you want it to 
play, and it takes care of actually creating the audio.

One of the advantages of this technique is that a recording made with 
for example a piano sound can be played back with a harpsichord, 
brass or guitar sound, just by changing settings on the synthesizer.

General MIDI (abbreviated GM) is an additional specification for MIDI 
instruments. If an instrument is General MIDI compatible, it will have a 
common, wide ranging set of sounds built in (piano, bass, drums, brass, 
strings etc). If you create music with a General MIDI compatible instru-
ment it can be played back on any other GM instrument and the music 
will sound more or less the same. This allows you to share your Cubasis 
VST songs with other people, and even publish your works in a com-
mon data format, for example on the Internet!

Cubasis VST also supports two expansions of the GM standard, called 
GS (Roland) and XG (Yamaha).
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The Main Windows in Cubasis VST

 

The Transport Bar

 

This is much like the transport control on any tape recorder. This is 
where you Play, Stop, “wind the tape” etc. But the Transport bar is also 
used for setting tempo, time signature etc.

These meters indi-
cate MIDI In (re-
cording) and Out 
(playback) activity.

These buttons are the equivalents 
of the transport controls on a 
regular cassette tape recorder.

The Time 
Signature Activates the 

metronome.

These are used for 
defining where to 
start and end 
recording and what 
section to Cycle.

Activates the 
Master Track. 

The tempo

This shows you the current Song 
Position in bars, beats and ticks

When you activate this, the 
program will cycle the sec-
tion between the Locators.
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The Arrange Window

 

This is where you record and assemble your music. Each Cubasis VST 
Song can contain several Arrangements, each with its own Arrange 
window.

Vertically, the Arrange window is divided into Tracks, letting you orga-
nize your recordings. You might use one Track for drums, another for 
bass, a third for main vocals, a fourth for vocal harmonies, etc.

The left part of the Arrange window is called the Track List:

This symbol indicates an 
Audio Track

This column shows you 
whether anything is being 
played back from the Track.

Click in this column to Mute 
(silence) a Track.

The Track’s channel

The name of the Track. 
Double click to change.

This symbol indicates a 
MIDI Track

This button opens the Inspector, in which you can 
make detailed settings for the selected Track.

The active 
(selected) Track. 
Recording always 
happens on the 
active Track.
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The right part of the Arrange window is called the Part Display. 

At the top of the Arrange window is a bar with various pop-ups and 
settings.

Time runs from left to right, 
as the ruler indicates.

Each recording you make appears in the 
Part Display as a box, called a Part.

The Song Position

The Left Locator The Right Locator

The vertical position of the Part shows you 
which Track it is on.

The horizontal position shows you where in the Song the Part starts.

The width of the 
box shows you 
the length of the 
recording.

In the Part you will see a visual 
representation of the recording.

Click here to listen to 
the selected Track only

The “precision” for editing 
operations, like moves and splits

This note value is used for 
the Quantize function.

The mouse pointer’s position 
in bars, beats and ticks.
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The VST Channel Mixer

 

This is where you mix your Audio Tracks, that is, adjust the levels (vol-
ume) and stereo panning. The section to the right is the Master section, 
where you adjust the final output level of the mix.

In addition, each audio channel has a two band parametric EQ, two ef-
fect sends and one insert effect slot.

Mute and Solo buttons

Pan controls

Level fader

Level meter

Mixer automation controls

Clip indicator

Input level 
switch

Master faders

EQ section

Insert effect slot

Effect sends
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The VST Instruments Window

 

This is where you activate and manage VST Instruments, software syn-
thesizers (or other sound sources) contained within Cubasis VST. You can 
have up to four different VST Instruments activated at the same time. 
Each VST Instrument has its own control panel in a separate window.

 

The VST Instruments window (top) and the Neon control panel.
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The MIDI Track Mixer

 

This is one of the places where you can adjust the levels, panning and 
other parameters for the sounds created by your MIDI synthesizer. If 
you use MIDI instruments that are compatible with one of the stan-
dards GM, GS or XG, you can also use this mixer to select sounds for 
each MIDI channel.

 

The Audio Pool

 

This window lists all your audio recordings, allowing you to manage 
them in various ways.

Mute and 
Solo buttons

Pan controls

Level fader

Level (velocity) 
meter

Mixer automation 
controls

Mutes all Audio 
Tracks.

This is a file containing an audio recording.

These are segments that play parts of the file. 
By dragging segments into the Arrangement, you can use the audio file in your Song.
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The MIDI Editors

 

There are three different editors for editing your MIDI recordings: 

 

Key Edit

 

This editor consists of a “grid” with the notes shown as boxes. The pitch 
of a note is indicated by the vertical position, and the note length is in-
dicated by the width of the box. This is the editor to use when you want 
quick graphical editing of notes and continuous controllers, such as 
modulation and volume.

Continuous Events

Notes
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List Edit

 

In this editor, all MIDI notes, controllers and other Events are shown 
and edited in a list. List Edit is useful when you want absolute control 
over values and positions, or if you are a “computer type of person”, 
used to numerical editing.

 

Score Edit

 

Here, the MIDI notes are presented as a musical score. Use Score Edit to 
print scores, or simply if you are used to working with musical notation.

The Event List The Event Display
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The Master Track List

 

This window allows you to add tempo and time signature changes in 
the Song.
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Minimum Requirements

 

To use Cubasis VST you need the following:

 

• A Macintosh with MacOS 8.6 or later installed and ready.

 

For more details about the computer requirements, see below.

 

• Normally, you can use the built-in audio hardware of the Macintosh. How-
ever, the latest range of Macintosh models do not have audio inputs, 
which means you will need some additional audio hardware to be able to 
record audio.

 

This hardware could be an audio card, an audio interface connected via USB, 
etc. See page 30.

 

For MIDI

• At least one MIDI Interface (or a MIDI instrument with a built-in computer 
connector), including the necessary cables.

• At least one MIDI instrument.

• Any audio equipment necessary to listen to the sound from your MIDI 
devices.

For Printing

• To print out scores, you also need a Macintosh compatible printer.
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Computer Requirements

 

Below, the minimum and recommended systems are listed. The follow-
ing sections describe each system component (processor, RAM, etc.) in 
more detail.

 

Minimum Requirements

 

• Power Mac 604e/200 MHz Processor.
• 128 MB RAM.
• 256 K Second Level Cache.
• Mac OS 8.6 or later.

 

Recommended Minimum System

 

• Power Mac G3/266 MHz or better.
• 192 MB RAM (when using Internet functionality).
• Mac OS 8.6 or later.
• Approved ASIO compliant audio hardware (for details, contact your local Stein-

berg distributor or visit www.steinberg.net).

 

Processing Power

 

The difference between running Cubasis VST on a faster computer and 
a slower one is noticeable in two areas:

 

Number of audio channels and real time processing

 

When you use Cubasis VST for recording audio, there is a direct relation 
between the speed of your system and the number of audio channels 
and, especially, the available real-time processing power (effects, 
equalizers, VST Instruments etc.).

 

Screen updates

 

Even when only working with MIDI or when preparing scores, you ben-
efit from using a fast computer. Scrolling, editing and manipulating ob-
jects is simply “snappier” on a faster machine.
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RAM

 

Each program you run on your Macintosh requires a certain amount of 
RAM. In Cubasis VST, the exact amount of RAM required depends 
largely on the number of audio channels you plan to use.

In addition, the RAM requirements depend on whether you plan to run 
other programs at the same time as Cubasis VST. The more RAM you 
have, the more programs you will be able to run simultaneously.

 

• To adjust the amount of memory assigned to Cubasis VST, use the Get Info 
function in the Finder.

 

See the Macintosh documentation for details.

 

Hard Disk

 

MIDI

 

Cubasis VST’s document files are relatively small, which means that 
MIDI recording in Cubasis VST puts little demand on your hard disk in 
terms of disk space.

 

Audio

 

For audio recording, it is very important to have a large and fast hard 
disk.

 

• The size of the hard disk determines how many minutes of audio you will be 
able to record. Recording one minute of stereo CD quality audio, requires ap-
proximately 10 MBytes of hard disk space. That is, eight stereo Tracks in Cubasis 
“eat up” 80 MBytes of disk space per recording minute.

• The performance of the hard disk has a significant impact on the number of au-
dio channels you will be able to record.
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Getting the Computer ready

 

Before you proceed you should have the computer set up:

 

• Make sure the computer is properly set up for normal use and check that 
all basic functionality seems to work as intended.

• Study the manuals that come with the computer and familiarize yourself 
with concepts such as file handling, clicking, double clicking, dragging etc.

 

Preparing the Computer for MIDI and Audio work

 

Defragmenting the Hard Disk

 

If you plan to record audio on a hard disk where you have already stored 
other files, now is the time to defragment it. Defragmentation reorga-
nizes the physical allocation of space on the hard disk in order to opti-
mize its performance. It is done with a special defragmentation program. 
Please consult your computer dealer for information on what software 
to use.

 

❐

 

It is crucial to the audio recording performance that your hard disk is defrag-

 

mented.

 

Turn off File Sharing

 

File Sharing may use processor power and “block” disk accesses, 
thereby slowing down the apparent performance of the computer.

 

Virtual Memory

 

Generally, we recommend that you deactivate Virtual Memory in the 
Memory control panel before launching Cubasis VST. If you don’t deac-
tivate Virtual Memory, the program will show a warning message on 
start-up.
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Making sure the Serial Ports (Modem and Printer Port) are available

 

❐

 

This is only relevant if your MIDI interface connects to the Modem or 

 

Printer port.

Disabling AppleTalk

 

Some printers and network utilities use the Printer port for something 
called AppleTalk. If you plan to use your Printer port for MIDI you must 
make sure AppleTalk is deactivated.

 

1. Open the Chooser and activate the printer or network symbol that uses 
AppleTalk.

2. Use the on-screen options to deactivate AppleTalk.

 

The Printer port can now be used for MIDI but not for software that requires Ap-
pleTalk. To use that software you must reactivate AppleTalk again.

 

3. Restart the computer to make sure the changes take effect.

Disabling software that uses the Modem Port or an internal Modem

 

Some modem and fax software that run “in the background” require 
the Modem port, which means it can’t be used for MIDI. Similarly, if you 
have a built-in modem, there may be software that “blocks” the Mo-
dem port. To use the Modem port for MIDI, disable that software.

The Apple Laserwriter 8 
driver is an example of a 
device that requires 
AppleTalk.

To use the Printer port for MIDI you must click this button (deactivate AppleTalk).
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Installing Additional Audio Hardware

 

The built-in audio hardware of the Macintosh works fine with Cubasis 
VST. However, as of this writing the latest Mac models have audio out-
puts only – no inputs. If this is the case with your computer, you need to 
install extra audio hardware to record audio with Cubasis VST.

 

Which Audio Hardware can I use?

 

For audio hardware (such as a PCI audio card or an audio interface con-
nected via USB or FireWire) to be usable with Cubasis VST, it has to 
meet the following criteria:

 

• It must be Macintosh compatible.

• It must have an ASIO driver.

 

ASIO is the protocol by which Cubasis VST communicates with audio hardware.

 

You will find a list of ASIO compatible audio hardware among the “Info 
Charts” in the Support section of www.steinberg.net. However, make 
sure to check the audio hardware manufacturers’ web sites for updated 
information and drivers.

 

Installation Guidelines

 

• When installing your audio hardware, make sure to follow the included 
hardware documentation.

 

For some audio cards, you may need to check hardware settings such as 
jumper switches, etc.

 

• You will also need to install drivers for the hardware.

 

This is usually done by running an installer application, included on the hard-
ware installation disc. Note that more than one driver may be installed – typi-
cally a general Macintosh driver for the hardware and an ASIO driver.

 

❐

 

Make sure to check the hardware manufacturer’s website for the latest 

 

driver versions!

• Make a note of where the ASIO driver for the hardware is installed!

 

You will have to copy this into Cubasis VST’s ASIO Drivers folder after installing 
the program (see page 34).
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Installing a MIDI Interface

 

Installing OMS

 

OMS is short for Open Music System – a protocol that allows Macintosh 
applications to communicate with MIDI interfaces, and also adds some 
capabilities to your MIDI system.

 

❐

 

If you are using a standard Macintosh MIDI interface connected to the se-
rial port(s), you don’t explicitly need to install OMS, since Cubasis VST can 

 

communicate directly with such interfaces.

 

However, even if your MIDI interfaces are directly supported by Cubasis 
VST, you may want to use OMS to take advantage of the following 
OMS-based features:

 

• Communication of data between programs.

 

With OMS you can transmit data between MIDI programs.

 

• A standard “database” with information on how your MIDI studio is con-
nected and what sounds are in the instruments.

 

This, together with the point above, allows you to integrate Cubasis VST with 
for example “MIDI librarian” software.

 

OMS 2.3.8 is included on the Cubasis VST installation CD-ROM, but is 
not automatically installed with the program. To install it, locate the file 
“Install OMS 2.3.8” on the CD-ROM, double click on its icon and follow 
the instructions shown on screen.

 

❐

 

How to set up the program for basic OMS use (i.e. communication with a 
MIDI interface) is described in the next chapter. You may also want to read 

 

the documentation for OMS itself, included with the OMS installation.
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Connecting the MIDI Interface

 

As of this writing, MIDI interfaces can usually be connected in one of 
two ways: to the USB port or to a serial (Modem/Printer) port. Note that 
older Macintosh computers may not have a USB port, while more re-
cent models have USB but no serial ports.

Regardless of the interface type, installation instructions for the MIDI 
Interface should come with the interface. However, here’s an outline of 
the necessary steps:

 

USB MIDI Interface

 

❐

 

You should have installed OMS before you install the USB MIDI interface.

1. Connect the interface to the USB port on the Macintosh, following the in-
stallation instructions for the interface.

2. Install the necessary system software for the interface.

 

This should be included on a CD-ROM or similar with the interface. At this point, 
you may need to run a setup application for the interface – again, follow the in-
stallation instructions.

 

3. Run the OMS Setup application.

 

This allows OMS to locate the USB interface. Follow the instructions on screen.

 

Single Serial Port MIDI Interface

 

1. If you only want to use one “simple” interface, decide to which serial port 
on the computer you want to connect it.

 

• If you don’t have any other equipment connected to the computer, choose the 
Modem port.

• If you already have something connected to the Modem or Printer ports, con-
nect the MIDI Interface to the other port.

 

The symbols for the Modem and Printer ports on your Macintosh.
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• If both ports are occupied, there may still be a way to connect your MIDI instru-
ment(s). Many MIDI Interfaces have “Thru” or “Out” connection for other devices 
and a “Thru” or “Select” switch. In one position this routes the signals to the MIDI 
interface. In the other position it lets the signals pass through the interface to 
the other device.

 

2. Make sure the switch described above is set to the position where the MIDI 
interface receives the signals.

3. If your interface has a “clock rate” setting (most don’t) which can be 
switched between 0.5 MHz, 1 MHz and 2 MHz, set this to 1 MHz. 

4. If the interface has a power supply and/or a power switch, turn it on.

 

Two Serial Port MIDI Interfaces or one “Double” MIDI Interface.

 

You can use two “simple” MIDI interfaces at the same time, one con-
nected to each serial port, for a total of 32 MIDI Channels. Some ven-
dors pack two MIDI interfaces into one casing, which is pretty much the 
same as using two separate standard interfaces. We refer to these as 
“double interfaces”.

 

1. Connect the interface(s) to both the Modem and Serial ports.

2. Make sure the interface is set to receive MIDI signals, that the clock rate is 
1 MHz (if it can be set at all) and turn on the power.

 

See above for details.

 

About Printers

 

If you intend to print, install the printer. Use the software included with 
the printer or some other software you already have installed (such as a 
word processing application) to verify that the printer works as expected.
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Installing the Software

 

❐

 

Before proceeding, read the Software Licensing Contract included in this 
package. By opening the disk pack or sending back the registration card, 
you are declaring yourself to be in agreement with the conditions in the 

 

contract.

1. Quit all applications so that you return to the Finder.

2. Disable any Virus protection software.

 

This is done by using control panels, or possibly by removing one or more Ex-
tensions and restarting the computer.

 

3. Put the CD-ROM in your drive.

4. Open and read the file “Read Me First” before continuing.
It may contain late breaking news pertinent to the installation.

5. Locate the Cubasis VST installer file and double click on its icon.

6. In the dialog that appears, select a folder on the hard disk on which you 
want the program to be installed, and click Install.

7. When the installation is finished, you will be requested to restart your Ma-
cintosh. Do so.

The program has now created a Cubasis VST folder on your hard disk, 
and also installed some files in your System folder.

8. Open the new Cubasis VST folder on your hard disk and check for “Late 
Changes” text files.
These list any changes to the program made after this manual was written.

9. If you are using audio hardware other than the built-in, locate the ASIO 
driver for the audio hardware (see page 30) and copy it into the ASIO Driv-
ers folder within the Cubasis VST program folder.
This makes the ASIO driver available to Cubasis VST.

10. Re-activate any Virus protection software you previously disabled.

11. Eject the Cubasis VST CD-ROM and store it in a safe place.
You may want to browse the CD-ROM and copy additional files to your hard 
disk (such as tutorial files, templates, drum maps, etc.). 
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Installing Spark LE

Cubasis VST comes with a separate audio editor application: Spark LE 
from T.C. Works. This is included on a separate CD-ROM and should be 
installed after you’ve finished the Cubasis VST installation.

Register your software!

Please fill out and send in the registration card that comes in this pack-
age. Doing so will make sure you are entitled to technical support and 
kept aware of updates and other news regarding Cubasis VST.

Installation done! Where do I go next?

There are basically two things we suggest you do:

• Read through the rest of this book and try out the different possibilities as 
you go along.
A good strategy would be to follow the instructions in the next chapter (to set 
up your MIDI and audio system properly) , and then move on to the Quick Start 
chapter, which gives you a quick hands-on introduction to the most important 
Cubasis VST features.

• Browse the Cubasis VST folder and the CD for files that might be of use for 
you.



5
Setting up your System
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Making Settings for Audio work

Connecting a musical instrument, a microphone or a mixer

About microphones

If you plan to record vocals or a musical instrument, we recommend 
that you contact a retailer of musical equipment to find a suitable mi-
crophone and a cable with the appropriate type of connector. Also, you 
should be aware that microphones generally produce rather low signal 
levels. Therefore, you should only connect the microphone to a dedi-
cated mic input on the audio hardware (or even better, via a separate 
microphone preamp or a mixer – see below).

About electric instruments

You might have an electric instrument such as an electric guitar, elec-
tric bass, organ or similar, that normally requires an amplifier. If you do, 
you need to be a bit careful about how to connect it to the Macintosh 
computer or audio hardware, in order to make your recordings sound 
as good as possible. Generally, electric guitars and basses should be 
connected to a microphone input, since they deliver a weak signal. 
Synthesizers, keyboards and other devices deliver a stronger signal 
called a “line level signal”. These should always be connected to the 
“line input” of the audio card.

❐ It is very important to make sure you use the correct type of input on your 
audio card, or your recordings will either be distorted or unnecessarily 
noisy. 
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Using an audio mixer

This is usually the best option. If you have access to an audio mixer, 
connect your microphones or instruments to this, and connect the out-
put of the mixer to the line input on the Macintosh computer or audio 
hardware. The picture below shows a possible configuration:

In this example, the mixer is used not only for sending audio into the 
computer, but also for listening to all sound sources (including a MIDI 
synthesizer). However, this requires that the mixer has separate, inde-
pendently controllable outputs for recording into the computer and 
listening to the mix. This is necessary, because otherwise you will not 
be able to record a separate sound source – since everything (the syn-
thesizers, microphones and even the computer’s own sound) will be re-
corded at the same time!

A common method is to use a special output on the mixer called a 
“monitor send” or a separate “bus”, connected to the input of the audio 
card. This ensures you can separately control what gets recorded on an 
audio Track.

The main outputs of the mixer are connected to the speakers, and it is 
via this connection you are able to hear the output of the audio card 
and the synthesizers, blended to a final mix.

Send/Bus Out

MainOut
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Naturally, there are endless variations on this concept depending on 
the type of mixer, the sources to be recorded and the specification of 
the audio card. Contact your music dealer for help on configuring a sys-
tem ideal for your specific needs.

Use the Audio Hardware Setup application

Often, an audio card or external audio interface has several inputs: a 
microphone input, a stereo line input, possibly digital inputs and 
maybe a connection from the CD-ROM drive in your computer.

Often, the audio hardware comes with one or more small applications 
that allow you to configure the inputs of the card to your liking. This in-
cludes:

• Selecting which ins/outs are active.
• Turning monitoring via the card on/off (see page 79).
• Setting levels for each input. This is very important!
• Setting Levels for the outputs, so that they match the equipment you use for 

monitoring.

❐ If possible, make sure audio recording and playback works properly be-
fore you launch Cubasis VST. 
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Selecting an ASIO Driver

ASIO (Audio Stream Input Output) is a technology developed by Stein-
berg, that acts as a “connector” between an audio application (in this 
case, Cubasis VST) and the audio hardware. For audio playback and re-
cording to work in Cubasis VST, you must select the proper ASIO driver:

1. If you haven’t launched Cubasis VST, do so.

2. Pull down the Options menu and select “System...” from the Audio Setup 
submenu.
The Audio System Setup dialog appears.

3. Pull down the ASIO Device pop-up menu, in the upper right corner of the 
dialog.
The pop-up menu lists the available ASIO drivers. To know which one to select, 
use the following general guidelines:

• If you are using additional audio hardware (that is, audio hardware other 
than the built-in audio inputs and outputs), and there is a dedicated ASIO 
driver for your audio hardware (that is, an ASIO driver specifically written 
for that audio hardware), you should select that!
Dedicated ASIO drivers generally give much lower latency (see below), and can 
provide audio hardware-specific features. Make sure you get the latest ASIO 
driver from the manufacturer of the audio hardware.

• If you are using the built-in Macintosh audio hardware (or if there is no ded-
icated ASIO driver for your audio hardware), you should select the Apple 
Sound Manager driver.
This makes use of Apple’s Sound Manager extension.



CUBASIS VST
Setting up your System 5 – 41

A word about Latency

In this chapter we mention latency, which means the delay between 
when audio is “sent” from the program and when you actually hear it. 
The latency in an audio system depends on the audio hardware and its 
drivers. Latency may become a problem in the following situations:

• When you are playing VST Instruments “live” from a MIDI keyboard, the sound 
of the VST Instrument will be delayed according to the latency.

• When you monitor through Cubasis VST, the monitored sound will come out 
delayed. This is probably the area that requires the lowest latency, but then 
again, if you monitor externally or directly through the audio hardware this 
won’t be a problem at all.

• When you mix your audio, a high latency will give a clearly noticeable delay be-
tween when you e.g. mute an audio channel and when the sound is muted. 

❐ Audio playback and recording timing will not be affected by latency, since 
VST takes the latency into account, and adjusts the timing accordingly. 
Similarly, if you play back MIDI Parts routed to VST Instruments, the play-
back precision is sample accurate, regardless of the latency.
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About the ASIO Control Panel for the Apple Sound Manager device

If you have selected the Apple Sound Manager ASIO driver, you can 
make settings for the built-in audio hardware of the Macintosh, by 
clicking the ASIO Device Control Panel “Launch” button.

This opens ASIO Control Panel for the Apple Sound Manager device: 

• The Device and Source pop-up menus allow you to select an audio input 
source.
See page 71.

• You can adjust the input gain with the two sliders in the control panel.
Normally, the default middle gain is suitable, but if you have an audio source with 
a very weak or “hot” signal level, you may want to adjust the input gain to avoid 
noise or distortion.

• Activating the “Play Through” checkbox will send incoming audio directly 
to the audio outputs, allowing for “direct-through” monitoring.
See page 44 for more about monitoring.

❐ Note: With some MacOS versions, it isn’t possible to change the “Play 
Through” setting from the ASIO Device Control Panel. Instead you will need 
to use the Sound control panel (accessed from the Apple menu in the Finder) 
to activate or deactivate “Play Through”, before launching Cubasis VST.

❐ If you are using additional audio hardware, there may be a similar control 
panel available (opened by clicking the ASIO Device Control Panel “Launch” 
button). Refer to the audio hardware documentation for details.
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Additional Audio Settings

While you’re in the Audio System Setup dialog, you need to make a few 
additional settings:

1. If you like, adjust the Number of Channels value.
The number of audio channels determines how many audio recordings you can 
play back at the same time (with stereo recordings using two audio channels). 
You can always adjust this value later if needed.

❐ How many channels you will actually be able to use depends on your com-
puter’s processing power, the speed of the hard disk and other factors.

2. Make sure Audio Clock Source is set to Internal for now.
Depending on your audio hardware, there may be other options on this pop-
up menu, allowing you to synchronize the sample rate to an external source. 
For example, if you record audio from digital inputs on your audio hardware, 
you should select the corresponding option on this pop-up menu, so that Cu-
basis VST’s sample rate is properly synchronized to the device producing the 
digital signal (see the hardware and ASIO driver documentation for details).

3. Click OK to close the Audio System Setup dialog.
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About Monitoring

In Cubasis VST, Monitoring means listening to the signal being recorded 
while preparing to record or while recording. There are basically three 
ways to monitor:

• Via a mixer
If you have the equipment connected to a mixer and then to the audio card, 
you can of course choose to listen to the connected equipment directly from 
the mixer. If you should choose this option or not depends on how advanced 
your mixer is.

• Via Cubasis VST
In this case, the audio passes from the input into Cubasis VST and back to the 
output. You then control monitoring via settings in Cubasis VST.

• Directly via the audio hardware
In this case, the computer’s audio input is connected directly to its output. If 
supported by the audio hardware, you activate this feature (usually called 
“through”, “monitor” or similar) in the hardware’s ASIO Control Panel (accessed 
from Cubasis VST’s Audio System Setup dialog), in the Sound control panel on 
the Mac’s Apple menu or in a mixer application that comes with the hardware.

Which should I choose – “Direct” or “Cubasis” monitoring?

• Monitoring via Cubasis VST has the advantage that any effect and other 
settings you make in the program will also be apparent on the monitored 
signal, not only on recordings you have already made and play back.
This will not be the case if you monitor directly via the audio hardware.

• Monitoring via Cubasis VST has one disadvantage: There is an unavoid-
able delay in the Monitor signal (the monitored sound will appear to be a 
little late). This delay, called latency, is due to the way audio is handled on 
Macintosh computers.
The latency time depends on the audio card, its drivers and settings. Audio 
hardware with separate ASIO drivers may have a low enough latency to allow 
proper monitoring through Cubasis VST.
Direct monitoring does not have this problem.
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Setting up

• If you want to use Cubasis VST’s monitoring, pull down the Options menu 
and select “Enable Monitor” from the Audio Setup submenu (if the menu 
item says “Disable Monitor”, monitoring is already enabled and you don’t 
need to change the setting).
You also need to make sure there is no monitoring (or “through”) function acti-
vated in the audio hardware mixer application or ASIO Control Panel.

• If you want to monitor directly through the audio hardware (and you are 
not using ASIO Direct Monitor), make sure this function is activated in the 
card’s mixer application or ASIO Control Panel (or in the Sound control 
panel – see the note on page 42). 
You also need to pull down the Options menu and select “Disable Monitor” 
from the Audio Setup submenu (if the menu item says “Enable Monitor”, moni-
toring is already disabled and you don’t need to change the setting).

• If you want to monitor “externally” using a mixer, pull down the Options 
menu and select “Disable Monitor” from the Audio Setup submenu (if 
the menu item says “Enable Monitor”, monitoring is already disabled 
and you don’t need to change the setting).
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Enabling/Disabling Audio

On the Audio Setup submenu on the Options menu you will find a set-
ting called Disable Audio, which allows you to disable all audio input 
and output. This feature is mainly for two situations:

• When you only want to record and play back MIDI and don’t want to waste 
processing power on the audio engine.
This lets the computer use all power for screen updates and MIDI playback.

• When the computer you use is not powerful enough to run Cubasis VST 
with the VST engine enabled.
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Setting up for MIDI

This section describes how to connect and set up MIDI equipment. If 
you have no MIDI equipment you can skip this section and move di-
rectly to page 71.

Connecting the MIDI Equipment

Below you find four setup examples for small MIDI systems. You might 
need or want to hook things up differently!

Example 1A – Using the Keyboard for recording and playback, via a 
separate MIDI Interface

1. Connect the MIDI Out of the instrument to a MIDI In on the MIDI interface.

2. Connect a MIDI Out on the interface to a MIDI In on the instrument.

MIDI In

MIDI Out
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Your MIDI interface may have more than one MIDI Out. Each MIDI port 
can address up to 16 different devices (or the 16 different voices in a 
multitimbral module). On smaller MIDI interfaces, the Outputs all carry 
the same information, so it doesn’t matter which one you use. 

On larger, multi-port interfaces, the MIDI Outputs are all separate, that 
is, they carry different sets of the 16 MIDI channels. This allows Cubasis 
VST to send MIDI data selectively to different MIDI channels on any of 
the available outputs. If you have a multi-port interface, you should 
connect the first output to your instrument, and use the following out-
puts if you need to connect more instruments.

Example 1B – Using a Keyboard with a built-in MIDI Interface

If your instrument has a built-in MIDI interface, no MIDI cables are 
needed, only a serial or USB cable (see the instrument’s documentation 
for cable specifications).

1. Make the connections with computer and instrument turned off.

2. Connect the cable between the printer/modem or USB port on the com-
puter and the computer connection on the instrument.
Many instruments have a special switch that needs to be set for the computer 
connection to be active (see the instrument’s documentation).

The connection above allows you to feed the computer with the signals 
from the keyboard, during recording. It also allows you to send MIDI sig-
nals from the computer to the instrument during playback.

Computer Connection
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Example 2 – Using a separate Keyboard and Sound Module

If you have a separate MIDI keyboard, that produces no sound, and a 
sound module without keyboard, you should hook things up as in the 
picture below. Using Cubasis VST’s MIDI Thru feature (described later) 
you will still be able to hear the sound from the sound module while 
playing the keyboard and when recording.

MIDI In

MIDI Out
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Example 3 – Adding more devices using the MIDI Thru connectors on the 
instruments

You might want to use more instruments for playback. Connect MIDI 
Thru on the first instrument to MIDI In on the next, and so on. In this 
hook-up, you will always play the first keyboard when recording. But, 
thanks to the Thru connection, you can still use all your devices for pro-
viding sounds on playback.

❐ If you plan to use more than three sound sources we recommend that you 
either use an interface with more than one output, or a separate MIDI Thru 
box instead of the Thru jacks on each unit.

Setting up the Instruments

If you have a General MIDI, Roland GS or Yamaha XG compatible instru-
ment, you may want to set it to its GM/GS/XG mode. If you have other 
types of instruments, set each Sound (Timbre, Part, Program, Patch) to 
receive on a different MIDI Channel.

MIDI In

MIDI Out

MIDI Thru
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MIDI Settings in Cubasis VST

The MIDI System Setup dialog

• Pull down the Options menu and select “System…” from the MIDI Setup 
submenu.
The MIDI System Setup dialog appears. This is where you make settings for how 
Cubasis VST should handle MIDI.

Which settings to make depends on whether you’re using OMS or not.

If you’re using OMS

1. Make sure the OMS Compatibility pop-up menu is set to “IN & OUT”.

❐ If you change the OMS Compatibility setting, you need to restart Cubasis 
VST.

2. Click the Inputs field.
The OMS Input dialog appears. It lists the available OMS inputs, including your 
MIDI interface (provided it’s properly recognized by OMS). There will also be ad-
ditional inputs available, used for MIDI communication between different com-
puter applications etc. See the OMS documentation for details.

3. Make sure the necessary OMS inputs are activated, and close the dialog.

4. Click OK to close the MIDI System Setup dialog.
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If you’re not using OMS

1. Make sure the OMS Compatibility pop-up menu is set to “No OMS”.

❐ If you change the OMS Compatibility setting, you need to restart Cubasis 
VST.

2. Pull down the Modem and/or Printer port (depending on to which ports 
your MIDI interfaces are connected) and select the “1 MHz” option.
This is the option to use for the vast majority of serial port MIDI interfaces – con-
sult your MIDI interface documentation if in doubt.

3. Activate the “Use Serial Driver” switch.
Serial Driver is a modern DMA transfer technology built into most Macintosh 
computers. This switch should be active if at all possible. Only if you get hang-
ing MIDI notes should you turn it off. This switch is of no relevance if you are us-
ing OMS.

4. Pull down the Inputs From pop-up menu and make sure the desired MIDI 
Input ports (Modem and/or Printer) are enabled.

5. Click OK to close the MIDI System Setup dialog.
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Setting MIDI Thru and Local On/Off

On the Options menu you will find a setting called “MIDI Thru” which 
can be enabled or not. This is related to a setting in your instrument 
called “Local On/Off” or “Local Control On/Off”.

• If you use a MIDI keyboard instrument, as described in Example 1 earlier in this 
chapter, MIDI Thru should be activated and that instrument should be set to Lo-
cal Off (sometimes called Local Control Off – see the instrument’s operation 
manual for details). This will let the MIDI signal from the keyboard get recorded 
into Cubasis VST and at the same time re-routed back to the instrument so that 
you hear what you are playing, without the keyboard “triggering” its own 
sounds.

• If you use a separate MIDI keyboard, that does not produce any sounds itself, as 
in Example 2, MIDI Thru in Cubasis VST should also be activated, but you don’t 
need to look for any Local On/Off setting in your instruments.

• The only situation where MIDI Thru should be deactivated is if you use Cubasis 
VST with only one keyboard instrument and that instrument cannot be set to 
Local Off mode.

MIDI In

MIDI Out

“Synth”

When “MIDI Thru” is active in Cubasis VST, MIDI 
data received is immediately “echoed” back out.

When you press a key, it is sent 
out via MIDI to Cubasis VST.

MIDI data coming in to the instrument 
is played by the “Synth” inside it.

When Local Control is On in the instrument, the keys 
you press will be played by the “Synth” inside the 
Instrument. When Local Control is turned Off, this 
connection is cut off.
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Checking your MIDI Setup

1. Select a MIDI Track by clicking on its name in the Track list (to the left in 
the Arrange window).

2. Play your MIDI keyboard.

3. Check the “In” indicator on the Transport Bar so that Cubasis VST receives 
MIDI data.

4. If you have Thru activated, the “Out” indicator should indicate Output of 
data.

5. Make sure you hear the instrument that you are playing.
If not, check your MIDI connections and Cubasis VST’s MIDI Thru setting. Also 
check the audio equipment and audio connections.

6. If you are playing a MIDI instrument with a built-in sound source, listen to 
make sure the instrument doesn’t sound “thin” or “flanged”.
If it does, you have probably not set the instrument to Local Off. This means 
that every key you press is played twice, once directly on the instrument and 
once via MIDI.

MIDI Tracks are indicated by the note symbol in the “C” column.

When this lights up, Cubasis VST is receiving MIDI data.

When this lights up, Cubasis VST is transmitting MIDI data.
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OMS : Setting up for General MIDI Patch Names

❐ This is only relevant if you are using OMS.

Apart from handling the MIDI Input and Output, OMS can also manage 
the names of the Patches (Presets, Programs, Voices) in your MIDI in-
struments. This allows you to select Patches by name, directly from the 
Inspector in Cubasis VST.

For optimal use of this facility you will need an OMS compatible librar-
ian program, that can automatically extract the names from the MIDI 
devices and “inject” them into the OMS Name Manager (see the docu-
mentation of the librarian program). However, even if you don’t have 
such a librarian program, you can select Patches by name for General 
MIDI compatible instruments:

Proceed as follows:

1. Pull down the Options menu and select “OMS Patch Names” from the MIDI 
Setup submenu.
The OMS Patch Name dialog appears, listing the available MIDI devices.

2. Select your General MIDI device in the list.

3. Pull down the Names menu (to the right of the Tools menu in the Cubasis 
VST menu bar) and select “Use Factory/GM Names”.
The Names menu is only visible when the OMS Patch Names dialog is open.

4. Click OK to close the dialog.

Now, you have specified that General MIDI patch names should be used 
for the device, allowing you to select patches by name in Cubasis VST.
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About this Chapter

This chapter gives you a really quick introduction to Cubasis VST. It is 
based on the Quick Start Demo Song, included on the VST CD-ROM. 

Opening the Quick Start Song

The Quick Start Song is automatically installed when you install Cubasis 
VST. If you have removed it for some reason, you can re-install it by 
copying the folder Quick Start Song from the Cubasis CD-ROM to your 
hard disk.

1. Locate and open the Cubasis VST application folder.

2. Open the Quick Start Song folder.

3. Double click on the Cubasis Song file “Quick Start Song”.
Cubasis launches, and the Song opens. What you see now is the Arrange win-
dow, the real focus of Cubasis.
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Playing Back

At the bottom of the screen you will find the Transport Bar. This is used 
for controlling playback, recording and many other functions, much 
like the controls on a regular tape recorder.

The transport controls.

1. Click the Play button, on the Transport Bar.
The Song starts playing. At this point, you will only hear the audio Tracks, that 
is, audio recordings stored on your hard disk as files. No MIDI is played at this 
point.

2. When you are done listening, hit Stop. 
Also try out Fast Forward and Rewind to see how you can move the Song Posi-
tion (the vertical moving line in the Arrange window) to any point in the Song 
and start playback from there.
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Muting and Soloing Tracks

As you can see, the Arrange window is divided into a number of Tracks. 
These are listed vertically. You can silence any number of Tracks, by us-
ing the functions Mute and Solo.

1. Click in the “M” column in the Tracks list, for the Track Bass.
You will notice how the bass disappears from the music. Click again to get it 
back. What you just did was muting and unmuting a Track.

• Experiment with muting/unmuting Tracks but leave the MIDI Tracks (Mono 
Lead, Vibes, Strings and Congas) muted for now.

2. Click on the name of the Track Bass.
The Track goes dark. What you just did, was selecting a Track. Selecting some-
thing means it is now the target for some operation you are about to perform.

3. Click on the Solo button, at the top of the Arrange window.
You will now hear only the selected Track. Solo can be thought of as a sort of in-
verse mute. Click Solo again to hear all unmuted Tracks.

A Muted Track.

This Track is selected.The Solo button.
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Activating the MIDI Tracks

The four Tracks at the bottom do not play audio but MIDI. You can see 
this by checking the “C” column for each Track. The note symbol indi-
cates that a Track is a regular MIDI Track whereas the waveform symbol 
indicates an audio Track.

To be able to play the MIDI Tracks you need to have an external MIDI syn-
thesizer connected to a MIDI Interface (or, you can use VST Instruments, 
as in the example on page 66). If your synthesizer is not General MIDI 
compatible, you might still play the Tracks, and you will probably hear 
something, but it might not be the sounds we assume in this example.

1. Make sure your synth is in its General MIDI compatible mode.
Many synths are already in this mode on startup.

2. Click twice on the Stop button to move the Song Position to the beginning 
of the Song.

3. Unmute the four Tracks Mono Lead, Vibes, Strings and Congas.

4. Activate playback.
You will now hear, from the MIDI synthesizer, some additional parts in some 
sections of the Song. If you don’t hear anything, check the Output column for 
the MIDI Tracks and make sure they are set to the correct “port”. 

❐ You may need to match the balance between the audio and the MIDI mu-
sic by adjusting the volume on your MIDI instrument.

Audio Track symbol

MIDI Track symbol
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Changing the Sound and Level of a MIDI Track

Now, let’s try to make some changes to the sound and levels of the 
MIDI Tracks. Let’s begin with changing sounds: 

1. Let the music keep playing.

2. Select the “Mono Lead” Track.

3. Look at the Inspector (the area with a lot of settings, to the left of the Track 
list).
If the Inspector isn’t visible, click on the arrow button in the lower left corner to 
display it.
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4. Position the pointer over the “Patchname” pop-up menu, and press the 
mouse button.
A pop-up menu appears, with all GM (General MIDI) sounds listed.

This picture shows the Patch Name menu when OMS isn’t used – with OMS, the menu 
isn’t hierarchical, but contains the same items.

5. Select a new sound from the pop-up menu.
When the Mono Lead Parts are played back, you will hear them with the sound 
you just selected. If nothing happens, this is because your instrument is not set 
up to receive the MIDI message Program Change.

Now, let’s change the levels of the MIDI Tracks. The easiest way to do this 
(although there are others) is to use the MIDI Track Mixer:

6. Keep the music playing.
If the Song has ended already, click twice on the Stop button to move the Song 
Position to the beginning of the Song, and then click Play again.



CUBASIS VST
Quick Start 6 – 63

7. Select “MIDI Track Mixer” from the Panels menu.
A window with faders, meters and other controls opens. 

This is where you mix your MIDI Tracks. Currently, the MIDI Track Mixer has four 
“channel strips”, since there are four MIDI Tracks in the Quick Start Song (if there 
had been five MIDI Tracks, you would have had five channel strips, etc).

8. Use the faders to adjust the levels of the MIDI Tracks, as desired.
If you like, experiment with the other controls in this window.

9. When you are done, close the window.

The four “Channel Strips”

Mute and Solo buttons

Pan control

Volume fader

Level (velocity) meter

Track name
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Setting the Levels of the Audio Tracks

Now that you’ve learned how to mix the MIDI Tracks, let’s do the same 
for the Audio Tracks.

1. Rewind the Song to the beginning and activate playback.

2. Select “VST Channel Mixer” from the Panels menu.
The VST Channel Mixer appears. Here you can see, via the colored bar graphs, 
which audio channels are playing (in this example, each audio channel corre-
sponds directly to an Audio Track, so that Track 1 plays back on audio channel 1, 
and so on).

The VST Channel Mixer window.

3. Use the channel faders to adjust the levels of the Tracks, as desired.
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Adding an Effect

Now, let’s add some audio effects to the Guitar Track. To hear what 
we’re doing, let’s Solo it first.

1. Locate the mixer channel strip for the Track “Guitar” and click on its Solo 
button (in the upper part of the channel strip).

2. Click on the same Track’s EQ button, located just above its Mute button.
The VST Channel Settings window for that channel appears. Essentially this is a 
mixer window with detailed settings for one channel only.

The section we are interested in now is the Sends section with two blue 
knobs. These represent controls for the amount of effect for this audio 
channel. In this Song, a delay and a reverb are activated.

3. Click on the On buttons for both of the effect sends.

The effect sends in the VST Channel Settings window.
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4. Use the knobs to add various amounts of each effect to the Guitar sound.
To do this, press the mouse button with the pointer over the knob, keep the 
button down and drag in a circular motion around the knob.

Drag in a circular motion around the knob.

5. When you are done, close the VST Channel Settings window, click the Solo 
button again to deactivate Solo and finally close the VST Channel Mixer.

Using a VST Instrument

Cubasis VST isn’t limited to playing back recorded audio files or send-
ing MIDI to external synthesizers – it also has built-in instruments. 
These are called VST Instruments, and are played via MIDI, just like ex-
ternal MIDI instruments. The big difference is that VST Instruments ex-
ist within the program, which means you can adjust their volume and 
add effects or EQ in the VST Channel Mixer, just as with Audio Tracks.

In this example we will set things up, so that the “Mono Lead” Track 
sends MIDI to the built-in Neon synthesizer instead of to an external 
MIDI instrument:

1. Locate the Mono Lead Track in the Arrange window, and click in the 
“Output” column.
A pop-up menu appears with a list of the available MIDI Outputs.

2. Select “Neon (V1)”.
The Mono Lead Track will now send MIDI to the Neon synthesizer.

3. Play back the Song to listen.
You may want to navigate to the Mono Lead Parts first, by using Rewind or Fast 
Forward.
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4. Open the VST Channel Mixer again, and scroll to the right with the scroll-
bar at the bottom of the window.
To the right of the regular audio channel strips, you will find separate mixer 
channel strips for the Neon synthesizer. You can use these to change the vol-
ume or add effects, just like you did with the Audio Tracks.

5. Click the “Edit” button at the top of the Neon channel strips.
This opens the control panel for the VST Instrument. In the case of Neon, this 
looks much like a traditional synthesizer panel.

6. While you play back the Song, try changing the sound of the Neon synthe-
sizer by using the controls in the synthesizer panel.

• If you like, you can try changing the Output of the other three MIDI Tracks 
to “Universal Sound Module”.
This is a General MIDI compatible VST Instrument, included with Cubasis VST.

The Neon channel strips
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Checking Out the Arrange Window Toolbox

So far you’ve been mixing and setting sounds. Now it’s time to explore 
the possibilities of editing the music. This is mainly done in the Arrange 
window, using a graphical Toolbox that allows you to manipulate record-
ings.

As you have probably noted, the recordings on the Tracks are made up 
of Parts, small boxes that each represent a musical recording, regardless 
of whether it contains audio or MIDI. Editing in the Arrange window 
means manipulating these Parts.

Parts in the Arrange window.

1. Pull down the Tools menu.
A Toolbox appears.

2. Select the Eraser tool.

3. Click on one of the Parts.
It disappears – because you just erased it!

4. Select Undo from the Edit menu.
The Part comes back.

5. Select the pointer from the Toolbox.
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6. Position the mouse pointer over any Part, press the mouse button and 
drag.
The Part moves. If you like, play back to hear the effect.

7. Select one Part. Then hold down [Shift] and click on more Parts, one af-
ter the other.
They all get selected and turn dark to indicate this.

8. Press the mouse button with the pointer over one of the selected Parts, 
and drag.
They all move together, as a block.

9. If you like, try out the other tools.
The functions of the Arrange window tools are described the chapter “Arrange-
ment Editing”.

Closing Up

This finishes our quick tour of the Quick Start Song. By now you are 
probably anxious to record something of your own. Proceed to the 
next chapter to get an introduction to the basic methods and concepts 
used in the program, and then get ready for a unique musical experi-
ence, using Cubasis VST to realize your own musical inspirations.

❐ Apart from the Quick Start Song, there may also be other Demo Songs in-
cluded on the CD-ROM. Use these to try out other features and get an im-
pression of the full capacity of Cubasis VST!



7
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Preparations

Selecting a Sound Source

Before you begin recording, you have to select which sound source to 
record. You may for example have a microphone connected, as well as 
some kind of line level instrument or mixer, and the audio output of an 
internal CD drive. How to make this selection depends on the audio 
hardware:

• If you are using the built-in audio hardware of the Macintosh, you need to 
select an input source in the Mac’s “Sound” control panel.

• For some audio hardware, you can select inputs and make other settings 
in the ASIO Control Panel. 
This is accessed by pulling down the Options menu and selecting “System” 
from the Audio Setup submenu, and clicking the “Launch” button in the dialog 
that appears.

• Some audio hardware types come with a separate application in which 
you can select inputs and make other settings.
See the audio hardware documentation for details.

❐ Some stereo audio cards allow you to mix several input sources. However, 
if you plan to record a single sound source, we recommend that you turn 
down or deactivate the other sources, to avoid unnecessary noise.
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Activating Cubasis VST Inputs

Cubasis VST allows you to use audio hardware with several Inputs and 
route different Inputs to different audio channels. For now, however, 
let’s stick to a “basic” 2 in/2 out setup (such as the built-in audio hard-
ware on the Macintosh or a simple stereo audio card). Still, you need to 
make sure that these Inputs are activated before you attempt to record 
anything:

1. Pull down the Panels menu and select “VST Inputs”.
The VST Inputs window appears:

The left column contains the available “physical” Input ports (in this case there are 
two Inputs). The fields in the right column show the names that will be used for each 
Input throughout the program. The middle column contain an indicator for each 
input pair, showing which Inputs are active.

2. Make sure that the indicator in the middle column is lit.
If not, click on it so that it lights up. This shows that the Inputs are active.

3. Close the Inputs window by clicking in its close box.

❐ For information about using audio hardware with several inputs, see page 
86.
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Selecting a Sample Rate

Before recording you have to set the sample rate for the Song:

1. Pull down the Options menu and select “System...” from the Audio Setup 
submenu.
The Audio System Setup dialog opens.

2. Use the Sample Rate popup to select a sample rate.
This setting determines the audio quality of your recordings. The higher the 
value, the better the quality, but when you raise the value, each recording also 
uses up more disk space and computer processing power. For recordings where 
the audio quality is important, 44100 Hz is the most common sample rate. For 
multimedia purposes, or in situations where you want to keep the audio files 
small, 22050 Hz may be a better choice.
Please note that some audio hardware might only support a limited number of 
sample rates (see the card’s documentation for details).

❐ This setting is done once and for all for the whole Song. You cannot make 
some recordings at one sample rate and others at some other sample rate.

3. Close the System dialog by clicking OK.
The settings are saved.
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Setting a tempo and time signature for the Song

Before you start you should specify tempo and time signature. These 
are both adjusted on the Transport bar:

Tempo tip

A good way of setting the tempo is to activate playback and adjust the 
tempo on the Transport Bar while listening to the metronome (Click) 
that is generated on each beat (quarter note). For the metronome to be 
heard, you need to make sure that the Click button on the Transport 
bar is activated:

Click activated on the Transport Bar.

❐ If you start playback with Click activated and still cannot hear the metro-
nome, you need to adjust the settings in the Metronome dialog on the Op-
tions menu (see page 109 to find out about the parameters and options in 
the dialog).

For now, make sure Master is not 
activated on the Transport bar.

The time signature determines the number of 
beats to each bar. 4/4 for example is often 
used in rock and pop. 3/4 is used for waltz.

The tempo determines the “speed” of the 
music. The number is in beats (quarter notes) 
per minute. 

For now, we recommend that you 
leave the Cycle function deactivated.
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Selecting and setting up a Track

About Stereo and Mono

Before you select a Track to record on, it is necessary to understand the 
basic concept about audio channels and how Cubasis VST handles 
mono and stereo recordings: 

• All audio is played back via audio channels. The number of available audio 
channels is determined by the “Number of Channels” setting in the Audio Sys-
tem Setup dialog (up to 48, depending on computer/hard disk performance). 

• Each audio channel can play back one mono audio recording at a time. 
• Stereo recordings play back on two audio channels, one for each “stereo side”. 

A stereo channel pair always consists of an odd channel and the next even 
channel (e.g. channel 1+2, 3+4, etc.).

• Channels that are used in stereo pairs cannot be used for mono recordings, and 
vice versa.

Setting Up

Set up a Track for recording as follows:

1. Select an Audio Track by clicking on its name field in the list.

• If you don’t have any empty Audio Tracks in your Arrangement, you need 
to create one, for example by using the Create Track item on the Structure 
menu. 
To make sure the Track is an Audio Track, position the mouse in the “C” column 
for the Track, pull down the pop-up menu and select “Audio Track”.

2. Set the Track’s channel (Chn) to the audio channel you plan to record on.
If this is the first Audio Track you record on, select 1. Generally, you should 
avoid using a channel already used by another Track, since each channel only 
can play one recording at a time.

The “Any” channel setting is explained on page 86. For now, select a “normal” 
channel number.

❐ If you plan to make a stereo recording, you must select an odd channel 
number.
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3. Open the Inspector.
This is done by clicking on the Inspector icon below the Track list.

4. Decide if you want the recording to be in mono or stereo by using the 
Mono/Stereo button in the Inspector.
The mono/stereo state of a Track is indicated by the label on the button, and by 
whether the switch is lit or not. 

• If a lock symbol is shown in the button, you cannot switch mode for the 
Track.
A mono Track will be locked if it is already used for a mono recording, if it is set 
to an even-numbered audio channel, or if it is set to an odd-numbered audio 
channel and the next channel is already used for a mono recording.
A stereo track will be locked if it’s already used for a stereo recording.

If you select Stereo for a Track, it will use the audio channel you set in 
step 2 above for the left side of the stereo recording, and the next chan-
nel for the right side. These two channels are then reserved for stereo 
use, so that no mono Track can be set to any of these channels.

5. Double click on the Track name, type in a new name for the Track and 
press [Return].
Since the recorded audio file will get the name of the Track, it is a good idea to 
use descriptive Track names.

Click on this icon...

...to open the 
Inspector.
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Now you need to make sure the correct inputs are selected for the se-
lected audio channel(s). By default, the left input on your audio card is 
assigned to odd-numbered channels, and the right input is assigned to 
even-numbered channels, but you may want to change this:

6. Pull down the Panels menu and select VST Channel Mixer.
The VST Channel Mixer window opens.

7. Locate the “mixer strip” for the audio channel(s) you have selected for 
recording.
There is one mixer strip for each audio channel (the value you set in the Chn 
column for the Track). At the top of the strip, you find a button with the name of 
the Input selected for the channel.

8. Click on the Input button to pull down a pop-up menu with the two Inputs.

9. Select the Input to which your sound source is connected.
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• If you have selected Stereo above, there will be a stereo channel pair in the 
mixer, with a common Input pop-up menu.
In that case, the Input pop-up menu will list stereo input pairs. If you are using 
audio hardware with a single stereo input, the left and right inputs will auto-
matically be assigned to the odd and even channel, respectively.

10. Go back to the Arrange window and click on the Enable button in the In-
spector, to make the Track and its selected audio channel ready for 
recording.
If this is the first time you enable audio recording in the Song, you will be asked 
to select a folder for storing your recorded audio files.

Selecting a folder for your Audio Files

When you enable recording for the first time in a new Song, a file dialog 
box will appear, asking you to select a folder for your audio files. This 
folder will be used to store all audio files recorded for the Song. If you 
have the opportunity, we recommend that you store your audio files 
on a separate hard disk.

• If you want to change the folder for your audio files during the session, you 
can do this at any time by pulling down the Options menu and selecting 
“Audio Files Folder” on the Audio Setup submenu.
This opens the same file dialog, letting you select a new folder, which will be 
used from that point on.
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Monitoring

As described on page 44, you can monitor via Cubasis VST, directly via 
the audio hardware or externally via a mixer.

If you monitor via Cubasis VST, you set this up in the following way:

1. Pull down the Options menu and open the Audio Setup submenu.

2. Select the item called “Enable Monitor”.
This is the global “master switch” for monitoring in Cubasis VST. If the menu 
item says “Disable Monitor”, monitoring is already enabled, and you don’t need 
to change anything.

3. Activate monitoring for the Audio Track by clicking on the left half of the 
Input button in the Inspector.
The incoming audio will now be “echoed” back out again.

❐ For this method of monitoring to be useful, audio hardware with low la-
tency is required! See page 41 for details.
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Checking the Input Levels

Digital recording (as in Cubasis VST) is different from analog recording 
when it comes to recording levels. Whereas with analog recording it is 
often perfectly acceptable to let the “needle hit the red” (record at lev-
els actually higher than the system can reproduce accurately), this is 
not true when it comes to digital recording.

The term used here is headroom. The headroom is the difference in 
level between the signal you record and the maximum level the system 
can handle. When the signal increases, the headroom diminishes to-
wards 0 dB (decibels). 

When the signal is stronger than the system can handle – when you ex-
ceed the available “headroom” – in a digital recording system, hard 
clipping occurs, which results in clearly audible and very unpleasant 
distortion. To avoid this, you should use the Input meter function in the 
VST Channel Mixer window to accurately check the recording levels:

1. Pull down the Panels menu and select VST Channel Mixer.
The VST Channel Mixer window opens.

2. Click the “In” button above the level meter for the recording channel to 
activate the Input meter function.

When this button is activated, the meter shows the signal level at the input se-
lected for the audio channel. 
When the button is deactivated, the meters show the output level of each au-
dio channel, which is what you want when you play back your recordings.

❐ Note that all actual settings (volume, pan, etc.) relate to the output sig-
nals, regardless of this switch. It is not possible to set the Input Gain with 
the Volume fader!

• If you are making a stereo recording, activate the “In” buttons for both 
channels in the stereo pair.
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3. Sing or play the connected instrument and check the meter and the nu-
meric level display above the fader.
The level should be as high as possible, without ever clipping (exceeding 0 dB).

Clipping is indicated by the red clip light above the “In” button. To reset the clip 
indicator, click on it.

4. If needed, adjust the recording level in the audio card’s mixer application 
(or adjust the output level of the sound source or external mixer).

5. While you are in the VST Channel Mixer window, you may want to adjust 
the output level of the monitored channel.
Use the volume fader for the channel to set a comfortable listening level (this 
only works if you are monitoring through Cubasis VST).
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Performing the first recording

Setting start- and end-points for the recording

When you start recording from Stop mode, the recording will always 
start at the position of the Left Locator and end at the Right Locator.

To position the Locators, proceed as follows:

• Point at the Locator flags on the ruler and drag left or right

or

• Hold down [Option] (Left Locator) or [Command] (Right Locator) and click 
on the ruler.

Recording

1. If you want to record to a metronome click, activate the Click button on 
the Transport Bar.

2. Click the Record button.
By default, you will hear a two bar count-in (you can adjust the length of this or 
turn it off completely in the Metronome dialog, as described on page 109).

3. After the precount, start performing.
Recording will automatically be deactivated when you reach the Right Locator, 
if you don’t hit Stop before that.

4. When you are done, press Stop.
The program will now calculate an image file so that a waveform can be displayed 
in the program. Depending on the length of your recording, this may take a few 
seconds, during which a dialog box shows the progress of the calculation.

Dragging the Left 
Locator.
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The program has now created an audio file in the folder you selected 
on page 78. The file will appear in the Pool (a window containing a list 
of all audio used in the Song), along with an audio segment. A segment 
is a “building block” that tells the program which section of the audio 
file to play back. In this case, the segment will play back the whole au-
dio file.

• Read more about audio files and segments on page 132.

In the Arrange window, a Part is created between the start and end 
points of the recording. Parts are containers for your recordings (in this 
case, the Part contains the audio segment that plays back the recorded 
audio file). As described in the chapter “Arrangement Editing”, you can 
move, copy, paste and manipulate Parts in many other ways to edit and 
assemble Songs. 

A Part.

Listening to the Recording

1. To hear what you just did, use the Transport Controls to move back to the 
beginning of the recording and click Play.

2. Stop when you are done.
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If you don’t like what you just recorded

If you are not satisfied with the recording, you can select Undo from the 
Edit menu to remove the recorded Part, or select the Part (by clicking 
on it) and press [Backspace].

However, neither of these methods will remove the actual audio file on 
your hard disk! If you want to permanently delete the recorded audio 
file, proceed as follows:

1. Click on the Part to select it.

2. Hold down [Command] and press [Backspace].
You will be asked whether you want to delete the audio file permanently. Click 
Yes.

Recording more on the same Track

To record more on the same Track, proceed as follows:

1. Move the Left Locator to the position where you want to start recording.
This can be at a “free” area on the Track, or at some place where something is al-
ready recorded, as described below.

2. Make sure the Right Locator is to the right of the Left Locator. If it isn’t, 
please move it.
You cannot activate recording if the Right Locator is to the left of the Left Locator.

3. Activate recording just as you did the first time on the Track.
A new file is automatically created.

About overlap

When you record again, where something has already been recorded 
on the Track, you will get a new Part which overlaps the previous one(s). 
However, when you play back, only the Parts that you can actually see 
are played back. This is because each audio channel can only play back 
one audio file at a time.
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The Smooth Segments option

When audio segments on the same channel are lined up after each 
other (with no gap at all) or overlapping, this can give rise to clicks and 
pops during playback. The reason is that the signals in the two seg-
ments may have a different amplitude (level) at the intersection point, 
which in turn creates a transient (a sudden and dramatic change in sig-
nal level). This can be especially noticeable when working with ReCycle 
files (see page 229).

To remedy this, you should activate the option Smooth Segments on 
the Audio Setup submenu on the Options menu. When this is on, Cuba-
sis VST will add small crossfades at the intersection points between 
segments during playback. This ensures that the transition from one 
segment to the next is smooth, and removes the transients (and thus 
the clicks and pops).

❐ This function uses some processing power and RAM. Therefore, if you 
don’t need it, turn it off.

Recording the Next Track – Overdubbing

Recording the next Track is done just as with the first. Here follows a 
summary of the steps:

1. Select another audio Track and make sure it’s set to another audio channel.

2. Make sure the Track is set to the correct audio Input.

3. Set up the Locators and activate recording.

Now, the previously recorded Tracks will play back and you are able to 
record the new Track as an overdub.
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Recording from Play mode – Punch In

Sometimes it is useful to go directly from playback to recording. This is 
called “punching in”, and can be very useful. For example, if you have 
made a mistake in the middle of a chorus, you can play back from the 
beginning of the chorus, punch in just before the flawed section and 
replace that section with a new performance.

Similarly “punch out” is when you deactivate recording without stop-
ping playback. If – in the example above – the chorus is followed by a 
verse which is perfectly OK, you would punch out at the end of the cho-
rus so that you don’t record anything over the verse.

In Cubasis VST you punch in by clicking the Record button (or pressing 
[*] on the numeric keypad) during playback. To punch out, click Record 
again. 

Advanced: Recording Multiple Audio Channels

If you have audio hardware with several inputs, you can record from 
any combination of these at the same time. For example, you may want 
to make a recording with several microphones or record several players 
at the same time. The key to this is recording on an Audio Track set to 
channel “Any”:

❐ A single “Any” Track can contain recordings on multiple channels. In fact 
one Track can contain mono recordings on as many channels as the sys-
tem supports.

Proceed as follows:

1. Activate the inputs you need in the VST Inputs window on the Panels menu.

2. Open the VST Channel Mixer and select the correct audio inputs for the au-
dio channels you wish to record.
You select inputs on the pop-up menus at the top of the channel strips, as de-
scribed on page 77.

3. Select or create an Audio Track to record on.
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4. Open the Inspector for the Track and set it to channel “Any”.
A number of Record Info buttons appear. Exactly how many depends on the 
number of audio channels in your audio recording system (as set in the Audio 
System Setup dialog).

A Track set to “Any” in a 16 channel system. For stereo channel pairs, only the first 
Record Info button is shown.

• There is also a group of Monitor buttons in the Inspector, as many as there 
are audio channels.
These work just like the Monitor button for a single channel Track, allowing you 
to manually turn monitoring on and off for each audio channel.

5. For the channels you plan to record on, click the corresponding Record 
Info button in the Inspector.
Activated Record Info buttons will be red.

6. Activate recording as usual.
All activated audio channels will now be recorded at once.

When you finish recording, a Part is created as usual. However, the Part 
will only contain the data recorded on the first audio channel (or the 
first stereo channel pair). The audio recorded on the other channels has 
been stored in audio files on the hard disk, and the files have been 
added to the Pool, but you have to move the files into the Arrangement 
manually.

7. Make sure there are separate Audio Tracks available for the remaining re-
corded channels.
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8. Pull down the Panels menu and select Audio Pool.
The Pool window opens.

9. Drag the audio files for these channels from the Pool into the Arrange 
Window, and line them up with the original recording.
For an example of dragging from the Pool into the Arrange window, see page 
151.

10. Finally, set the “Any” channel Track to the correct audio channel.
This should be the first audio channel recorded. That is, if you recorded on 
channels 3, 4, 7 and 9, you should set the Track to channel 3.

Now you can play back the Tracks and hear all the recorded channels.

If you get Audio Performance Problems

If you experience audio dropouts, crackles or “untight” playback, there 
are some audio settings you can adjust (and some general precautions 
to take):

• Adjust the MIDI to Audio Delay in the Audio System Setup dialog.
This is useful if there is a fixed time offset between the MIDI and audio playback.

• Adjust the settings in the ASIO Control Panels.
These are opened by clicking the ASIO Control Panel button in the Audio Sys-
tem Setup dialog. See the online help for the ASIO Control Panels for more info.

• Don’t run other applications when you use Cubasis VST, if you don’t ex-
plicitly need them.
You may want to check for and remove unnecessary “Startup Items” in the 
Macintosh Extensions Manager.

• Use the Macintosh Extensions Manager to create a separate extension set 
for Cubasis VST work.
This may not be absolutely required, but can be useful for two reasons:
A. There may be extensions that cause conflicts and degrade performance (e.g. 
schedulers, screen savers and similar).
B. Unnecessary extensions cause the MacOS to use more memory (RAM) that 
could be put to better use by Cubasis VST.
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• Assign as much RAM as possible to Cubasis VST (see the Macintosh 
documentation).
However, you should leave a little extra RAM available for the MacOS system 
when Cubasis VST is running (2-5 MB is usually sufficient, depending on the 
system).

• Rebuild the desktop now and then.
See the Macintosh documentation for details.

• Check the integrity of your hard disk(s) regularly.
Even though nothing may appear to be wrong, there can be various small hard 
disk errors that affect performance. When working with hard disk recording, it’s 
also important to defragment your hard disk regularly, for maximum hard disk 
efficiency. 
There are several hard disk analysis and repair tools available – just make sure 
you use a version compatible with your MacOS and file structure! 
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About this Chapter

In this chapter, you will learn how to make a MIDI recording.

This chapter assumes the following:

• That you have connected a MIDI keyboard (or other controller) and some kind 
of MIDI sound source. As described earlier in this book, this could be a MIDI key-
board with a built-in sound source, or any combination of a MIDI controller and 
a sound module.

• The instrument you use is General MIDI compatible and set to its General MIDI 
mode.

• You are already familiar with Audio Recording as described in the previous 
chapter.

❐ If your instrument is not General MIDI compatible, you will not be able to 
select sounds from the Program pop-ups in Cubasis VST (see page 94). The 
actual recording procedure is not affected.
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Preparations

Tempo, Time Signature and Click

If this is your first recording in a new Arrangement, set up the time sig-
nature, tempo and Click as described on page 74 in this book.

Selecting and naming a Track

The Tracks with the note symbol in the “C” column are for MIDI record-
ing. An Arrangement can contain up to 64 Tracks.

1. Select a Track by clicking on its name in the list.

• If you don’t have any empty MIDI Tracks in your Arrangement, you need 
to create one, for example by using the Create Track item on the Struc-
ture menu. 
To make sure the Track is a MIDI Track, position the mouse in the “C” column for 
the Track, pull down the pop-up menu and select “MIDI Track”.

2. Double click on the Track name, type in the name you desire and press 
[Return].

Setting MIDI Channel and Output

Setting the MIDI Channel in the Instrument

Most MIDI synthesizers can play several sounds at the same time, each on 
a different MIDI Channel. This is the key to playing back several sounds 
(bass, piano etc.) from the same instrument.

Some devices (such as General MIDI compatible sound modules) always 
receive on all 16 MIDI Channels. If you have such an instrument, there’s 
no specific setting you need to make in the instrument.

On other instruments you will have to use the front panel controls to set 
up a number of “Parts”, “Timbres” or similar so that they receive on one 
MIDI Channel each. See the manual that came with your instrument for 
more information.
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Setting the MIDI Channel and Output in the Track List

1. If you cannot see the Chn and Output columns in the Track list, point at the 
Divider (the border between the Track list and the Part Display), click and 
drag it to the right.

2. Set the Chn column for the Track to the same MIDI Channel as you just set 
up to use on the synthesizer.

❐ In General MIDI, channel 10 is always used for drums!

3. Make sure the Track is set to the MIDI Output that the synthesizer is actu-
ally connected to. If it isn’t, pull down the Output menu for that Track and 
select the desired MIDI Output.
The available MIDI Outputs on the menu depend on your MIDI interface(s) and 
(if you are using OMS) on the settings you have made in the OMS Setup. 
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Selecting a sound

When you play your keyboard, you should now hear the sound that the 
instrument plays on this MIDI Channel (the Track’s “Chn” setting).

To select a sound, proceed as follows:

1. Open the Inspector.

2. Set a numeric Program Change value in the “Prg” field.
See also page 97 for more information about Program Change and Bank Select.

If you have a GM compatible instrument, you can also select sounds by 
name:

3. In the Inspector, click the Patch Name field.
A pop-up menu appears, listing all GM sounds.

❐ If you are using OMS, this pop-up menu is called “OMS Patch”. It lists the 
patch names in your instrument according to the OMS Patch Names set-
tings you have made (see page 55).

4. Select the desired sound from the pop-up menu.

5. Play the keyboard to try out the new sound.
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Setting levels

While you can set volume, pan, etc. from the Inspector, it is much easier 
to do this from the MIDI Track Mixer:

1. Pull down the Panels menu and select MIDI Track Mixer.
The MIDI Track Mixer window opens. This window contains “mixer strips” for all 
MIDI Tracks, which you can use to mix your MIDI sound sources, manually or 
automatically.

2. Locate the mixer strip for the Track you plan to record on.

3. Use the volume fader and pan control to set volume and pan for the sound.

❐ Note that your instrument must be able to respond to MIDI Volume and 
Pan messages for this to work. Refer to the instrument’s documentation.

If you have a MIDI Instrument compatible with the GS (Roland) or XG 
(Yamaha) standards, you can use the MIDI Track Mixer to control a lot of 
other parameters in your instrument. This is described on page 225.

4. Press [Return] to close the MIDI Track Mixer window.

Pan Control

Volume Fader
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Verifying the Settings

Now when you play your keyboard you should hear the right sound in 
the synthesizer (and only that sound). If not, check the following:

• Is the Track set to the correct MIDI channel?
• Is the Track set to the MIDI Output the instrument is connected to?
• Do you have MIDI Thru enabled on the Options menu in Cubasis VST?
• Do you have Local Off activated in your instrument (if needed and/or available)?
• Is the synthesizer set up to receive MIDI Program Change?

Recording

1. Set start and end-points using the Locators, and decide if you want a Click 
or not, just as when recording audio.

2. Click the Record button.
By default, you will hear a two bar count-in (you can adjust the length of this or 
turn it off completely in the Metronome dialog, as described on page 109).

3. After the precount, start performing.
Recording will automatically be deactivated when you reach the Right Locator, 
if you don’t hit Stop before that.

4. When you are done, press Stop.
A Part appears.

Now, you can listen, Undo or record more on the same Track, just as 
with Audio Tracks.

About overlap

MIDI Tracks are different from Audio Tracks when it comes to overlap-
ping Parts. When you record again where something has already been 
recorded on the Track, the new recording is simply added to whatever 
was on that Track before. When you play back, you will hear both re-
cordings.
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Advanced: Program Change and Bank Select

Program Change Display Setting

When you select sounds in your MIDI instrument from within Cubasis 
VST, you are sending MIDI Program Change messages to the instru-
ment. As described on page 94, this can be done numerically (using the 
Prg setting in the Inspector) or by name (using the Patch Name/OMS 
Patch pop-up menu).

If you select programs numerically, you may find that different MIDI in-
struments number their programs differently. Therefore, you can ad-
just how the program numbers are shown in Cubasis VST: Click on the 
arrow symbol next to the Prg value in the Inspector and select one of 
the options on the pop-up menu that appears.

Bank Select

With Program Change messages, you are able to select between 128 
different programs in your MIDI device. However, many MIDI instru-
ments contain a larger number of program locations. To make these 
available from within Cubasis VST, you need to use Bank Select mes-
sages, a system in which the programs in a MIDI instrument are divided 
into Banks, each Bank containing 128 programs. If your instruments 
support MIDI Bank Select, you can use the Bank field in the Inspector to 
select a Bank, and then the Prg field to select a program in this Bank.

In the MIDI standard, Bank Select messages consist of two separate num-
bers: the “Most Significant Byte” (MSB) and the “Least Significant Byte” 
(LSB). However, different instruments use different methods of combin-
ing these two numbers when transmitting and receiving Bank Select 
messages. To compensate for these variations, Cubasis VST allows you to 
specify which method you want to use for each Part or Track:

1. Select a Track you want to make Bank Select settings for.

2. Open the Inspector.



CUBASIS VST
8 – 98 Recording MIDI

3. Click on the arrow button next to the Bank Select value, to pull down a 
small pop-up menu.

There are five options:

4. Activate the suitable options for the instrument that the Track is set to 
transmit to.
Consult the operation manual for the instrument if you are unsure.

Option Use when

Swap Value Bytes 
(Roland)

When this is activated, the MSB and LSB values are swapped 
when the Bank Select messages are transmitted from Cubasis 
VST. This mode is suitable for some Roland instruments.

Send MSB first When this is activated, the MSB number is sent out before the 
LSB, instead of the other way around.

Send Only One Byte Sends only LSB values, use for devices that don’t differentiate be-
tween the two Bank select types.

Send as PRG Change For devices that use Prg change messages 101-128 to change 
Banks.

Edit as MSB-LSB When this is activated, the Bank Select value will be displayed in 
the Inspector as two separate numbers (MSB–LSB).
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Advanced: Recording SysEx Messages

System Exclusive (Sys Ex) is a special type of MIDI message used to send 
data that only make sense to a unit of a certain make and type. Every 
major MIDI manufacturer has its own Sys Ex identity code. Sys Ex can 
be used to transmit a list of the numbers that make up the settings of 
one or more sounds in a synth. 

You can record System Exclusive messages in Cubasis VST, for example 
if you want to store program settings for your instrument in your Cuba-
sis VST song, or record automation for a VST Instrument. However, re-
corded System Exclusive data cannot be edited in Cubasis VST.

• To record System Exclusive messages, activate the option “Record SysEx” 
on the Options menu, and record as usual.
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The Transport Bar

Below, you will find a brief description of what each control on the 
Transport Bar is used for:

• You can hide and show the Transport Bar by selecting “Hide/Show Trans-
port” on the Windows menu, or by pressing [F12].
Regardless of whether the Transport Bar is visible or not, you can use the Nu-
meric Key Pad to control many of the transport functions:

In addition to this, the space bar serves as an additional Stop key.

• You can move the Transport Bar by clicking the dark handles at the edges 
and dragging.

Song PositionPosition 
Slider

End of Cycle

Record start point and beginning of Cycle

Indicates 
MIDI In/Out 
activity

Turns the Metronome On/Off

Turns the Master Track On/Off

Cycle On/Off

Fast Forward Stop Play RecordRewind

Tempo Time Signature

num
lock = / *

7 8 9 –

4 5 6 +

1 2 3

0 , enter

Record 

Lower Tempo 

Raise Tempo 

Play 

Cycle On/Off 
Rewind 

Fast Forward 

Go To 

Go To 

Left Locator 

Right Locator 

Stop 
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About Position Values

In Cubasis VST, all positions are shown in meter format. This means 
they are related to the tempo and time signature, rather than to exact 
time. 

Positions are displayed as Bars.beats.ticks.

• Beats are the denominator in the time signature - often quarter notes. If the 
time signature is 3/4, each beat is a quarter note and there are three beats to 
each bar.

• Ticks are subdivisions of the beats. There are 384 ticks to each quarter note. 
When note lengths are shown numerically, they are displayed as ticks.

Here, the position is 3.2.0, which means at the start of the second beat in the third 
bar.

Setting the Song Position

The Song Position Pointer is displayed in the Arrange window as a ver-
tical line with a triangular head in the Ruler.

There are several ways to move the Song Position:

• By clicking in the Ruler.
If you click somewhere in the Ruler, the Song Position Pointer is moved there.

• By clicking the Song Position triangle and dragging left or right.

• By pressing [Option]+[Shift] and clicking anywhere in the Part Display or 
the Event Display of an Editor window.
This way, you don’t have to click in the Ruler to set the Song Position.
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With the above methods, the Snap value determines to which positions 
you can move the Song Position Pointer (e.g. if Snap is set to 1/4, the 
Song Position will be moved to the closest quarter note position). See 
page 117 for more information about Snap.

• By using Fast Forward and Rewind on the Transport Bar.
If you hold down [Shift] while clicking the button, Rewind/FF is much faster.

• By using the Position Slider on the Transport Bar.
The position slider is located on the Transport Bar. Drag the handle or click di-
rectly somewhere on the line to move the handle there.

The range of the slider relates to the length of your Arrangement. This means that if 
you drag the slider all the way to the right, the Song Position will appear at the end of 
the last Part.

• By editing the Position value on the Transport Bar.

Returning to the beginning of the Song

If the Song is stopped and you click the Stop button again (or press [0] 
on the numeric key pad), the following happens:

• The Song Position is moved to the Left Locator.
• If the Song Position is already at the Left Locator or to the left of it, the Song Po-

sition is moved to the beginning of the Song.

This means that you can always click twice on the Stop button to return 
to the beginning of the Song.
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Tempo and Time Signature Handling

Transport Bar and Master Track Tempo

There is actually a choice of two sources for Cubasis VST’s tempo:

• When the song uses a steady tempo throughout, you can turn off the Master 
button and simply set the right tempo directly on the Transport Bar. The tempo 
can be adjusted at any time, even while playing back.

• When the song contains tempo changes, you need to use the Master Track, 
(which is Cubasis VST’s tempo Track). For those tempo changes to actually 
“happen” on playback, the Master button on the Transport Bar must be acti-
vated.

Setting the Transport Bar Tempo

To adjust the tempo value on the Transport Bar, use one of the follow-
ing methods:

• Click in the upper or lower part of the tempo value to raise or lower the 
tempo, respectively.
If you hold down [Shift] while clicking, the value will change in steps of ten.

• Click on the value and drag the mouse up or down with the mouse button 
pressed.

• Double click and type in a value.

The Tempo setting on the 
Transport Bar is used.

The Tempi set on the Master Track are 
used and shown on the Transport Bar.
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Using the Master Track

If you want tempo changes in your Song, you need to use the Master 
Track. You open the Mastertrack List Editor by selecting Mastertrack on 
the Edit menu, or by double-clicking the Master button on the Trans-
port Bar.

The Mastertrack window displays a list of all Tempo and Time Signature 
Events in your Song. To insert a new tempo within the Song, proceed as 
follows:

1. Move the Song Position Pointer to where you want the new tempo to be 
inserted.

2. In the Mastertrack window, pull down the topmost pop-up menu and 
make sure “Tempo” is selected.
This determines the type of event to be inserted.

3. Click the “Insert” button.
A new tempo event is inserted at the Song Position.

4. Adjust the new tempo in the “Value” column, in the same way as you ad-
just the tempo on the Transport Bar.

If you now rewind and activate playback (with the Master button acti-
vated on the Transport Bar) you will note how the tempo changes 
when the Song Position Pointer reaches the correct position.

• To delete a tempo event from the Mastertrack, select it and press [Back-
space].
You cannot delete the first tempo event.
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❐ You should avoid changing the tempo after you have recorded audio! 
Even though each separate Audio Part will start at the correct position in 
the new tempo, the actual audio recordings within the Parts will still be 
playing in the tempo you had set when recording!

Time Signatures

The time signature is the number of beats to the bar, e.g. 4/4 (four beats) 
or 3/4 (three beats). You can adjust the basic time signature directly on 
the Transport Bar, but you can also add time signature changes in the 
Master Track window, in the same manner as with tempo changes (you 
only have to select “Timesign” from the pop-up menu in step 2 above).

Locators

The Locators are the two “L” and “R” flags in the Ruler. They have sev-
eral uses:

• Recording starts at the Left Locator and ends at the Right Locator.
• If you activate the Cycle button on the Transport Bar, playback will loop be-

tween the Left and Right Locator.
• Some editing functions affect the area between the locators (see page 125).

As with the Song Position, there are several ways to set the position of 
the Locators:

• By holding down [Option] or [Command] and clicking anywhere in the 
Ruler.
[Option]-clicking sets the Left Locator, [Command]-clicking sets the Right 
Locator.

• By clicking on a Locator flag in the Ruler and dragging.
With both these methods, the Snap value affects where the Locator is posi-
tioned (see page 117).

• By adjusting the Locator values numerically on the Transport Bar.
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• By enclosing a Part.
If you select a Part in the Arrange window (see page 118) and press [Option]-[P] 
on the computer keyboard, the Locators are moved to the start and end posi-
tion of the selected Part, respectively.

This method also works with several Parts selected, as shown in this figure.

Moving the Song Position to the Locators

You can move the Song Position to one of the Locators by clicking un-
der the Left and Right Locator value on the Transport Bar (or by press-
ing [1] or [2] on the numeric key pad, respectively).

About the Cycle

Cubasis VST can play back and record in a Cycle – a loop. You decide 
where the Cycle starts and ends by setting the Left and Right Locators. 
If the Cycle mode is active you can repeatedly listen to a section of the 
Arrangement, and record, adding more on each lap etc. Cycled play-
back is also convenient when editing and when making adjustments in 
the Inspector.

You set up and activate the Cycle in the following way:
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1. Set the Left Locator to the position where you want the Cycle to begin.

2. Set the Right Locator to the position where you want the Cycle to end.
For this to make sense, the Right Locator should be to the right of the Left Loca-
tor.

3. Click on the Cycle button on the Transport Bar so that it gets activated, or 
press [/] on the numeric key pad.

Cycle activated on the Transport Bar.

Now, when the Song Position Pointer reaches the Right Locator during 
playback, it will jump back to the Left Locator.

About Recording in Cycle Mode

When recording in Cycle mode, the results are different for MIDI and 
audio recording:

• When you record MIDI in Cycle mode, the notes you add for each Cycle lap 
are simply added to the existing notes in the Part.
For example, this is useful when you are recording drum patterns: record the 
bass drum on the first lap, the hi-hat on the next, and so on.

• When you record audio in Cycle mode, the result is one long audio file, 
containing all the Cycle laps you recorded.
However, there will be a separate audio segment for each Cycle lap. This allows 
you to select the “best take”, by auditioning the segments in the Pool (see page 
143) and dragging the best one into the Arrangement.
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Setting up the Metronome Click

As mentioned earlier, you turn the metronome click on and off on the 
Transport Bar. You can also specify the click type and volume, whether 
you want a count-in etc. These settings are made in the Metronome di-
alog, opened from the Options menu, or by double-clicking the Click 
button:

The Precount section

Activate this if you want a count-in when you start recording from stop 
mode. The Bars value sets the length of the Precount (by default, 2 bars).

Click activated on the Transport Bar.
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Audio Click

Activating this will give you an audio click, played back via the audio 
hardware. You can set the volume of the click in the value field below.

MIDI Click

Activating this checkbox will give you a MIDI click, played back on what-
ever MIDI instrument you have connected. The value fields in the sec-
tion allow you to select which MIDI Channel and Output the click should 
be sent out to, as well as note number and velocity for the high note (the 
first beat in each bar) and the low notes (the other beats).

❐ The Click button on the Transport Bar still governs whether the metronome 
should be activated or not! However, if you deactivate all three checkboxes, 
no click will be heard, even if you turn on the Click button.
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About Songs and Arrangements

A Song is the main Cubasis VST document format. This contains all your 
recorded music and all settings.

• You can only have one Song open at a time.
In fact, there is always one Song open – you cannot run Cubasis VST without a 
Song opened. This is very important to realize.

• If you open a Song, this will replace the current Song.
If you have unsaved changes, you will be asked whether you want to save the 
current Song first.

• If you want to create a new Song, you should use the New Song command 
on the File menu.

Within the Song, an Arrangement contains your music. You can have 
several Arrangements in the same Song (up to 16), each with its own Ar-
range window. This allows you to create several versions of the same 
piece, use one Arrangement as a “storage facility” for recordings, phrases 
and alternate takes, etc. You can also use this feature to create a collec-
tion of favorite pieces and save them all as one document (a Song).

• To create a new Arrangement, select New Arrange from the File menu.

• To select between open Arrangements, click on the windows, or use the 
Windows menu, which lists all Arrangements in the Song.

• If you close an Arrangement, a dialog appears that allows you to save your 
changes. In this dialog, you will find an option called “Set Aside”. 
By using this option, you will close the Arrangement window but the actual 
data are kept in memory. To reopen the window, select the Arrangement from 
the Windows menu.
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About Closing – Important!

The Close item on the File menu closes the current Arrangement! It is 
not possible to close the Song. Therefore, if you are finished working 
with a Song, either quit Cubasis VST or start with a new Song, in the fol-
lowing way:

• Select New Song from the File menu.
This opens the default Song, allowing you to start with a clean slate.

About Tracks, Parts and Arranging

As you have already seen, the Cubasis VST Arrangement is roughly 
structured in two “levels”: Several Tracks, each containing a number of 
Parts. This chapter is about Arrangement editing – in other words, re-
arranging Tracks (done in the Track list, to the left in the Arrange win-
dow) and Parts (done in the Part Display, to the right in the Arrange 
Window).
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Creating and Managing Tracks

The Track is one of the most basic concepts in Cubasis VST. Every time 
you record something in Cubasis VST, the recorded material is placed 
on a Track. You can have up to 64 Tracks in each Arrange window, and 
you can easily move or copy material between Tracks, as long as they 
are of the same type (MIDI or Audio). 

When you are working with audio, different Tracks can be set to play 
back on different audio channels, which is essential if you want several 
audio files to be played back simultaneously. In MIDI recording, the most 
obvious reason for putting the recorded material on different Tracks is 
perhaps that you want to have your music played back by different “in-
struments” – or maybe rather by different sounds on a MIDI sound mod-
ule or keyboard.

Creating Tracks

You create Tracks by using any of the following methods:

• Double click in the empty area below the last Track in the Track list.

• Pull down the Structure menu and select Create Track.

• Press [Command]-[T] on the computer keyboard.

After creating a Track, you may want to change its Track Class (MIDI or 
Audio). This is done by clicking in the “C” column for the Track and se-
lecting MIDI Track or Audio Track from the pop-up menu that appears.
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Making Track Settings

You make settings for a Track by adjusting the values in the Track 
columns:

• Some of the Track column settings can also be changed in the Inspector.

Selecting Tracks

You select a Track by clicking on its name field in the Track List, so that it 
is highlighted. Selecting a Track allows you to make settings in the In-
spector for all Parts on that Track. Recording is also automatically routed 
to the selected Track.

Moving and Duplicating Tracks

To move a Track up or down in the list, click on its name and drag it to 
the desired position (the Parts on the Track will follow). To duplicate a 
Track, including its Parts, press [Option] and drag it to a new position in 
the list.

Column Description

A (Activity) Indicates playback or recording on a Track. You cannot change any-
thing in this column.

M (Mute) Used for muting the Track (see page 116).

C (Class) Used for selecting MIDI or Audio Tracks.

Track The name of the Track. Double click to change.

Chn (Channel) For MIDI Tracks, this is the MIDI channel (1-16) for the Track. Use this to 
direct the Track to a specific channel in your MIDI instrument.
For Audio Tracks, this is the audio channel (see page 75).

Output If you have more than one MIDI output, you use this pop-up menu to 
select an output for each MIDI Track. By selecting different Outputs 
for different Tracks, you can direct the Tracks to different instruments, 
having one Track send MIDI to an output on your MIDI interface while 
another Track sends MIDI to a VST Instrument, etc.
You cannot change the Output setting for Audio Tracks.
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Deleting Tracks

To delete a Track, proceed as follows:

1. Click in an empty area in the Part display, to make sure no Parts are 
selected.

2. Select the Track.

3. Click [Backspace] or select Delete Track from the Edit menu.
If the Track contains any data, you will be asked to confirm that you really want 
to delete it.

Mute and Solo

• If you click the Solo button at the top of the Arrange window, you will only 
hear the active Track.

• By clicking in the Mute (M) column in the Track list, you can silence any 
Track temporarily.

The white dot 
indicates that 
this Track is 
muted.

The Solo 
button.
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Working with Parts

Parts can be viewed as “containers” for your MIDI and audio data. By 
manipulating Parts in the Part Display, you can quickly rearrange and 
structure your Arrangement.

About the Snap value

When you are moving, duplicating or changing the length of Parts, the 
result of your actions depends on the Snap value. 

The Snap pop-up menu.

This value puts a restriction on the positions where you can perform 
editing actions. If you for example set snap to “Bar” and move a Part by 
dragging it, it will always start at an exact bar line when you release it. 
Likewise, if you cut the Part in two, with the scissors, the split will then 
always occur at an exact bar line.

The Snap values are as follows:

Snap Value Description

Off Any position is allowed.

Bar Actions are restricted to exact bar lines.

1/2 to 1/16 Actions are restricted to the selected note value.

If Snap is set to Bar... ...Parts can only be dragged to exact bar lines.

If Snap is for example set to 1/4... ...Parts can be put on any quarter note position.
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Selecting Parts

You have to select a Part in order to move, delete or manipulate it in 
any way. Selecting a Part can be done in several different ways:

• Clicking on a Part selects it.

• Holding down [Shift] and clicking on Parts selects these too, without dese-
lecting other Parts.

• By pressing the mouse button with the pointer in a “free” area of the Part 
Display, you can drag to create a selection rectangle.
This works just like when selecting files and folders on the desktop.

• The Select All item on the Edit menu allows you to select all Parts in the Ar-
rangement.

Using the Arrange Window Tools

For many Part operations in the Arrange window, different tools are 
needed. The tools are gathered in a “Toolbox”, which can be accessed 
from the Tools menu.

• To select a tool, pull down the Tools menu and select one of the tool icons.
The pointer will now take on the shape of the selected tool.

• To use the Toolbox as a separate window, click the Tools menu and drag it 
anywhere on the screen.
Now you can select tools by clicking on an icon in the Toolbox.

Click this button to toggle 
between a horizontal and 
vertical Toolbox window. 

Click here and drag to move 
the Toolbox.

Click here to close the 
Toolbox.
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• You can also temporarily display the Toolbox at the current pointer posi-
tion by pressing [Control] and clicking.
After selecting a tool and releasing the mouse button, the Toolbox will be hid-
den again. 

❐ If you are using a mouse with two buttons, you may want to set up the right 
mouse button to generate a [Control]-click. This way, you can display the 
Toolbox by right-clicking anywhere in a Cubasis VST window.

Moving and Duplicating Parts

To move one or more Parts to a new position, proceed as follows:

1. If you want to move several Parts, select these.

2. Select the Arrow tool.

3. Click and drag the Part(s) to a new position.
The Snap value applies as described on page 117.

❐ Note that you cannot move an Audio Part to a MIDI Track or vice versa.

• To duplicate (copy) Parts, press [Option] and drag.
You can also duplicate Parts with the Repeat Parts function (see page 122).

Changing the length of Parts

To change the length of a Part, proceed as follows:

1. Select the Pencil tool

2. Click in the Part and keep the mouse button pressed.

3. Drag to the new desired length.
The Snap value applies as usual.

• You can resize several Parts at the same time, by selecting them and resiz-
ing one of them with the Pencil tool.
This will move the endpoint of all selected Parts to the same position. 

❐ If you make a MIDI part shorter using this method, the notes in the 
“removed” section will be erased!
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Splitting Parts

You can use the Scissors tool to split Parts:

1. If you want to split several Parts simultaneously, select these.

2. Select the Scissors tool.

3. Click on one of the selected Parts.
All selected Parts are split in two, at the position where you clicked (taking the 
Snap value into account). The “new” Parts will have the same name as the orig-
inal Parts.

• If you hold down [Command] when you click with the Scissors tool, the se-
lected Parts will be split at a position relative to each Part’s start points.
For example, if you have a 4 bar Part and a 7 bar Part selected, and click with the 
Scissors two bars into one of the Parts, the other will also be split at a position 
two bars from its start point.

• If you hold down [Option] when you click, the Part(s) will be split into sev-
eral sections, with the length determined by the click position.
For example, if you have a six bar Part and [Option]-split it after the first two 
bars, it will be cut into three two bar Parts.
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Joining Parts together

Joining Parts means turning two shorter Parts (on the same Track) into 
one long Part. This is done by clicking on the first Part with the Glue 
Tube tool:

• If the Parts overlap, they are merged in the overlapping area. No Events 
are lost.

• If you hold down [Option] and click on a Part with the Glue Tube tool, all 
the following Parts on that Track will be glued together.

Monitoring the contents of a Part

With the Speaker tool, you can listen to the contents of each Part sepa-
rately in Stop mode:

1. Select the Speaker tool.
From there on, the procedure differs for Audio Parts and MIDI Parts:

2. To monitor the contents of an Audio Part, click anywhere in the Part.
You will hear the contents of the Part played back, from the point where you 
clicked, for as long as you keep the mouse button pressed (or until the end of 
the Part).

3. To monitor the contents of a MIDI Part, drag the pointer forwards or back-
wards over the Part.
Notes and other MIDI Events will be played back according to how fast you drag 
the pointer.

Gluing two Parts together, regardless of if they are spread apart...

...gives you one long Part with the name of the first.
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Deleting Parts

There are several ways to get rid of unwanted Parts.

• Select them and press [Backspace] on the computer keyboard.

• Select them and use Delete Parts on the Edit menu.

• Click on the Parts with the Eraser tool.
If you hold down [Option] when you click, the Part and all the consecutive Parts 
on the Track will be deleted.

❐ Deleting an Audio Part will not erase the actual audio file or the segment 
in the Pool! 
To delete an Audio Part and erase the corresponding audio file from the 
hard disk, select the Part, hold down [Command] and press [Backspace].

Repeating Parts

You can repeat one or several Parts, on the same or different Tracks, us-
ing the Repeat Parts function on the Structure menu:

1. Select the Part(s) you want to repeat.

2. Select the “Repeat Parts” item on the Structure menu (or press [Com-
mand]-[K] on the computer keyboard).
The Repeat Parts dialog appears.

3. Enter the desired number of copies in the dialog.

4. If you activate the Ghost Copies checkbox, the copies (and the original 
Part) will become Ghost Parts.
See below.
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5. Click “Do It”.
The selected Part(s) are repeated, and the copies are lined up “end-to-start” af-
ter the original(s). The selected Parts are treated as one block, so the relative 
spacing between the created Parts is determined by the beginning of the first 
selected Part and the end of the last.

About Ghost Parts

Ghost Parts are “linked copies”, which means that if you edit the origi-
nal or a copy in any of the Edit windows, the changes show up in all the 
ghost copies (including the original Part). 

This can be useful e.g. if you have copied a few bars of drums through-
out the Song, and need to adjust the drum pattern at a later stage – just 
change the pattern in one of the Parts and the other Ghost Parts are au-
tomatically adjusted the same way.

• If you alter the contents of a Ghost Part by recording over it, merging it with 
another Part or by splitting or joining, it is automatically converted to a reg-
ular copy.

Repeating Parts with the Pencil tool

An alternative way of repeating Parts is to use the Pencil tool, in the fol-
lowing way:

1. Select the Parts you want to repeat.

2. Select the Pencil tool.

3. Press [Option], click in one of the Parts and drag to the right.
When you drag, a rectangular outline is shown.

4. Release the mouse button at the position where you want the last re-
peated Part to end.
The Parts are repeated to fill out the rectangular outline.

Original Parts Repeated Parts
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Using Copy and Paste

You can apply standard Copy and Paste techniques to your Parts. This, 
among other things, allows you to move Parts between Arrangements 
(see below).

Cut and Copy work just like in any Macintosh program with the follow-
ing additional rules.

• Pasted Parts always appear on the same Track(s) as they originally came 
from.

• If you Paste in just one Part, it appears at the Song Position. If you Paste 
several, the first Part in the “block” appears at the Song Position. The 
other Parts keep their relative positions to the first.
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Editing the Arrangement Structure

On the Structure menu you will find three functions for making large-
scale adjustments to your Arrangement structure:

Cut At Locators

This command removes the area between the Left and Right Locator, 
on all Tracks.

• The Parts to the right of the Right Locator will be moved left, filling out the gap.
• Any Parts that have a section inside the Locators, are shortened, and the Events 

within these sections are removed.
• Muted Tracks are not affected, but the Master Track (for tempo and time signa-

tures) is cut like any other Track.

Insert At Locators

Insert at Locators is the opposite of Cut at Locators; an empty area is in-
serted between the Locator Positions (on all unmuted Tracks):

• The length of the piece will be the number of bars between the Left and Right 
Locator. For example, to insert four bars starting at bar three, set the Left Loca-
tor to 3.1.0 and the Right Locator to 7.1.0.

• All music after the Left Locator is “pushed” to a later position.
• Parts that start before the Left Locator and end after it, will be lengthened by 

the selected amount of bars (the lengthened sections will be empty).
• Muted Tracks are not affected, but the Master Track is affected like any other 

Track.

Split At Locators

This command splits Parts on all Tracks at the Left and Right Locator 
positions, just as if you had done it with the Scissors Tool.

• If you only want to make one split, set the Left and Right Locators to the same 
position.

• Muted Tracks are not affected.

An alternative splitting method (that will include muted Tracks), is sim-
ply to select all Parts and then split using the Scissors tool.
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Using the Inspector

Cubasis VST features an area in the Arrange window called the Inspec-
tor. From here, you can make settings for the currently selected MIDI 
Parts, or (if no Parts are selected) for the selected MIDI Track.

❐ When you adjust Volume, Transpose, Velocity or Pan values in the Inspec-
tor, you don’t actually change the recorded data. Rather, your adjustments 
affect the MIDI during playback. This also means that your changes won’t 
be visible in a MIDI editor.
If you want to make your changes permanent, use the function “Freeze 
Play Parameters” on the Functions menu.

Opening and closing the Inspector

The Inspector is opened/closed by clicking the Inspector icon in the 
lower left corner of the Arrange window, or by pressing [Option]-[I] on 
the computer keyboard.
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The Inspector Parameters

For MIDI Parts and Tracks, the Inspector contains the following settings:

For Audio Tracks, the Inspector is mainly used for setting up for record-
ing, as described on page 76.

The Bank Select value 
(necessary to select 
sounds in your MIDI 
instrument, if there are 
more than 128 sounds 
– see page 97).

The Program Change value. Use 
this for selecting sounds in your 
MIDI instrument. See also page 97

Sends out a MIDI Volume 
message on the selected Parts’ 
MIDI channel(s).

Use this to adjust the Velocity 
values of the notes in the se-
lected Part(s). On playback, the 
value is added to/subtracted 
from the actual velocity values.

Use this to transpose 
the selected Part(s) in 
semitone steps.

You can also select sounds by 
name, using this pop-up menu.

Sends out a MIDI Pan 
message on the selected 
Parts’ MIDI channel(s).

The name of the Part. Double 
click to rename it.

The Start and End 
positions of the Part. 
Changing these will 
move or resize the 
Part, respectively.

The label “Part Info” shows 
that one or several Parts are 
selected (if no Part is selected, 
the label says “Track Info”).
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Quantizing MIDI notes

What is Quantizing?

Quantizing is a function that automatically moves recorded MIDI notes, 
positioning them on exact note values. If you for example record a se-
ries of eighth notes, some of them may end up slightly beside the exact 
eighth note positions. Quantizing the notes with the Quantize value set 
to eighth notes will move the “misplaced” notes to exact positions.

The Quantize value on the pop-up menu on the Status Bar determines 
the exact positions the notes should be moved to when you quantize. 
These are the options:

❐ Quantizing in the Arrangement is the method to use if you want the Quan-
tization to affect all notes in the selected Part(s). If you only want to quan-
tize some of the notes in a Part, you should use the Quantize function in 
one of the MIDI Editors instead.

This column is for selecting the basic Quantize 
note value. As you see, the available values 
range from 1 (whole note) to 128 (1/128 note).

If you select Off, no quantizing will be done.

If you drag the pointer to the right, you can add a “T” or a “.” option
to the note value. This will result in a Triplet (T) or Dotted (.) Quantize value.
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Performing the Quantize

1. If you want to Quantize a certain set of Parts, select these.
If instead, you want to Quantize all Parts on a Track, select this Track in the Track 
list and make sure no Parts are selected in the Part display.

2. Select the appropriate Quantize value, as described above.

3. Select Quantize from the Functions menu.

4. Play back to listen to the change.

Undoing Quantize

If you don’t like what you got when Quantizing, you can Undo it like any 
other action. However, Undo of Quantizing goes one step further. By using 
“Undo Quantize” on the Functions menu, you can revert Parts to their un-
quantized original, at any time, even after saving!

Other MIDI Functions

On the Functions menu, you will also find two additional MIDI editing 
functions:

Delete Doubles

This command erases all double notes in the selected Part(s). Such dou-
bles most often occur when you record in Cycle mode and record over 
more than one lap. Double notes can be hard to hear, but sometimes 
sound like short delays, flanger effects, or even just as one loud note.

Delete Cont. Data

This command erases all Continuous data in the selected Part(s), or 
more specifically, the following:

• Controllers
• Pitch Bend
• Channel Pressure
• Poly Pressure
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What is the Pool?

In the Pool, all audio files in the Song are listed, similar to the display of 
the files and folders in the Macintosh Finder. Every time you add an au-
dio file to the Song, by recording or by importing it from your hard disk, 
it appears in the Pool.

But Cubasis VST is not restricted to playing complete files. It can also 
play any section of a file from the beginning, at the end, or some snip-
pet in the middle, short or long, it doesn’t matter.

A section of a file is called segment. A single audio file can have several 
segments. For example, different sections of an audio file might be 
used several times in the song.

❐ The Pool is not used for MIDI Tracks.

This Audio File has five segments, playing different sections of the file.

The number to the left of the name shows how often each segment 
is used in the Song.
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Opening the Pool

The Pool is opened by selecting “Audio Pool” from the Panels menu or 
by pressing [Command]-[F].

Viewing Files and Segments

Files

Each file is represented by a line, preceded by a triangle.

The file columns have the following functionality:

File Heading Explanation

File Name The name of the file, on disk.

Disk The Disk the file resides on. If the file can’t be found, three question 
marks are shown instead (see page 141).

S/M Stereo/Mono – one bullet indicates mono, while two bullets indicate a 
stereo file.

F A tick mark indicates the file has been found, a crossed circle shows 
that it has not been found (see below). Clicking in this column lets you 
replace an audio file, as described on page 140.

Img This shows you the status of the waveform image for the file, see below.

Length This shows the size of the file in kilobytes.

Date and Time This shows the date and time the file was created.

Quality and 
Broadcast

These are described on page 259.
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Segments

Each file that is in use has one or more segments, listed below the file in 
the Pool. 

The segment columns have the following functionality: 

To display or hide the segments for one audio file, click on the triangle 
preceding the file.

• To Show/Hide all segments for all files, select Expand/Collapse from the 
View pop-up menu.

Segment Heading Explanation

Hear To play the segment, click in this column (on the speaker symbol) 
and hold down the mouse button (see also page 143).

Segment (name) The name of the segment.

Start The segment’s Start Inset in the file. Displayed in samples, as a 
meter position, or as time code, depending on the selected format 
(as described on page 135). This value can be changed, see below.

End The segment’s End Inset in the file. Can be changed.

Length The length of the segment. Cannot be changed.

SRate The Sample Rate of the file.

Range An overview of the segment in the file.
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Customizing the View

Hiding Headings

If you don’t need the Headings at the top of the window you can hide 
them using the “Show/Hide Headings” item on the View pop-up menu.

Turning on and off Information

If you don’t need all the information fields for the files and segments, 
you can deactivate these by clicking the “i” icon at the top of the win-
dow. Among other things this allows you to get a more detailed over-
view of the waveforms.

Turning on and off Waveforms

If you don’t need to see the waveforms for the segments, you can hide 
them by clicking on the waveform icon at the top of the window.

Zooming and setting Sizes of the Waveforms

If you change the width of the window, the waveforms are scaled accord-
ingly. That is, the bigger you make the window the more detailed the view 
of the waveform will be.

By using the vertical zoom control (below the scrollbar to the right) you 
can set the vertical size of each line, to get a better overview of the 
waveforms.
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Selecting Time Formats

You can set whether the Start, End and Length values should be dis-
played in samples, as meter positions, or as time code values, by clicking 
the Time Format button at the top of the window. Each time you click, 
the symbol in the button changes, and a new format is selected.

• If you select samples, the values are shown as numbers of samples. 
How many samples there are to a second depends on the sample rate (48000 
samples per second at 48kHz for example).

• If you select time code format, the values are shown in the format 
“hours:minutes:seconds:frames:subframes”. 
There are 25 frames to a second.

• If you select meter position format, the start and end inset values indicate 
the start and end position of the first instance of the segment in the Song, 
as bars, beats and ticks.
If the segment is not used, the start inset will show 1.1.0 and the end inset will 
show the end position as it would be if the segment had really started on 1.1.0. 
The length value shows the length of the segment in bars, beats and ticks, start-
ing with 0.0.0 – in other words the difference between the end inset value and 
the start inset value.

❐ Please remember that if you have meter position format selected, the End 
Inset and Length values depend on the tempo. That is, if you change the 
tempo, these values will change as well.

Sample format Time code format (“frames”) Meter position format



CUBASIS VST
11 – 136 Using the Pool

Setting File and Segment Order

File Order

On the View menu, you can determine in which order the files should 
be displayed:

Segment Order

By selecting “Order Segments” from the View pop-up menu, you re-ar-
range the segments so that they are shown in the order they appear in 
the file.

Option Description

By Name Files are shown alphabetically.

By Date Files are shown chronologically according to the time they were created, 
with the newest file at the top.

By Size Files are shown in size order, with the largest one at the top.
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Finding Out how a Segment is used in the Song

One segment can be used in more than one place in a Song. There are a 
number of situations where you will want to find out where a segment 
is used, for example:

• So that you can tell that a segment isn’t used anywhere and possibly delete it.
• If you want to know if a segment is used in more than one place, so that you can 

decide how editing the segment affects the Song.

Number of Times the Segment is used

Next to the speaker icon for each segment, you will see a number tell-
ing you how many times in the Song this segment is used. A “greyed 
out” segment without numbers is not used anywhere.

Finding Out Where the Segment is used

1. Select one or more segment(s).

2. Select Find Parts from the Do pop-up menu.
Now the Parts that play the selected segment(s) get selected in the currently 
active Arrange window.
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File Operations

Renaming a File

To rename a file, proceed as follows:

1. Double click on the existing name, or select the file and press [Option]-[N].

2. Enter a new name or edit the existing one.

3. Click outside the box or press [Return].

❐ This method is much better than renaming files in the Finder. This way, 
Cubasis VST “knows” about the change and will not lose track of the file 
the next time you open the Song. See page 141 for details about lost files.

Locating a File on the Hard Disk

To find out where on the hard disk a certain file is located, hold down 
[Command] and click on the file. A pop-up showing you the file loca-
tion appears.

Deleting Files

Removing from Audio Pool

If you want to remove one or more files from the Audio Pool without 
actually deleting them from the hard disk, proceed as follows:

1. Select the file(s).
Selecting more than one is done just as with any other object in Cubasis VST, by 
clicking in combination with the [Shift] key.

2. Select “Delete Entry” from the Edit menu or press [Backspace].

• This way you can only delete Audio Files from the Pool which are not 
used in any Part in the Arrange window (greyed out in the Pool).
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Removing from the Audio Pool and deleting from Hard Disk

If you want to remove the file from the Audio Pool and also delete the 
file permanently from the hard disk, proceed as follows:

1. Select the file(s).

2. Hold down [Command] and press [Backspace].
A dialog box asks you if you are sure you want to perform this operation. Re-
member that this operation can not be undone!

Deleting all Unused Files

This function finds all files in the Audio Pool that are not used in the 
Song, and removes them permanently from the hard disk.

❐ Please note that you cannot undo this operation – make sure the unused 
files aren’t used in any other Songs!

1. Pull down the File pop-up and select Delete Unused Files.
If there are unused files in the Audio Pool, a dialog reminds you that the opera-
tion cannot be undone, and asks you if you want to continue.

2. If you change your mind, click Cancel. Otherwise, click OK.

Creating a Segment

You can create a “default” segment for the file, that is one that plays the 
entire file.

1. Select the file.

2. Select Duplicate Segment from the Do pop-up menu.
The new segment can be edited to play any part of the file (see page 144). You 
can also select the new segment and use the Export Segment function (see 
page 150) to create a copy of the original audio file.
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Replacing a File in the Pool

There are situations when you may want to replace an audio file in the 
Pool with another, but keep all segments that are in use. As an exam-
ple, consider the following situation: 

You have used an external Wave Editor to perform some dynamic or 
spectral editing on an audio file. To be on the safe side, you save the ed-
ited audio file under an new name. When you return to Cubasis VST, 
you will want to be able to replace the original file, so that all segments 
refer to the new, edited audio file instead, and preferably be able to 
switch back if you change your mind. Proceed as follows:

1. Click on the symbol in the “F” column for the file.
A dialog appears, asking if you want to “re-find” the file. Click “Yes”.

2. In the file dialog that appears, select the audio file that should replace the 
existing file in the Pool.
In our example above, this would be the edited version of the audio file.

3. A dialog appears, telling you that the file you selected has a different 
name or date than the original. Click OK to proceed.

4. Another dialog will ask you if you are sure. Click “OK”.
The audio file in the Pool is now replaced with the one you selected in the file 
dialog. The segments keep their names and, if possible, their start and end inset 
positions. If you later want to switch back to the original file, just repeat the 
operation.

❐ Please note that the replacing audio file must be of the same length as the 
original file, for the segment start and end insets to be relevant! If you per-
form any editing that involves changing the length of the file (such as time 
stretch, truncating, etc.), this method does not work, since you will have to 
create new segments.
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Handling “Missing Files”

When you open a Song, you may get a warning that one or more files 
are “missing”. A file is considered missing under one of the following 
conditions:

• The file has been moved to another folder or renamed in the Finder since the 
last time you changed the Song, and you ignored the Missing files dialog when 
you opened the Song.

• With the program running and a Song open, you have used the Finder to move 
or rename a file or change some of its properties (such as date).

In the dialog that appears you can select one of the following options:

• Auto
If you choose Auto, the program scans all your hard disks for a file with the 
proper name and creation date.

❐ Please note that Cubasis VST is quite strict about identifying the files you 
use. The program retains information on the Name and Creation Date of 
every file saved in a Song. If these values are changed by you, or a program 
you may be using, you will not be able to rely on Cubasis VST's “auto-find” 
function. In this case you will have to use the “Manual” option and “over-
ride” the subsequent warnings.

• Manual
If you choose Manual, the program will display a file dialog allowing you to lo-
cate the file manually. When you have found the file, click OK to replace the 
missing file in the Audio Pool. If the name or date is not identical to the missing 
one, the program will warn you but let you proceed. The next time during this 
session that the program attempts to search for a missing file, it will first look at 
the position of the last found file.
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• Skip
The program will ignore the missing file and continue to open the Song.

• Skip All
The program will ignore this and all subsequent missing files and open the 
Song.

If you chose the “Skip” options, the Song will open without the missing 
files. In the Audio Pool you can check which files are considered miss-
ing. This is indicated by a crossed circle next to the file (instead of the 
usual check mark) and three question marks in the Disk column.

• If you click on the crossed Circle, the “File cannot be found” dialog will ap-
pear again, allowing you to locate the file, automatically or manually, as 
described above.

Creating Wave Images and keeping them up to date

With each audio file goes an image, a picture of the waveform for dis-
play in various places in Cubasis VST. The wave images are very useful, 
when editing your files in the Arrangement or in the Audio Pool.

Wave images are created after you have completed recording, in a pro-
cess that may take a few seconds. In the Pool, the states of the wave im-
age are indicated like this:

Updating the Wave Image

To update the wave image for one file, click on its icon.

Icon Description

The image is OK.

The file has no image.

This file is found

This file is missing
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Segment Operations

The Audio Pool allows you to create new segments, slightly or drasti-
cally different from those you already have in your Song, and drag and 
drop these into the Arrange window.

Auditioning a Segment

From the Beginning

To audition a segment from its beginning, press and hold the mouse 
button with the pointer over the speaker icon to the left of the segment 
name.

When you press and hold the mouse button, the pointer turns into a loudspeaker 
symbol.

From any Position

To start playback from any position in the segment, click with the 
mouse pointer in the waveform to the right. Playback will start from the 
position you click on.

When you press the mouse button, the pointer turns into a loudspeaker symbol.
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Renaming a Segment

To rename a segment, proceed as follows:

1. Double click on the existing name or select the segment and press [Op-
tion]-[N].

2. Enter a new name or edit the existing one.

3. Click outside the box or press [Return].

Duplicating Segments

To create a copy of a segment, proceed as follows:

1. Select the segment by clicking on it.

2. Select Duplicate Segment from the Do pop-up menu.
The new segment appears in the Audio Pool.

Changing Start and End Insets

You can change the Start and End points of the segment. This allows 
you to change what part of the audio file the segment plays.

❐ Please note that this change will affect all places in the song where this 
segment is used.

By Numerical Editing

You can adjust the Start and End Inset values by regular value editing. 
See page 135 for a description of the different time formats.

By Dragging

You can also drag the Start and End Inset directly in the waveform.

1. Position the pointer over the beginning or end of the segment.
If the segment currently plays the entire file, these two points are at the begin-
ning and end of the waveform image.

2. Press the mouse button and drag left or right.
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Moving the Segment

To move the segment within the file, without changing its length, pro-
ceed as follows:

1. Hold down [Command].

2. Position the pointer over the segment and drag left or right.
A dotted outline of the segment is shown while you are dragging.

Deleting segments

Deleting one or several segments from the Audio Pool

1. Select the segment(s).
Selecting more than one segment is done just as with any other object in
Cubasis VST, by clicking in combination with the [Shift] key.

2. Select Delete Entry from the Edit menu or press [Backspace].

• This way you can only delete Audio Files from the Pool which are not used in 
any Part in the Arrange window (and which are greyed out in the Pool).

Deleting all Segments not used in the Song (Purge)

To automatically delete all segments that are currently not used in the 
Song, select Purge Segments from the Do pop-up menu.
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Deleting Unused Portions of Audio Files (Erase 
Unused)

“Erase Unused” allows you to “trim” down your Audio files so that they 
only contain the sections actually referenced by that file’s segment. This 
helps you maintain as much free space on the hard disk(s) as possible.

The idea behind this is that hard disk space is most often precious, and 
recorded silence (for example) takes up as much hard disk space as re-
corded “noise”. When you adjust Start and End Points in segments to 
“hide” the sections of audio you don’t want to hear, you are still using up 
valuable disk space for those unheard bits. To “fix” this, use Erase Unused.

Which Parts of the Files are considered Unused?

Unused portions of a file are the sections not played back by any seg-
ment currently used in the Song.

These segments are each used in one place in the Song.

These segments are not used in the Song.
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Applying Erase Unused

❐ Erase Unused changes the contents of one selected audio file. If you use 
the file in another Song, or if you want to be able to go back to the original 
recording, make sure you have a copy of the file before you begin!

1. Select either the file or one of it's segments.
This command works on “one sound file at a time”. For this function to work, 
two criteria have to be fulfilled:

• The audio file must be used by at least one Event somewhere in the Song.
• There must be some section of the audio file that isn’t used by any Segment 

(otherwise there’s nothing to erase, right?).

2. Select the “Erase Unused” command from the pop-up menu.
A dialog box will display how much of the original audio file will be kept, and 
ask you if you want to go on.

3. Click Compact.
First the unused Segments are deleted. Then a new audio file is created, con-
taining only the used sections of the original file, “joined together” with only a 
short section of silence in between. New segments are created accordingly, 
and the audio file references in the Song are adjusted to use the new segments 
and file. Finally, the original audio file is permanently deleted from the hard 
disk.
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Importing Files into the Pool

If you have any other audio file on your hard disk, and would like to use 
it in the song, you can import it into the Pool and then drag it into the 
Arrangement, as described on page 151.

File Specifications

The Audio file must meet the following specifications:

• The file format must be Sound Designer II, Wave (WAV), Audio IFF (AIFF) or MP3.
• It must be an uncompressed 16 bit file.
• The sample rate (also called sampling frequency) of the file must be the same as 

the one used in the Song (see page 73).
• The file can be mono or stereo.

Importing the file

By using Drag and Drop

The simplest way to import files into Cubasis VST is to drag them into 
the program from the desktop or a folder on your hard disk:

1. Open the Pool.

2. Arrange the windows so that you can see both the Pool and the desktop (if 
that’s where the audio file is).

3. Click on the file and drag it from the desktop into the Pool.

❐ It’s also possible to drag file directly from the desktop into the Arrange 
window!
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By using the File pop-up menu.

1. Open the Pool.

2. Select Import Audio from the File pop-up menu.

A regular file dialog appears.

3. Select a file format from the File Type pop-up.
Files of the selected type(s) are listed in the file dialog box.

4. Use the file dialog box to locate the file and select it.

• You can audition the audio file with the Play button.
When you click the Play button, its label changes to “Stop” and the selected au-
dio file is played back. Playback continues until you click on Stop, or select an-
other file.

• You can select several files by [Shift]-clicking.

5. Click “Open”.
Now, the File(s) will appear at the bottom of the Pool window, each complete 
with a segment which can be dragged into the Arrangement (see above).

• Again, you can also import audio files directly into the Arrangement, us-
ing the “Import Audio File…” item on the File menu.
This will put the imported audio on the selected Track, at the Left Locator.

❐ When you import an MP3 file, the program will create a copy of the file and 
convert this to AIFF format before importing it (the original MP3 file will 
not be used in the Cubasis VST Song). The AIFF file will be placed in the 
currently selected Audio Files folder (if you haven’t yet specified one, you 
will be asked to do so). 
Please be aware that the converted AIFF file will be several times larger 
than the original MP3 file!
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Converting Sound Designer II files to AIFF files

As described above, Cubasis VST can import SD II files, and some file 
operations in the program will also create SD II files. However, in some 
situations this may not be the desired file format:

• If you are planning to move projects or files to the PC (SD II files are not used by 
PC applications).

• If you are using the InWire/RocketPower feature for collaborating with other 
Cubasis VST users over the Internet. This requires the audio files to be in AIFF or 
Wave format.

• If you want to edit or use the files in other applications that don’t support SD II.

For these reasons, you can convert SD II files by selecting them in the 
Pool and selecting “Convert SDII to AIFF” from the File pop-up menu. If 
you are uncertain which files are of which format, you can simply select 
all files and perform the conversion – files in other formats are not af-
fected.

Exporting Files and Segments

You can export segments from the Audio Pool as individual files, for 
use in other applications:

1. Select the segment you wish to export.

2. Select “Export Segments” from the Do pop-up menu.
A file dialog appears.

3. Use the file dialog to find a location and name for the file.

4. Click Save.
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Dragging from the Pool to the Arrange window

One of the most important features in the Pool is the possibility to drag 
segments into the Arrange window. This example makes use of the in-
cluded Quick Start Song:

1. Open the Song “Quick Start Song”.
You will find this in a subfolder within the program folder.

2. Select New Arrange from the File menu so that you get a new empty 
Arrangement.
In this example you will not use the original Arrangement, even though it will 
still be there in the background. 

3. Make sure you have a number of Audio Tracks at the top of the Arrange-
ment.

4. Set the tempo of the Arrangement to 70 BPM.

5. Pull down the Panels menu and select Audio Pool.

6. In the Pool window, select Expand from the View pop-up menu.
One or several segments will appear below each file in the list.

7. Click on one of the segment names, and drag the segment onto an Audio 
Track in the Arrangement.
The picture sequence on the next page shows this step in more detail.
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8. If the segment doesn’t appear at the place you intended, simply drag it to 
the right Track and bar position.
As always in the Arrangement, the Snap value affects where the segment is 
positioned.

9. Play back to hear the new Arrangement.

1. Point at the 
Segment name.

2. Drag onto an audio Track in 
the Arrangement.

3. The Segment appears as a Part in the Part Display
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10. Drag another segment to another Track, and position it in such a way that 
they start at the same time. Play back to hear the results.

11. Add more Parts in this way to build an Arrangement.

Two tips:

• Remember that you can repeat Parts that are already in the Arrangement. 
This might be faster than dragging the same segment from the Pool many 
times.

• Use the Cycle function to try out different files and see if they work to-
gether well.
The Cycle function makes the section between the Left and Right Locator repeat 
over and over again. Just place the Left and Right Locators where you want them, 
click on the Cycle button on the Transport Bar so that it is lit, and activate play-
back. Then drag files to positions inside the Cycle while the program is playing 
back!

The Cycle button.
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Saving and Loading the Audio Pool

The Audio Pool is automatically saved with the Song or an Arrange-
ment. However, by using the Load and Save Audio Pool commands on 
the pop-up File menu, you can freely save Audio Pools and load them 
into Songs. 

The three items at the bottom of this pop-up menu are described on page 259.

Saving

1. Select Save Pool from the File Pop-up menu.

2. In the dialog box that appears, specify if you want to save all files and seg-
ments, or just the selected ones. 

3. In the standard dialog box that appears, specify a name and a location for 
the file.

❐ The audio files themselves are not saved in the Pool file, only a reference 
to them. You should probably not move any audio file(s) until next time 
you want to use the Pool. You should definitely not delete them!

Loading

An Audio Pool file is opened (loaded) with the Load Pool command on 
the File pop-up menu. When you load a Audio Pool file, the files in it are 
“added” to the current Audio Pool.
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About the different Audio Editing methods

In Cubasis VST, there are three principal ways in which you can edit the 
audio files you have recorded or imported:

• By editing the Audio Parts in the Arrange window.
This allows you to cut up, duplicate and resize audio recordings, or rather, af-
fect how they play back. This method does not change the actual audio files on 
your hard disk. See the chapter “Arrangement Editing”.

• By editing Audio Segments in the Pool
In the Audio Pool, you can adjust the start and end insets of the audio segments, 
and thereby adjust which sections of the audio files are actually played back. 
This is described on page 144. Again, this does not affect the actual audio files on 
disk.

• By editing in the external Spark LE audio editor application.
As described on page 35, Cubasis VST comes with an external audio editor ap-
plication: Spark LE from T.C. Works. This allows you to perform what is known as 
“destructive” editing, i.e. the editing affects the actual audio files on disk. This 
method is described on the following pages.

Editing in Spark LE

Spark LE allows you to perform detailed editing of audio files, such as 
cutting, applying fades, EQ-ing, normalizing, reversing and much more. 
For details of the editing procedures and functions, please refer to the 
Acrobat (pdf) documentation included with Spark LE.

To launch Spark LE from Cubasis VST and edit an audio file, proceed as 
follows:

1. If necessary, create a copy of the file you want to edit.
This may be a good thing to do, since editing in Spark LE will change the audio file 
permanently – by making a copy first, you can still use the original, unchanged 
file in other Songs, etc. You can make copies of files from the Audio Pool, as de-
scribed on page 139.

2. Select the Audio Part containing the file, and select “Launch External 
Wave Editor…” from the Edit menu (or double click the Audio Part).
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Now, Spark LE launches and opens the Part’s audio file (see the note on 
the next page about running Spark LE for the first time). If the Part plays 
more than one audio file, only the first file will be opened for editing.

3. Perform whatever editing you want.
See the Spark LE documentation for details.

4. Save the audio file (you may want to save it under another name, see be-
low) and close it.
You can keep Spark LE open if you like, just remember to close the audio file.

5. Return to Cubasis VST.
If you have applied any processing to the audio file, an alert box will appear, 
telling you that the file contents have been changed, and the Pool and Arrange 
windows will be updated to reflect the changes. 

• If you have shortened the audio file in Spark LE, the length of its segments 
in Cubasis VST will automatically be adjusted if needed (since a segment 
cannot be longer than its audio file). 

• If you have lengthened the audio file, the length and start point of its seg-
ments will not be affected.

Switching between the original and edited file

If you use the “Save As” function in Spark LE to save the file under an-
other name, you can use the “Re-find” function in the Pool to switch be-
tween the original and the edited file (see page 140). This can be very 
convenient for trying out different edit versions of files.

❐ Note that this only works if you performed editing to the audio file that 
didn’t change its length (e.g. dynamic or spectral editing).
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What can I do with the MIDI Editors?

When you record MIDI data, you fill Parts with notes and other MIDI 
“Events”. But you don’t really get to see and manipulate those Events 
individually from the Arrange window. In the MIDI editors you do!

Cubasis VST has three different MIDI editors: Key Edit, List Edit and 
Score Edit. These are described separately on the following pages.

❐ The features and settings that are common for all three MIDI editors are 
described on page 189.

If you haven’t yet recorded any Part

You might want to open the editor to input notes from scratch, without 
recording anything first. In this case you have to create a Part, using any 
of the following methods:

• Draw a Part with the Pencil tool.
• Select the Create Part command on the Parts menu.
• Double click between the Locators (creates a Part on the Track you double click 

on).
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Opening an Editor

There are several ways to open a MIDI editor:

• By double clicking on one Part.
Which editor opens depends on the “Double Click Opens” setting on the Op-
tions menu.

• By selecting the desired editor on the Edit menu.

• By using keyboard shortcuts.
The key commands for opening Key Edit, List Edit and Score Edit are 
[Command]-[E], [Command]-[G] and [Command]-[R], respectively.

• The editor will open with the currently selected Part(s). 
• If no Parts are selected, the editor will open with all Parts on the selected Track. 
• In Key and Score Edit, it is possible to edit Parts from several Tracks at the same 

time.

About Editor Tools

All three MIDI editors have different tools for different editing purposes. 
Just like in the Arrange window, you select tools from the Toolbox, in 
one of the following ways:

• By pulling down the Tools menu and selecting one of the tool icons.

• By clicking one of the tool icons in the free-floating Tools window.
To display the Toolbox as a window, you click the Tools menu and drag it to the 
desired position on screen.

• By pressing [Control] and clicking anywhere in the Editor window, and se-
lecting one of the tool icons from the Toolbox window that temporarily 
appears.
If you are using a mouse with two buttons, you may want to set it up so that the 
right mouse button generates a [Control]-click – that way you can right-click to 
bring up the Toolbox.

The different editor tools available are described with the respective 
Editor, on the following pages.
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Key Edit

The three editors share certain basic functionalities but are designed 
for performing specific tasks. The following guidelines may help you 
determine when to use Key Edit:

Use Key Edit when...

• You want to get a quick overview of the Events.
• You want to edit several Parts at the same time.
• You’re editing Continuous Data and velocity values.

Overview

Notes are displayed in all MIDI editors. Let’s look at a simple melody 
line and how it is shown in Key Edit:

The notes are shown as boxes, with higher notes higher up in the 
grid. The note length is indicated by the width of the rectangle.

The piano keyboard to the left is there to make it easy to 
find the right pitch when inputting or editing notes.
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Entering Notes

The Pencil Tool.

You can use the Pencil tool to draw new notes one at a time. Here are a 
few rules-of-thumb:

• Click once with the Pencil to create a single note.
The new notes will get the length of the Quantize value.

• Click and drag with the Pencil to create a note with a length of your choice.

❐ If drawing notes doesn’t seem to work – make sure that Caps Lock is deac-
tivated on the computer keyboard (see page 164)!

1. Set the Snap value to the smallest 
position you want to enter a note at.

For example if you only want to 
enter notes at quarter note 
positions, set Snap to “4”.

2. Set the length of the note to 
enter by changing the Quan-
tize value. If you for example 
set this to “8” you will input 
eighth notes.

3. Select the Pencil tool from the Toolbox. Move the 
pointer onto the note display.

4. Aim at the correct position. Two fields on the Status 
Bar will help you by showing the position and Pitch 
you move the pointer over.

5. Click once with the mouse. 
The note appears.
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Entering Notes using the Brush Tool

The Brush Tool.

The Brush Tool is used for continuous “painting” of notes. The following rules 
apply:

• The notes are created at a spacing defined by the Snap value.

• The new notes will get the length of the Quantize value.

• If you hold down [Shift] on the computer keyboard, movement is re-
stricted to horizontally only when you are painting with the Brush tool. 
That is, all notes will have the same pitch.

Editing Notes

Selecting Notes

The Arrow Tool.

Notes are selected for editing using the Arrow tool. This works just like 
selecting Parts in the Arrange window; you can use [Shift] to select sev-
eral Notes, or drag an enclosing rectangle that will select all the Notes it 
touches, etc. 

Moving Notes

Just as in the Arrange window, notes can be dragged around as desired 
by using the Arrow tool. The set snap value is taken into account when 
moving notes. If you select several notes, you can move them all at 
once, maintaining the relative distance between the notes.
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Restricting movement to one direction

Sometimes you may want to transpose notes without moving them 
sideways, or vice versa. Proceed as follows:

1. Aim at the note(s) with the Arrow tool and press the mouse button.

2. Start moving the note(s) in the desired direction.

3. Press [Shift] and continue moving the note(s).
The note(s) will now move in one direction only.

Duplicating Notes

Again like in the Arrange window, if you hold down [Option], the notes 
you drag will be duplicated.

Resizing Notes with the Pencil tool

You may change the size of notes that you have drawn or recorded, us-
ing the Pencil tool:

1. Set the Snap value.
What you do when you resize a note, is moving the position where the note 
ends. You can only resize notes in multiples of the set Snap value. That means, 
if Snap is set to 8, you can move the end-position of a note to 1/8, 1/4, 3/8, etc.

2. If you want to resize several notes at the same time, select these.

3. Click with the Pencil tool inside the note (or one of the selected notes), and 
drag to the left or right with the mouse button pressed.
When you release the mouse button, the note(s) are resized, taking the Snap 
value into account. 

• If several notes were selected, they will all get the same end position.
If you hold down [Command] while resizing, the selected notes will be resized 
relatively instead (so that they all are lengthened or shortened by the same 
amount).

❐ It might be hard to determine whether you have the pointer inside a note 
or not. To avoid painting in new Events, activate [Caps Lock] on the com-
puter keyboard. This disables creation of new Events. Remember to deac-
tivate [Caps Lock] when you are done resizing the notes.
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Deleting Notes

Notes can be deleted in several ways:

• Click on them with the Eraser tool.

The Eraser Tool.

or

• Select them and press [Backspace] on the computer keyboard.

or

• Select them and select Delete Events from the Edit menu.
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Editing Velocity

One type of data you’ll be likely to view and edit often is velocity (or, 
more specifically, note-on velocity). This is slightly different from other 
types, since velocity is not an Event itself, rather a property of a note. 
This means that if there are no notes in the edited Part, you will not see 
any velocity values. Also, you cannot create velocity values (you have to 
enter new notes). 

Although velocity values can be adjusted in List Edit, they are best 
viewed and edited in Key Edit:

Showing and Hiding the Controller Display

Key Edit has a dedicated Controller Display at the bottom of the window, 
for showing velocity values and Events other than notes. 

• To show or hide the Controller Display, click on the Controller Display but-
ton in the lower left corner of the window.

You can also show/hide the Controller Display by pressing [Option]-[C].

Once you have opened the Controller Display, you can change its size 
by dragging the Divider up or down:
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Displaying Velocity in the Controller Display

The Controller Display can show various types of data, but only one 
type at the time. To specify that the velocity values should be shown, 
proceed as follows:

1. Position the pointer on the Event type icon (in the Controller Display) and 
press the mouse button.
The Event Type pop-up menu appears.

2. Select “Velocity” at the top of the pop-up menu.
The velocity values are shown as bars, positioned according to their respective 
notes and with higher bars representing higher velocity values.



CUBASIS VST
13 – 168 Editing MIDI

Editing the Velocity values

To change the velocity of a note, proceed as follows:

1. Select the Pencil tool.

2. To change the velocity of a note, click on its velocity bar.

The display to the left shows the numerical value at the mouse position (in this case, 
the velocity is set to 53).

• To change a series of values, drag over them.

Creating a velocity ramp

To create a linear ramp, for example a fade-in, proceed as follows:

1. Select the Line tool.

2. Position the pointer where you want the ramp to start and press the 
mouse button.

3. “Draw” the outline of the ramp with the mouse button pressed.

When you release the mouse button, the velocity values are changed:
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Editing Non-Note Events

By “non-note Events” we mean all Controllers, After Touch, Pitch Bend, 
Sustain-pedal, etc. – in other words, all Events that are not associated 
with a note.

As with velocity values, you can edit non-note messages in List Edit, but 
the best overview is offered by the Controller display in Key Edit:

• To show or hide the Controller Display, click on the Controller Display but-
ton in the lower left corner of the window.
See page 166.

Selecting which Event Type to view

To select Event type to be displayed, click the Event type icon (to the 
left in the display) and select an Event type from the pop-up menu that 
appears.

• This pop-up menu contains the most common Event types. To see the full 
list of MIDI Controllers, move the pointer to the “Other” option at the bot-
tom of the list.
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Entering new Events

To create new non-note Events (e.g. add some modulation wheel data), 
proceed as follows:

1. Select what type of data you want to enter.

2. Use the Snap value to decide what “density” you want for the Events.
For very smooth Continuous Controller curves, you should use a small Snap 
value. However, please note that this creates a very large number of MIDI 
Events, which can cause MIDI playback to “stutter” in some situations. A me-
dium-low density like 1/16 is often sufficient.

3. Hold down the [Option] key.
From here on there are basically three ways to go:

4. Release the [Option] key.

If you want to enter just one Event, click once with the Pencil:

If you want to “paint a curve”, drag the Pencil (with the mouse button pressed).

If you want to create a perfect ramp, use the Line tool as described above.
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Editing the Values

This is done just like creating new Events, except you do not press the 
[Option] key:

• To change one value with the Pencil, simply click on it.

• To change a series of values, drag over them with the Pencil.

• To create a ramp, use the Line tool.

Deleting non-note Events

To delete non-note Events, use one of the following methods:

• Click on them with the Eraser tool.

or

1. Select the Events, by dragging a frame around them with the Arrow tool.
Note that it is the start of the Event(s) that has to be enclosed.

2. Click [Backspace] or select Delete Events from the Edit menu.

or

• Use the Delete function on the Do pop-up menu.
This allows you to delete all Events within a certain range, set by the Loop or Cy-
cle. See page 191.

or

• Use the Delete Cont. Data function on the Functions menu on the main 
menu bar.
See page 129.
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List Edit

Use List Edit when...

• You need to perform detailed editing of single Events.

Overview

The Song Position is shown both in the Event list and in the Event display

The Events are shown in the list 
and in the display to the right.

This display shows “Value 2” for the Events. In 
the case of notes, this is the velocity values.
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Entering Events 

❐ Key and Score Edit can be used to edit any combination of Parts from dif-
ferent Tracks. List Edit can only be used for Parts on one Track at a time.

Editing in the List

The Columns

In List Edit, all properties of notes and other Events are shown numeri-
cally in the list columns to the left.

• To view all columns in the list, click the divider between the list and the 
Event display and drag it to the right.

Two of the columns have the same functionality for all Event types:

Column Description

Start Position Edit this value to move the Event.

Chn The MIDI channel of the Event. Note that all Events will play back on the 
MIDI channel set for their Part! If you want the MIDI Events to play back 
on their “own” MIDI channels, set the Part or Track to channel “Any”!

1. Use the Insert pop-up 
menu to decide what 
type of Event to Insert.

2. Set the Snap value to the smallest 
position you want to enter a note at.

3. If you are entering notes, 
set the length with the 
Quantize value. If you for 
example set this to “8”, you 
will input eighth notes.

4. Click with the Pencil tool in the Event Display. Use the ruler to find the right position.

The Event appears both in the Event Display and in the List.
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The other columns have different functionality for different Event 
types. In the tables below, only the used columns are listed:

• Notes:

• Poly Pressure:
Polyphonic Pressure means that you can apply different amount of aftertouch 
to different keys on a MIDI keyboard. Not all instruments support this feature.

• Control Change:

• Program Change:
When you play back a Program Change message, you instruct the MIDI instru-
ment to select another sound (just as when you select a program in the Inspec-
tor). For Program Change Events, you can only edit the Val 1 column, which is 
the Program number.

Column Description

Length Edit this value to make the note shorter or longer.

Val 1 The pitch of the note.

Val 2 The note-on velocity (see page 166).

Val 3 The note-off velocity, i.e. how fast the key was released. Note that not all 
MIDI instruments support this feature.

Column Description

Val 1 The pitch of the note to which Poly Pressure is applied.

Val 2 The amount of pressure.

Column Description

Val 1 This is the type of Control Change message (Modulation, Volume, etc.). By 
changing this value, you convert a Control Change Event to another type.

Val 2 The actual Control Change value.

Event Type This is a text representation of Val 1, showing the Control Change type in 
words. You can convert the Control Change message in this column too.
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• Aftertouch:
This is the most common form of key pressure, which affects all currently play-
ing notes on the same channel (often called Channel Pressure). For Aftertouch 
Events, you can only edit the Val 1 column, which is the amount of pressure.

• Pitch Bend:
Pitch Bend is different from other Events, since it really consists of two separate 
values – one for the coarse amount and one for the fine amount of bend. There-
fore it may be more convenient to edit Pitch Bend data in the Controller Display 
in Key Edit (where the two coarse and fine amounts are shown as one value).

• Track Mute:
Track Mute Events tell Cubasis VST when to mute or unmute a Track, making it 
possible to have Tracks mute and unmute “automatically” during playback. 
Generally, it is recommended to keep Track Mute Events on a separate Track 
with no music, to avoid having the Track mute itself!

❐ The remaining Event Types cannot be edited in List Edit.

Editing Procedures

The positions and values of Events can be edited in the List, using one 
of the following methods:

• Click in the upper or lower part of the tempo value to raise or lower the tempo, 
respectively.

• Click on the value and drag the mouse up or down with the mouse button 
pressed.

• Double click and type in a value.

Column Description

Val 1 This is the fine Pitch Bend value.

Val 2 This is the coarse Pitch Bend value.

Column Description

Val 1 Track Number

Val 2 1: Mute; 0: UnMute
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There are some things to note:

• If you hold down the [Option] key on the computer keyboard while you’re 
changing a value, all Events of the same Event type will be edited.
The setting on the To pop-up menu is also taken into account, allowing you to 
edit all Control Change Events within the Cycle for example. See page 189.

• If you change an Event’s Start Position, the List will be re-sorted.
The Events are always shown in the order they are played back, with the earliest 
Event at the top and the latest at the bottom.

Editing in the “Value 2” Display

The graphical display to the right shows Value 2 for the Events in the 
List (where applicable) as horizontal bars. You may use this to change 
values, create ramps etc.

The Event types that use Value 2 are Notes, Poly Pressure, Control 
Change and Pitch Bend. Perhaps the most common use for the display 
is to edit Value 2 for Note Events, that is, the Note On velocity value. To 
make it easier to distinguish the velocity values, the Value 2 bars are 
black for Note Events and grey for other Event types.

• You do not have to select the Pencil tool to change the bars in the “Value 
2” display; the pointer automatically changes to the Pencil when you 
move it into the display.

• You can drag the divider between the Value 2 display and the Event dis-
play to resize the area.

The Value 2 Display
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Continuous Events in List Edit

The “mountains” of continuous data (as shown in the Key Edit Control-
ler Display) are in reality a large number of single Events. This becomes 
clear when looking at the same data in the List Edit Window:

The Events (Modulation Events in this 
example) are listed in their playback order.

Value 2 for each Event is shown in the list and in the Value 2 display. 
The grey color indicates non-note Events.
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The Score Editor

Use Score Edit when...

• When you are used to reading and writing scores.
• When you are preparing your music for printing.

Score Edit displays your music as regular notation. Below you will find a 
description of some of Score Edit’s main features:

Overview

• If you are editing one Track, as much of it as possible is shown on several 
staves – one above the other – just as with a score on paper.

• If you edit Parts on several Tracks, they are put on a grand staff (multiple 
staves, tied together by bar lines).

• The number of measures across the screen depends on how many notes 
there are in each measure.

• The last measure in the Part is indicated by a double bar line.

The “inverted” notes 
are selected.

The Song Position Pointer.

The mouse position is shown in the mouse box and the pitch is shown as a note 
name in the box below. When you move a note, the lower box instead shows the 
amount of transposition in semitones.

If you are editing several Tracks at the same time, 
the black rectangle at the beginning of the score 
indicates the Active Track.
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Getting the Score displayed correctly

When you open Score Edit for a Part played in real-time, the score may 
not look as legible as you would first expect. The Score editor can ignore 
the minor time variances in performance and make a neater score almost 
instantly. To achieve this, there are a number of settings in a Staff Set-
tings dialog box that determine how the program displays the music. 

There are two ways to open the Staff Settings dialog:

• Double click in the white area to the left of the staff.

• Activate a staff by clicking on any of the staves in the window. Then select 
“Staff Settings…” from the Do pop-up menu.
The Staff Settings dialog appears: 

The settings you make in this dialog box are independent for each Staff 
(Track), but common for a piano staff which you have created by choos-
ing the “Split” option in the Staff Mode pop-up menu (see below).



CUBASIS VST
13 – 180 Editing MIDI

Staff Mode

This pop-up determines how the staff should be shown: 

• When set to “Single”, all notes in the Part are shown in the same staff.

• When set to “Split”, the Part is split on the screen into a bass and treble 
clef, as in a piano score. 
You use the Split Point field to set the note where you want the split to occur. 
Notes above and including the split note will appear on the upper staff, and 
notes below the split note will appear on the lower staff.

Before and after setting a split at C3.

• To set the clef and key for the lower staff, activate the “Lower Staff” check-
box in the Key/Clef section (see below).
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Display Quantize

Notes are not an absolute language, and you must give the program a 
few hints on how the score should be displayed. This is done using the 
Display Quantize section of the Staff Settings dialog.

❐ These are only display values used for the Score Editor. They do not affect 
the actual recording in any way.

Here is a description of the functions:

Parameter Description

Notes Determines the smallest note value to be displayed and the “smallest 
position” to be recognized and properly displayed. Set this to the small-
est significant note position used in your music. 
For example, if you have notes on odd sixteenth note positions, you 
should set this value to 16.
The “T” values are for triplet note values.
This setting is partly overridden by Auto Quantize (see below).

Rests This value is used as a “recommendation” – the program will not dis-
play rests smaller than this value, except where necessary. In effect, this 
setting also determines how the length of notes should be displayed. 
Set this value according to the smallest note value (length) you want to 
be displayed for a single note, positioned on a beat.

Auto Quantize Generally, if your music contains mixed triplets and straight notes, try 
activating this checkbox. Otherwise, make sure it is deactivated.

Auto Quantize uses involved methods to make your score look as legible 
as possible. Auto Quantize allows you to mix straight notes with tuplets 
(triplets) in a Part. But, Auto Quantize also uses the Display Quantize 
value. If it can't find an appropriate note value for a certain note or group 
of notes, it will use the set Quantize value to display it.
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Key and Clef

The correct Key and Clef are set using the two scroll bars in the Key & 
Clef section.

Display Transpose

Some instruments, for example a lot of brass and woodwind instru-
ments, are written transposed. For example, if you want a tenor saxo-
phone to play a C3 note, you would score it as a D4 note.

For this reason, you can specify a Display Transpose value for each staff. 
This will not affect the playback, only how the notes are displayed and 
printed.

Display Transpose set for a tenor sax part (notes are displayed 14 semitones higher 
than their actual pitch).

If you check the “Auto Clef” checkbox, the program attempts to 
guess the correct clef, judging from the pitch of the music.
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Switches

These provide additional options for how the score should be dis-
played:

Parameter Description

Clean Lengths When this is activated, notes that are considered to be chords will be 
shown with identical lengths. This is done by showing the longer 
notes as shorter than they are. When Clean Lengths is turned on, notes 
with very short overlaps are also cut off; a bit as with No Overlap (see 
below), but with a more subtle effect. 

No Overlap When this is activated one note will never be shown as overlapping 
another, lengthwise. This allows long and short notes starting at the 
same point to be displayed without ties; the long notes are cut off in 
the display. This will make the music more legible.

An example measure with No Overlap deactivated...

...and with No Overlap activated.

Syncopation When this function is activated, syncopated notes are shown in a more 
legible way.

This is a dotted quarter at the end of a bar when Syncopation is Off...

...and when it is On.

Shuffle Activate this function when you have played a shuffle beat and want it 
displayed as straight notes (not triplets). This is very common in jazz 
notation.

Flat Beams When this is ticked, the beams over the notes will be flat (as opposed 
to slanted).

No Beams When this is ticked, there will be no beams whatsoever in the Part. This 
is good for example for vocal scoring.
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Entering Notes 

In Score Edit, you use the Note tool to input notes:

1. Set the Snap value to the smallest position at which you want to enter a 
note.

2. Select a note value by clicking on a note button on the Toolbar.
The Note tool is automatically selected, and takes on the shape of the selected 
note value.

3. Press the mouse button somewhere in the score display.

4. With the mouse button down, drag the note up/down. 

Accidentals appear, to show you the exact pitch of the note. The pitch is also 
shown in the value field under the Mouse Box.

5. When you have the note at the right note line with the correct accidental, 
release the mouse button.

Entering Rests

You can use the Rest tool to insert rests between notes. Like the Note 
tool, the Rest tool changes appearance depending on the chosen note 
value. 



CUBASIS VST
Editing MIDI 13 – 185

Editing Notes

Moving and Transposing Notes

To move notes, you drag them with the Arrow tool as usual.

• Use the two mouse boxes to determine where to place notes.

When you move several notes, the upper mouse box shows the position of the 
note you clicked on when starting to drag.

• If you hold down [Command] and transpose a note, it will only be trans-
posed within the set key.
If, for example, the key is C major (set in the Staff Settings dialog), you will only 
transpose to notes belonging to the C major scale.

Enharmonic Shift

The buttons to the right on the toolbar are used to shift the display of 
selected notes so that for example an F# (F sharp) is instead shown as a 
Gb (G flat) and vice versa:

1. Use the arrow tool to select the note(s) you want to affect.

2. Click on one of the buttons to display the selected note(s) a certain way.

The middle button resets the notes to original display. The other four options are 
double flats, flats, sharps and double sharps.

Flip Stems

By selecting this item from the Do pop-up menu you change the stem 
direction of the selected note(s).

The upper box shows the position of the moved 
note (as bars, beats and ticks).

The lower box shows the pitch when 
inputting notes, and the transposition 
value when moving notes.
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Joining Notes

The Glue Tube allows you to join two or more notes of the same pitch.

Splitting Notes

The Scissors tool allows you to split a tied note into two separate notes.

Deleting Notes

As with all other objects in Cubasis there are two ways to erase notes in 
Score Edit. Either select them and press [Backspace] on the keyboard, 
or select the Eraser from the Toolbox and click on the notes.

Adding Text

1. Select the Text Tool.

The Text Tool.

2. Click anywhere in the score.
A text input line dialog box appears. 

3. Enter the text.
You can press [Return] to create several lines of text if you like.

4. When you are done, click outside the text box.

Changing the Font and Size

If you wish to change the font and size for some text you already put in, 
proceed as follows:

1. Select the text.

2. Select “Text Settings…” from the Do pop-up menu.
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3. Use the Font pop-up, the size setting and the style options in the dialog 
box that appears.
The fonts you find on the menu depend on what fonts you have installed in 
your computer.

4. Click “Apply” to apply your settings to the selected text object(s).

5. Close the dialog by clicking its close box.
You can have the dialog open while you are working in the Score Editor if you 
like.

❐ On your font menu you will also find one or more Cubase fonts. These are 
not intended for text, but for the non-text symbols used in the program.

Title, Comment and Author

These are three standard text elements on the first page of your score. To 
make settings for these, select “Score Title” from the Do pop-up menu. 
This opens a dialog box, in which you can input texts and make settings 
for font, size and attributes for each of the three elements. Cubasis VST 
will automatically position the elements as follows:

• The Title is always centered, at the top of the page. 
• The Comment is always positioned just below the Title. 
• The Author text is always positioned at the right side of the page, just above the 

first system.

None of these elements are visible on screen but will be printed out 
properly.
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Printing the Score

To print your score, proceed as follows:

1. Make settings for the Text, Title, Comment and Copyright elements, as de-
scribed on the previous pages.

2. Select Page Setup from the File menu.
This opens the Page Setup dialog, which is a standard Macintosh dialog, with 
one exception (the Margins settings, described below).

3. Choose paper size and direction, and make any other desired settings, just 
as when printing from a word processor or layout program.

4. If you need to, change the size of the margins by setting new Left, Right, 
Top and Bottom values.
Please note that each printer has a minimum margin. To automatically set the 
values to this minimum, click on the Default Values button. You can also have 
the margins toggle for left/right pages, by activating the Toggle Margins op-
tion.

❐ If you set margins smaller than the Default values, everything on the page 
might not get printed!

5. Close the Page Setup dialog by clicking OK.
The Page Setup settings are included when you save the Song.

6. Select “Print…” from the File menu.
A standard Macintosh Print dialog opens. Its options depend on the type of 
printer you use (explained in the manual for your Macintosh or printer). Nor-
mally you should be able to decide to print a number of copies, all pages, or just 
a specified range, etc.

7. Click Print.
Provided that you have your printer connected correctly, your score will now 
be printed.

❐ Note that printing is only available from Score Edit!
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Common settings and functions

Selecting and the To pop-up menu

The concept of selecting Events is much the same as selecting Parts:

• Click on an Event to select it (and deselect all others).

• Hold [Shift] and click on an Event to select it, keeping any previously 
selected Events.

• Select several Events by enclosing them in a rectangle using the Arrow 
tool.

• Use the Select All item on the Edit menu to select all Events in the editor.
The key command for this is [Command]-[A]. 

• Use the [←] and [→] keys to select the previous/next Event in the Ac-
tive Part.
If you hold down [Shift] and use the arrow keys, the next/previous Event will be 
selected, without deselecting already selected Events.

Selecting Events from different Parts

In Key Edit and Score Edit you can select Events from both an active and 
an inactive Part:

1. Select the Events you want in the active Part, using any method de-
scribed above. 

2. Hold down [Shift].

3. Select one Event from an inactive Part by clicking on it. 
This Part now becomes active. 

4. While keeping [Shift] pressed, use any method to select more Events 
from the now active Part. 
As long as you keep [Shift] pressed, you can switch active Parts and select from 
as many as you like, using this method.

❐ Usually, any type of editing you do (like moving, copying and so on) will 
affect all selected Events, whether they are in active or inactive Parts. See 
also below.
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The To Pop-up

All the editors have a pop-up menu called “To”. This is used together 
with the Loop and Cycle functions to collectively choose a group of 
Events to be affected by your editing.

Auditioning Events

The Speaker tool (all MIDI Editors)

If you click on an Event with the Speaker tool, it is played back. You can 
also drag over Events to play them back one after the other.

The Speaker icon

When you click on the speaker symbol on the Status Bar, Events will be 
output automatically when you click on them, when you create them 
using the pencil or paint brush, and when you make changes on the 
Info line (see below).

All Events, active or inactive, will be affected.

All Events inside the Loop (see 
page 196) will be affected, 
whether the Loop is On or Off, 
and regardless of whether the 
Events come from active or 
inactive Parts.

All Events inside the Cycle will be 
affected, whether the Cycle is On 
or Off, and regardless of whether 
the Events come from active or 
inactive Parts.

All selected Events, inactive 
or active, will be affected.

Those Events 
that are inside 
the Loop and 
selected will be 
affected.

Those Events that are inside the 
Cycle and selected will be affected.
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Editing on the Info Line

At the top of the Key and Score editors, you have the Info Line. The Info 
Line shows the values for one selected note. The values can be edited, 
just as in the List in List Edit:

1. To show/hide the Info Line, click on the i-button on the Status Bar or 
press [Option]-[I] on the computer keyboard.

2. Select a single Event.
Its values are shown on the Info Line.

If no Event or several Events are selected, the Info Line shows “– – –” for 
all values.

3. Change the desired values using regular value editing.
You could either drag the value up or down with the mouse or double click on 
it and type in a new value from the computer keyboard.

The Do pop-up menu

In all three editors, the Do pop-up menu contains two editing functions 
(in Score Edit, the Do pop-up menu contains other options as well, as 
described previously in this chapter). The functions are:

Fill

This function only works when the To pop-up menu is set to “All Events”, 
“Looped Events” or “Cycled Events”. It then fills the whole Part/the Loop/
the Cycle with notes that have the same pitch. The notes are spaced ac-
cording to the Snap value and are all given a length corresponding to the 
Quantize value.

• In Key Edit you can specify the pitch of the “Fill notes” by clicking on a key 
on the keyboard display before you perform the operation.

Delete

This deletes all Events in the range defined by the To menu (notes, Con-
trollers, the lot).

When the “i” button is lit, the Info Line is shown.
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Cutting, Copying and Pasting

You can use the Cut, Copy and Paste commands to move Events be-
tween editors or to duplicate a series of Events.

• Cut or Copied Events are Pasted in, starting at the Song Position. The 
Events will keep their relative positions, pitch and other properties.

Edit Solo

When this button is activated, you will only hear the Track/Parts that 
are currently being edited. All other Tracks are muted. Use this function 
when you want to concentrate on editing the Parts in the editor, rather 
than hearing the recording in context.

Follow Song

If Follow Song on the Options menu is turned on, the Edit window will 
scroll automatically during playback, so that the current Song Position 
is always visible.

• You may also press [F] on the computer keyboard to turn Follow Song on 
and off.
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The Goto pop-up menu

You can move directly to certain useful positions in an editor by select-
ing from the Goto menu on the Function Bar. These options will scroll 
your view to show the Events at the chosen position.

Song Position Takes you to the Song Position.

First Event Takes you to the first Event in the active Part.

Last Event Takes you to the last Event in the active Part.

First Selected Event Takes you to the earliest of all the selected Events.

Next Selected Event Takes you to the next selected Events.

Last Selected Event Takes you to the last of the selected Events.

Prev Selected Event Takes you to the selected Event before the one currently in 
view.

Next Part This is mainly useful when you are editing several Parts at the 
same time in Key Edit. It takes you to the beginning of the next 
Part. This might just lead to a vertical scroll if there are several 
Parts beginning at the same Position.

Prev Part This is mainly useful when you are editing several Parts at the 
same time in Key Edit. Takes you to the beginning of the previ-
ous Part. This might just lead to a vertical scroll (see above).
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Editing Notes via MIDI

You can change the properties of notes via MIDI. This can be a handy 
and fast way to get for example the right velocity value, since you will 
hear the result even as you edit:

1. Select the note you want to edit.

2. Click on the MIDI Connector symbol on the Status Bar.

The symbol should be “lit”. This enables editing via MIDI.

3. Use the Note buttons on the Status Bar to decide what properties will 
be changed by the MIDI input.
You can enable editing of Pitch, Note On- and/or Note Off-velocity.

With this setting, the edited notes will get the Pitch and Velo Off values of the notes 
input via MIDI, but the Velo On values will be kept as they are.

4. Play a note on your MIDI instrument.
The note selected in the editor will take on the properties of the played note, 
according to the setting made in step 3.

The next note in the active Part automatically gets selected. A series of notes 
can therefore quickly be edited.

• If you want another try, select the note again (easiest by pressing the 
[←] key on the computer keyboard) and again play a note on your MIDI 
Instrument.
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Step Recording

If you prefer not to record your music in real time, you may use the Step 
Recording function to input music one note at a time from your MIDI 
instrument:

1. Set the desired spacing of notes with the Snap value.

2. Set the desired length of notes with the Quantize value.

3. Click the “Foot” button on the Status Bar to activate Step Recording.
The MIDI button is automatically activated, indicating that Cubasis VST is ready 
for MIDI input.

4. Move the Song Position to where you want to start.

5. Play a note or a chord.
It is registered, and the Step Position jumps to the next position (according to 
the Snap value). Proceed with the next note or chord, and so on.

• To input a pause, press [Tab].

• To remove the last note or chord and go back one step, press [Back-
space].

6. When you are finished, turn off Step Recording by clicking the MIDI sym-
bol button (the “Foot” button is automatically deactivated).
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The Loop Function

In all of the MIDI editors you can set up a local Loop, which is a sort of 
“mini-cycle” for the Parts being edited. The Loop facility operates in ad-
dition to the Cycle, meaning you can Loop the Parts you are editing 
while Cycling Parts that are not being edited!

There are two principal ways to set the Loop:

• Drag the mouse in the Ruler to draw the Loop area.
This will also automatically turn on the Loop (see below).

This method does not work in Score Edit, since it has no Position Ruler.

• Use the mouse and/or computer keyboard to set the values in the Loop 
boundary boxes on the Status Bar.

These boxes can also be opened for editing by pressing [Option]-[L] and [Op-
tion]-[R], respectively.

Either way, the current Loop area is shown in white on the Ruler when it 
is activated, and in light grey when it is deactivated.

Turning the Loop on or off

• Turn the Loop on/off by clicking on its button or by pressing [Option]-[O].
For this to work, you have to define the Loop first, as explained above.

When the Loop is active, the Parts within the Loop in the Edit window 
loop almost independently of the rest of the music. We say “almost”, 
because the Loop is still dependent on the Cycle. Every time the Cycle 
starts over again, so does the Loop.

The Loop is also used for directing editing to the Events inside the 
Loop. See page 190.

The upper box is the start of the Loop, the lower is the end.

The Loop On/Off button.
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Closing the Editor

There are two ways of closing the editor, “Cancelling” and “Keeping”.

Cancelling

If you press [Esc] on the computer keyboard, a dialog box allows you to 
change your mind:

• Clicking “Yes” closes the editor and cancels all changes you’ve made since 
opening the editor.

• Clicking “No” closes the editor, but your changes are kept.

Cancelling can be thought of as a super-undo. It allows you to try out a 
series of changes to a recorded piece of music and then easily revert 
back to its original state.

Keeping

If you close the editor by clicking the window’s Close box or by pressing 
[Return], the window closes and all the editing you have done is kept.

The “Keep Appended Events?” Dialog

If you close the editor and a dialog appears asking you if you want to 
“Keep appended Events”, this is because you have added Events out-
side the Part(s) being edited.

• If you click “Yes”, the Part will be extended to encompass the added Events.
• If you click “No”, the Events outside the Part will be discarded.



14
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Introduction

This chapter describes the general procedures of handling levels, pan, 
EQ and effects to create a final stereo mix. Mixing is done in different 
windows in Cubasis VST, mainly the VST Channel Mixer (for audio) and 
the MIDI Track Mixer (for MIDI). 

❐ The MIDI Track Mixer is designed to interact with MIDI instruments com-
patible with any of the standards GM (General MIDI), GS or XG. However, 
even if your instrument is not GM/GS/XG compatible, you may still be able 
to use some of the functions in the mixer.

Mixing Audio

Setting Levels

1. Set up your Audio Tracks and possibly the Locators so that they play back 
the section you want.

2. Pull down the Panels menu and select “VST Channel Mixer” (or press 
[Command] and [*] on the numeric keypad).
The VST Channel mixer window opens. This contains “channel strips” for the au-
dio channels, and a Master section for adjusting the level of the final mix.
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3. Make sure the “In” buttons next to the faders are not activated for the au-
dio channels.
When these are activated, the level meters show the input level instead of the 
playback level.

4. Make sure the Read and Write buttons are deactivated.
These are used for automating mixer movements, as described on page 213. 
For now, we’ll stick to manual mixing.

5. Activate playback, and use the faders to set the relative volume for the au-
dio channels.
The fader settings are displayed numerically below the faders. You can boost 
weak signals by +6 dB in the VST Channel Mixer, if you like. Just be sure to avoid 
signal levels above 0 dB (clipping).

❐ Actually, due to Cubasis VST’s high internal resolution, clipping can usu-
ally only occur in the Master section (when the signals are sent to the au-
dio hardware). Therefore, it can be OK to have the Clip indicators light up 
for individual channels, as long as the Clip indicators in the Master section 
never light up!

Clip indicator
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• For stereo channel pairs, the faders are automatically “linked”, i.e. moving 
the fader for the left channel will automatically move the fader for the 
right channel, and vice versa.
To set the level independently for one channel in a stereo pair, hold down 
[Option] and drag the fader.

A stereo channel pair.

• If you hold down [Command] and click on a channel fader, it will auto-
matically be set to position 0.0 dB.

6. Adjust the total volume with the faders in the Master section to the right.
The faders are linked, i.e. if you move one fader the other will move as well. If 
you want to adjust the level of one stereo channel independently, press [Op-
tion] and move the fader.
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Setting Pan

The Pan controls are the boxes with the green vertical line, located 
above each channel fader. This is where you set the stereo position of 
each audio channel. Like volume, pan settings can be automated using 
the Write/Read functions.

• When you are changing Pan for a channel, the setting is shown numeri-
cally (L64–R64) in the level display below the fader.
To make the display show the fader setting again, click the fader handle.

• To select the center Pan position, hold down [Command] and click on the 
Pan control.

• For audio channels in a stereo pair, you should probably pan the left (odd-
numbered) channel fully left and the right (even-numbered) fully right.

❐ If the Mono switch in the Master section is activated, all audio playback 
will be in mono, and the Pan settings will have no effect.
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Using Mute and Solo

For each audio channel, there is a Mute and a Solo button, which are 
useful when you want to listen closely to one or several audio channels. 
These work as follows:

• Clicking the Mute button silences the output of the audio channel.
To deactivate Mute, click on the button again.

• Clicking the Solo button silences the output of all other audio channels.
To deactivate Solo, click on the button again.

• You may Mute or Solo several audio channels at the same time if you like. 
However, if you hold down [Command] when you click Mute or Solo for a chan-
nel, the function will be exclusive. This means that only this channel will be 
Muted or Soloed – all other channels are automatically un-muted/un-soloed.
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Making Equalizer settings

Each audio channel in Cubasis VST is equipped with a two band para-
metric equalizer. To activate and set EQ for a channel, proceed as 
follows:

1. Click on the EQ button at the top of the channel strip.
The VST Channel Settings window for that channel opens. This contains a dupli-
cate of the channel strip, an effect section (see page 206) and 2 EQ modules.

❐ If you make Equalizer settings for one channel in a stereo channel pair, the 
settings will automatically be reflected in the other channel.

2. Activate one or both EQ modules by clicking on their On buttons.

❐ The maximum total number of EQ modules (for all channels together) is 
governed by your computer’s performance. If you activate more EQ mod-
ules than your system can handle, you will note that the Over indicator in 
the VST Performance window lights red, and the audio playback stutters 
and distorts. Keep an eye on the VST Performance bar graphs and deacti-
vate a number of EQ modules, until the computer load seems to be normal.
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3. Set the parameters for the activated EQ module.
It is probably easiest to set up a playback cycle and experiment with the set-
tings until you get the desired sound. The three basic EQ parameters are:

❐ Please note that high Gain values may give rise to distortion. Check the 
channel level meters and compensate with the channel volume faders.

4. Close the EQ window by clicking on its close box.
In the VST Channel Mixer window, the EQ button indicator for the audio chan-
nel will now be lit, which means EQ is applied to that channel.

Applying Effects

There are two basic types of effects in Cubasis VST; insert effects 
(applied separately to each channel, by using the channel inserts in the 
VST Channel Mixer) and send effects (applied separately to each chan-
nel by using the effect sends in the VST Channel Mixer). 

Typical uses for insert effects would be distortion, filters, auto panners 
or any effect that you want to send a whole channel through. Typical 
send effects would be reverb, delay, chorus or anything that you want 
to apply in different amounts to the different audio channels.

Gain Governs the amount of boost or attenuation around the set frequency. The 
value range is ± 24 dB.

Frequency The center frequency for the equalization. Around this frequency, the sound 
will be boosted or attenuated according to the Gain setting. The range of the 
Frequency parameter is determined by the four Hi/Lo buttons below the 
knobs.

Q Determines the width of the frequency band around the center frequency 
to be affected. The narrower the frequency band, the more drastic the ef-
fect of the boost or attenuation.
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Routing an Audio Channel through the Send Effects

You can have two different send effects in Cubasis VST, and each chan-
nel has two effect sends. The first step is to select, activate and make 
settings for the two effects:

1. Select VST Send Effects from the Panels menu.
The VST Send Effects window opens. This contains up to two “slots”, each hold-
ing a separate effect plug-in. If you have less than two effects activated, there 
will be a slot at the bottom of the window, labeled “No Effect”.

2. Click the “No Effect” label (or, if you have two effects already, on one of 
the effect names) and select an effect from the pop-up menu that appears.

The available effects are listed on page 210.

• The “No Effect” option is used for deactivating the effect processor totally. 
Use this if you need to conserve computer power, and don’t need the effect.

3. Make sure the red “power button” is activated for the effect.

4. Make sure the slider to the left is set to a suitably high value.
This is the master send level, governing the total amount of input level to the 
effect processor. If you later activate a lot of effect sends, you may need to 
turn down the master send level somewhat, to avoid clipping (distortion) in 
the processor.

Clicking on the effect name...

...opens the Effect pop-up.
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5. Repeat steps 2 to 4 for the other processor if you like.

Now it’s time to set up the effect sends:

6. In the VST Channel Mixer window, click on the FX button for the audio 
channel to which you want to add the effect.
The VST Channel Settings window opens, as described on the previous pages. 
The section between the channel fader and the EQ modules contains the effect 
sends.

7. Click on the On button for one or both effect sends and turn the Send level 
knobs to moderate values.
When you activate the On button, the channel’s FX button will light up in the 
VST Channel Mixer.

8. If you want the signal to the effect to be independent of the channel fader 
setting, click on the PRE button for the send.
With Pre-fader effect sends, the amount of effect for the channel is not affected 
by the volume fader. With Post-fader effect sends (PRE button not activated), 
the amount of effect is proportional to the channel volume, and will change 
with the volume fader movements. This is the most common setting.

If you activate playback, you should hear the selected effect(s) being 
added to the sound. At this point, you will probably want to try out the 
different effect programs and make settings for the selected effects. 
This is described below.

Send level

Pre-fader Send switch

Bypass button (affects both sends)

Send On/Off
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Adding Insert Effects

Each audio channel has one insert effect slot. To add an insert effect to 
an audio channel, proceed as follows:

1. In the VST Channel Mixer, click the Insert button for the channel.
The VST Channel Settings window opens. The Insert Effect settings are located 
above the Effect Sends.

2. Pull down the Inserts pop-up menu and select an effect.

3. Activate the On button.
Now, the audio channel signal will pass through the insert effect.

❐ To deactivate an insert effect, pull down the Effect type pop-up menu and 
select “No Effect”. If you just turn off the On button, the effect slot will still 
be counted as “in use”, and thus consume some processor power.

Editing Effects

Each effect in Cubasis VST has a separate “control panel” window for 
making settings. The window can have a standard panel (with sliders 
for all parameters) or a custom panel with knobs, buttons and sliders.

• To open the effect control panel for a send effect, click the Edit button in 
the VST Send Effects window.
You can also go directly to the control panel from a VST Channel Settings win-
dow by pressing [Command] and clicking on the On button for an effect send.

• To open the effect control panel for an insert effect, click the Edit button in 
the Inserts section in the VST Channel Settings window.

Either way, the control panel appears in a separate window.



CUBASIS VST
Mixing 14 – 209

A custom control panel (left), and a standard control panel.

To edit effects, use the following methods:

• Select another effect program from the pop-up menu at the top or bottom 
of the control panel.
You can also step between programs by clicking the arrow buttons next to the 
pop-up menu. Note however that only some effects come with ready-made 
programs.

• Use the parameters in the control panel to adjust the sound of the effect.

• You can save your settings as an effect program, by pulling down the File 
pop-up menu and selecting “Save Effect”.
The program is saved as a separate file on disk, and can be loaded into other 
songs by using the “Load Effect” item on the same pop-up menu.

❐ Effect settings can be automated. See page 213.
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The included effects

The following VST effect plug-ins are included with Cubasis VST:

Chorus

This is a multi-stage chorus effect that can produce both warm, subtle 
chorusing and extreme effects.

DoubleDelay

This effect provides two separate tempo-based delays that can be 
panned independently. Cubasis VST automatically provides the plug-in 
with the current Song Tempo. You set a tempo-based delay time in the 
following way:

1. Select a note value for each delay with the tempo sync pop-up menus (to 
the left in the graphic display). 

2. Adjust the timing with the TMP Sync parameters.
For example, if you selected “1/16” with the pop-up menu and set the 
TMP Sync knob to “x3”, the interval between each delay repeat will be 
three sixteenth notes.

Fuzz

This is a simulation of the good old transistor stompbox, producing 
sweet or nasty distortion, depending on the parameter settings.

The tempo sync 
pop-up menus
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Grungelizer

The Grungelizer adds noise and static to your recordings. Kind of like 
listening to a radio with bad reception, or a worn and scratched vinyl 
record.

Auto Pan

This makes the sound move automatically between the left and right 
channel.

• If you are using this effect with a stereo recording, it’s best used as an in-
sert effect.

• If you are using it with a mono recording, you should use it as a send ef-
fect, with “Pre” activated in the send section for the audio channel, and 
the level fader turned down.
If you use Auto Pan as an insert effect for a mono channel, it will serve as a 
tremolo instead (varying the volume of the sound).

Reverb

Reverb is used to add ambience and “space” to recordings. The Reverb 
effect allows you to specify room size, reverb time, pre-delay and damp 
(softens the reverb sound).

Stereo Echo

The Stereo Echo is a delay with separate settings for the left and right 
channel. It can also be used as a single mono delay, in which case the 
maximum delay time will be doubled.

Wunderverb 3

Wunderverb 3 is a reverb plug-in which provides fairly natural sounding 
reverb effects while using very little processor power. You can select be-
tween ten different reverb algorithms, each with different characteris-
tics, and manually adjust room size, reverb time and damp.
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Scopion

This isn’t really an effect, but rather an on-board oscilloscope, that ana-
lyzes the left or right side of a stereo input signal and displays the wave-
form contents in real time. Scopion must be used as an insert effect for 
stereo channel pairs.

Stereo Wizard

The Stereo Wizard is a stereo width enhancer that takes a stereo input 
signal and makes it sound “wider”. This effect must be used as an insert 
effect for stereo channel pairs.

Copying Mixer Channel Settings

You can copy all settings from one channel to another in the VST Chan-
nel Mixer. This is valuable if you want several channels to have the 
same EQ settings, etc. Proceed as follows:

1. In the VST Channel Mixer window, select the channel you want to copy set-
tings from, by clicking on the channel number label below the faders.

Channel 2 selected for copying.

2. Select Copy from the Edit menu (or press [Command]-[C]).

3. Select the channel you want to apply the settings to, by clicking on its 
channel number label.

4. Select Paste from the Edit menu (or press [Command]-[V]).
All channel settings are copied. 
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Automating the VST Mixer

It is possible to automate all VST Mixer actions, so that volume, pan, EQ 
and effects can change automatically during playback. This is done by 
“writing” your mixer actions into a special Audiomix Part. When played 
back, this Part will repeat your fader movements and button settings 
just like you performed them. You will even see the faders and buttons 
move on the screen, like on a physical mixer with motorized controls.

Recording your actions

1. Open the VST Channel Mixer window.

2. Click on the Write button above the Master Section to the right.
While this button is “lit” (activated), every mixer action you make will be recorded.

3. Start playback.

4. Move the faders and other controls as you would during a manual 
mixdown.
Since you can repeat this recording several times, it is probably easiest to mix 
one or a couple of channels at a time, and stop and deactivate the Write func-
tion in between. That way, you can also Undo your last run if you’re not satis-
fied, using the Undo command on the Edit menu.

5. Stop playback.
If you check the Arrange window, you will note that a special Track called “Au-
dio Mix” has been created. This Track contains one long Part named “Audio 
Mix”, in which all your mixer actions are stored. Don’t worry about the length of 
this Part; it will automatically be lengthened if you record past its end.
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Please note that there is only one Audiomix Part/Track, created the first time 
you use the Write function in your Arrangement. No new Parts are created the 
next time you use the Write function; information is added to the existing Part 
instead.

6. Deactivate the Write function by clicking on the button.
Exiting the mixer window will automatically deactivate the Write function.

❐ The Write function works in Stop mode as well as during playback. If you ac-
tivate Write when Cubasis VST is stopped, all changes you make to your 
mixer parameters are recorded at the current Song Position. This feature 
can be used creatively if you need initial mixer settings, abrupt changes, etc.

Playing back your recorded Mixer actions

1. Activate the automated playback by clicking on the Read button above 
the VST Channel Mixer’s Master Section.

You may have Write and Read activated simultaneously, if you want to watch 
and listen to your recorded mixer actions while you’re recording fader move-
ments for another mixer channel, etc.

2. Start playback as usual.
The monitor faders and controls will move automatically, following your re-
corded actions.
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Mixing MIDI

❐ To be able to “mix” your MIDI Tracks, your MIDI Instruments must be able 
to respond to MIDI Volume and Pan messages. Furthermore, if your instru-
ments support any of the standards GS (Roland’s extension of GM) or XG 
(Yamaha’s extension of GM), you will be able to control various other pa-
rameters in the instruments, such as effects, filters, envelopes, etc.
For details about the XG, GS and General MIDI standards, see page 225. 

What is MIDI “Mixing”?

The easiest way to mix your MIDI Tracks (or really, to change levels, pans 
and other settings in your MIDI Instruments) is to use the MIDI Track 
Mixer. This is opened by selecting MIDI Track Mixer on the Panels menu.

Even though the MIDI Track Mixer resembles the VST Channel Mixer, 
there is a big difference between how they work: While the VST Chan-
nel Mixer actually affects the audio played back, the MIDI Track Mixer 
emulates this by sending out MIDI Controller messages to your MIDI In-
struments. For example, changing the volume for a Track in the MIDI 
Track Mixer causes Cubasis VST to send out MIDI Volume messages to 
the instrument. This is important to realize, since it affects the behavior 
of the Mixer in many ways.



CUBASIS VST
14 – 216 Mixing

MIDI Track Mixer vs. Inspector Settings

Many of the settings in the MIDI Track Mixer are also available in the In-
spector. Settings you make in the MIDI Track Mixer are reflected in the 
Inspector, and vice versa, according to the following rules:

• Inspector settings made for the Track are reflected in the MIDI Track Mixer.
• Inspector settings made for single Parts are not reflected in the MIDI Track Mixer.
• Settings you make in the MIDI Track Mixer affect the Inspector settings for the 

Track (but not for individual Parts).
• Mixer automation (created with the Write/Read function in the MIDI Track Mixer) 

will not be reflected in the Inspector.

When you play back a MIDI Track this may cause some confusion: Con-
sider a Track set to volume 90 (in the MIDI Track Mixer or Track Inspec-
tor). Somewhere a bit into the Track, there is a Part set to volume 127. 
On playback, when the Song position reaches this Part, the volume will 
be raised in your instrument, but this will not be reflected in the MIDI 
Track Mixer! The same thing will happen if the Parts contain recorded 
controller messages. Therefore:

❐ If you want to have “absolute control” over the volume, pan, etc. from the 
MIDI Track Mixer (manually or using automation), make sure that all In-
spector Part Parameters are set to OFF and that the Parts don’t contain 
any controller messages of those types.

The Relationship between Tracks and “Mixer Channels”

For each MIDI Track there is one channel fader. If you create new Tracks 
or delete any existing Track, the Mixer will adjust accordingly.

❐ Please note that you can have several MIDI Tracks set to the same MIDI 
channel. Since all actions in the MIDI Track Mixer send out MIDI messages 
(volume, pan, etc.), this means that “mixing” one of these Tracks also af-
fects all other Tracks set to the same MIDI channel. 
For example, if you move the fader for one of the Tracks, the faders for the 
other Tracks on the same channel will move accordingly.

❐ Tracks set to channel “Any” are displayed in the MIDI Track Mixer, but you 
cannot make any settings for them.



CUBASIS VST
Mixing 14 – 217

Setting Levels

You adjust the levels of your MIDI Tracks by moving the faders.

About the Meters

As in the VST Channel Mixer, playback is reflected by the level meters 
next to each fader. However, in the MIDI Track Mixer, the level meters 
actually show the velocity values of the MIDI data being played back. 
This means that the faders (which adjust the volume in the instrument) 
don’t affect the meters (which indicate the velocity of each Event that is 
played back). Also, playing back one single long note will only cause the 
level meters to flash briefly at the beginning of the note – since they 
only respond to the note-on messages, not to the actual sound level.

Setting Pan

You adjust the stereo position of the MIDI Tracks with the pan controls. 

When you move a fader, the display below it shows the setting 
numerically (0-127). This is the value of the MIDI Volume message 
sent out on the corresponding MIDI channel.

When you change this setting, the display below the 
fader shows the setting numerically (L64 - <C> - R63).
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Using Mute and Solo

On each Mixer channel strip, there is a Mute and a Solo button, which 
can be of great use when you want to listen closely to one or several 
MIDI Tracks.

• Clicking the Mute button silences the output of the Track.
To deactivate Mute, click on the button again.

• Clicking the Solo button silences the output of all other MIDI Tracks.
Audio Tracks are not affected by this. You may Solo several Tracks at the same 
time if you like. To deactivate Solo, click on the button again.

The Audio Mute button

Activating the Audio Mute button will turn off all Audio output, by Mut-
ing all Audio Tracks in the Arrangement. Use this when you want to 
concentrate on the MIDI material.
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The “Extended” Channel Strip

If you click on the arrow button at the top of a channel strip (MIDI 
Tracks only), the strip is extended to the right. Pressing [Option] and 
clicking on any arrow button will extend all Tracks.

Which controls are available in the extended area differs depending on 
the mode selected on the pop-up menu at the top:

The following modes are available:

Mode names Description

XG 1 – Effect & Sends Effect Sends and various sound control parameters for use with 
instruments compatible with the Yamaha XG standard.

XG 2 – Global Settings Global settings for instruments compatible with the Yamaha XG 
standard.

GS – Effect & Sends Effect Sends and various sound control parameters for use with 
instruments compatible with the Roland GS standard.

GS – Global Settings Global settings for instruments compatible with the Roland GS 
standard.

Off In this mode, no control parameters are available.

An “Extended” Channel Strip.
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The controls in each mode are described below.

About the Reset and Off buttons

Regardless of the selected mode, you will find two buttons labelled “Re-
set” and “Off” at the top of the extended channel strip. These have the 
following functions:

• Clicking the Reset button will set all parameters to their default values, 
and send out the corresponding MIDI messages.
For most parameters, the default values will be zero or “no adjustment”, but there 
are exceptions to this. For example, the default Reverb Send settings is 64.

• Clicking the Off button will set all controls to their lowest value, without 
sending out any MIDI messages.

XG 1 – Effects & Sends

The following controls are available when the XG 1 mode is selected:

Control Description

Send 1 Send level for the reverb effect. 

Send 2 Send level for the chorus effect.

Send 3 Send level for the “variation” effect.

Attack Adjusts the attack time of the sound. Turning the knob to the left shortens 
the attack, while turning it to the right gives a slower attack. Middle posi-
tion means no adjustment is made.

Release Adjusts the release time of the sound. Turning the knob to the left shortens 
the release, while turning it to the right makes the release time longer. Mid-
dle position means no adjustment is made.

Harm.C Adjusts the harmonic content of the sound. Middle position means no ad-
justment is made.

Bright Adjusts the brightness of the sound. Middle position means no adjust-
ment is made.
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XG 2 – Global Settings

In this mode, the parameters affect global settings in the instrument(s). 
Changing one of these settings for a Track will in fact affect all MIDI in-
struments connected to the same MIDI Output, regardless of the MIDI 
Channel setting of the Track. Therefore, to avoid confusion it might be 
a good idea to create an empty Track and use this only for these global 
settings. The following controls are available:

GS – Effects & Sends

The following controls are available when the GS 1 mode is selected:

Control Description

Eff. 1 This allows you to select which type of reverb effect should be used: No 
effect (the reverb turned off), Hall 1-2, Room 1-3, Stage 1-2 or Plate.

Eff. 2 This allows you to select which type of chorus effect should be used: No 
effect (the chorus turned off), Chorus, Celeste or Flanger.

Eff. 3 This allows you to select one of a large number of “variation” effect types. 
Selecting “No Effect” is the same as turning off the variation effect.

Reset Sends an XG reset message.

MastVol This is used to control the Master Volume of an instrument. Normally you 
should leave this in its highest position and set the volumes individually 
for each channel with the volume faders.

Control Description

Send 1 Send level for the reverb effect. 

Send 2 Send level for the chorus effect.

Send 3 Send level for the “variation” effect.

Attack Adjusts the attack time of the sound. Turning the knob to the left shortens 
the attack, while turning it to the right gives a slower attack. Middle position 
means no adjustment is made.

Decay Adjusts the decay time of the sound. Turning the knob to the left shortens the 
decay, while turning it to the right makes the decay longer. Middle position 
means no adjustment is made.

Release Adjusts the release time of the sound. Turning the knob to the left shortens 
the release, while turning it to the right makes the release time longer. Middle 
position means no adjustment is made.
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GS – Global Settings

In this mode, the parameters affect global settings in the instrument(s). 
Changing one of these settings for a Track will in fact affect all MIDI in-
struments connected to the same MIDI Output, regardless of the MIDI 
Channel setting of the Track. Therefore, to avoid confusion it might be 
a good idea to create an empty Track and use this only for these global 
settings. The following controls are available:

Cutoff Adjusts the filter cutoff frequency. Middle position means no adjustment is 
made.

Reson. Adjusts the filter resonance. Middle position means no adjustment is made.

Press. Allows you to send out aftertouch (channel pressure) messages on the Track’s 
MIDI channel. This is useful if your keyboard cannot send aftertouch, but you 
have sound modules that respond to aftertouch. The default value for this pa-
rameter is zero, i.e. fully left.

Modul. Allows you to send out modulation messages on the Track’s MIDI channel. The 
default value for this parameter is zero, i.e. fully left.

Control Description

Eff. 1 This allows you to select which type of reverb effect should be used: 
Room 1-3, Hall 1-2, Plate, Delay or Panning Delay.

Para 1-4 Allows you to edit the four first parameters of the selected reverb effect.

Eff. 2 This allows you to select which type of chorus effect should be used: Cho-
rus, Flanger, Short Delay or Feedback Delay.

Para 1-4 Allows you to edit the four first parameters of the selected chorus effect.

Control Description
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Automating the MIDI Track Mixer

All actions in the MIDI Track Mixer window can be automated in a very 
straightforward way: by “writing” them into a special “Track Mix” Part. 
When played back, this Part will repeat your fader and knob movements 
just like you performed them. You will even see the faders and buttons 
move on the screen, like on a physical mixer with motorized controls.

Recording your actions

1. Open the MIDI Track Mixer window.

2. Click on the Write button in the upper left corner to activate recording.
While this button is “lit” (activated), every volume, pan, mute or effect setting 
you make will be recorded.

3. Start playback.

4. Move the faders and pan controls as you would during a manual mixdown.
Since you can repeat this recording several times, it is probably easiest to mix 
one or a couple of channels at a time, and stop and deactivate the Write func-
tion in between. That way, you can also Undo your last run if you’re not satis-
fied, using the Undo command on the Edit menu.

❐ Note that you can record Mutes but not the Solo buttons!

5. Stop playback.
If you check the Arrange window, you will note that a special Mixer Track called 
“Track Mix” has been created. This Track contains one long Part named “Track 
Mix”, in which all your MIDI Track Mixer actions are stored. Don’t worry about 
the length of this Part; it will automatically be lengthened if you record past its 
end.
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Please note that there is only one Track Mix Part/Track, created the first time 
you use the Write function in your Arrangement. No new Parts are created the 
next time you use the Write function; information is added to the existing Part 
instead.

6. Deactivate the Write function by clicking on the button.

Recording Mixer settings in Stop mode

The Write function works in Stop mode as well as during playback. If you 
activate Write when Cubasis VST is stopped, all changes you make to 
your mixer parameters are recorded at the current Song Position. This 
feature can be used creatively if you need initial mixer settings, abrupt 
changes, etc.

Playing back your recorded Mixer actions

1. Check that the Track Mix Track is not muted.

2. Activate the Automated playback by clicking on the Read button in the 
upper left corner of the MIDI Track Mixer.

You may have Write and Read activated simultaneously, if you want to watch 
and listen to your recorded mixer actions while you’re recording fader move-
ments for another mixer channel, etc.

3. Start playback as usual.
The faders and controls will move automatically, following your recorded 
actions.
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What is GM/GS/XG?

General MIDI

General MIDI (GM) is a standard set up by the MIDI Manufacturers Asso-
ciation (MMA) and the Japanese MIDI Standards Committee (JMSC).

It defines a standardized group of sounds and the minimum require-
ments for General MIDI compatible synthesizers or sound modules, so 
that a specially prepared sequence or MIDI file that is sent to the instru-
ment via MIDI will play back the correct sound types, regardless of 
make and model of the instrument.

MIDI identifies sounds by their program change number. Before the 
General MIDI standard was introduced, the same MIDI program change 
number often addressed totally different types of sound in any two syn-
thesizers or sound modules from different manufacturers, e.g. a flute 
type sound in one instrument and a piano type sound in the other. 

With the introduction of General MIDI standard compatible instru-
ments this changed. These instruments use the same program change 
numbers for the same types of instruments.

So, if you prepared a sequence or MIDI file and want the melody to be 
played by a “piano”, you can use a certain program change command 
embedded into the sequence to automatically select a piano sound in 
any GM compatible sound module. The GM standard does not specify 
in great detail how that piano should sound. It is simply assumed that 
the manufacturer reproduces an acoustic piano within the capabilities 
used by the instrument.

General MIDI supports all 16 MIDI channels. Each channel can play a 
variable number of voices (thus be polyphonic). Each channel can play 
a different instrument (or sound or program). A minimum of 24 fully dy-
namically allocated voices are simultaneously available for both me-
lodic and percussion sounds.

Furthermore, in GM compatible instruments, percussion and drum in-
struments which are key-based always use MIDI channel 10 and spe-
cific note numbers are reserved for specific drum sounds.
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There is a number of other MIDI messages that GM compatible instru-
ments should respond to. Among these are the MIDI controller events 
for Volume (Controller 7) and Pan (controller 10). By using these control-
lers, it is possible to create a MIDI Mix for a piece of music.

Roland GS

This is a variation of General MIDI introduced by Roland. It defines addi-
tional standard procedures for selecting alternate drum kits and sound 
variations, and for setting a number of other parameters in Roland GS 
compatible instruments. 

Yamaha XG

This is a variation of General MIDI introduced by Yamaha. It defines ad-
ditional standard procedures for selecting alternate drum kits and for 
setting a number of other parameters in Yamaha XG compatible instru-
ments. 
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Importing audio files into the Arrangement

You can quickly import audio into your Arrangement without having to 
open the Pool. This can be done in two ways: 

• By using the Import Audio function on the File menu.
• By “dragging and dropping” an audio file directly onto the Arrange window.

Using the Import Audio function

1. Select the Audio Track to which you want to import an audio file.
Note that you can’t import stereo files to mono Tracks and vice versa.

2. Move the Left Locator to where you want the audio file to start.

3. Pull down the File menu and select “Import”, then select “Audio File...” 
from the submenu.
A file dialog opens.

4. Select a file format from the Show pop-up menu.
Cubasis VST can import files of the formats AIFF, Wave, SD1, SD2 and MP3.

5. Use the file dialog box to locate the file and select it.

• You can audition the audio file with the Play button.
When you click the Play button, its label changes to “Playing…” and the selected 
audio file is played back. Playback continues until you click on the button again.

6. Click “Open”.
The file is imported into the Pool, just as when using the Import Audio File com-
mand on the File menu in the Pool. A segment that plays the whole file is cre-
ated and placed in an Audio Part, which in turn is placed on the selected Audio 
Track, at the position of the Left Locator. 

❐ If you import an MP3 file, the program will create a copy of the file and 
convert this to AIFF format before importing it (the original MP3 file will 
not be used in the Cubasis VST Song). The AIFF file will be placed in the 
currently selected Audio Files folder (if you haven’t yet specified one, you 
will be asked to do so). 
Please be aware that the converted AIFF file will be several times larger 
than the original MP3 file!
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Importing Audio using “drag and drop”

1. Select an audio file to Import.
This may be located anywhere on your drive – it doesn’t matter as long as you 
select it from the Finder.

2. Drag the file into the Arrange window and drop it on an audio Track (or in 
the empty area below all Tracks).
In the latter case, an audio Track will be created. Again, the regular mono/ste-
reo conventions apply.

3. Release the mouse button.
The audio file appears in the Arrangement at the position where you released 
the mouse button (taking the Snap value into account).

Importing ReCycle Files

The “Import ReCycle File…” item on the File menu lets you import au-
dio files created in Propellerhead Software’s application ReCycle. ReCy-
cle is a program specifically designed for working with sampled loops. 
Using ReCycle you can “slice” a loop and make separate samples of 
each beat. Among other things, this makes it possible to change the 
tempo of loops without affecting the pitch, and edit the loop as if it 
were built from individual sounds. 

If you have ReCycle you can create and export files that you can use in 
Cubasis VST. There are also numerous CD-ROMs available with ready-
made ReCycle (REX) files, such as the Steinberg/Sounds Good “Sounds 
& Cycles” series. To import a Recycle file into Cubasis VST, proceed as 
follows:

1. In Cubasis VST, select an Audio Track to which you want to import the file 
and set the Left Locator at the position where you want the file to appear.

2. Pull down the File menu and select “Import”, then select “ReCycle File...” 
from the submenu.

3. In the file dialog that appears, locate a ReCycle file for import.
There are currently three ReCycle file formats supported by Cubasis VST, Rex1 
(*.rex), Rex2 (*.rx2) and Recycle (*.rcy).
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• You can use the Play button to audition the selected file before opening it.

4. Click Open.
The following happens:

• A copy is made of the ReCycle file. This copy is converted to an AIFF file, which 
is added to the Pool. 

❐ The original ReCycle file should not be deleted or moved, because it will 
be called upon if you later want to re-import the corresponding AIFF file 
into the Arrangement from the Pool. Cubasis VST “remembers” the loca-
tion of the original file and will automatically try to open it when needed.

• A number of Segments are created for the file, each one corresponding to a 
slice in ReCycle.

• A Part which will play these Segments is automatically created on the active 
Track, starting at the Left Locator position.
Now you can play back the ReCycled file in any tempo. You can also quantize 
the Audio Part in the Arrange window, to change the groove.

• If you need to re-import the file into the Arrangement, drag the file item 
from the Pool to the Arrangement, just as any other file. 
A new Part is then created.

❐ Please note that the new file will sound very strange if played back in its 
entirety. It should only be triggered from the Part which has been created 
in the Arrangement. 

About tempo changes and the last Segment(s)

It may happen that you import a ReCycle file into an Arrangement that 
has a higher tempo than the loop originally had. In this situation, the 
slices (Segments) will overlap, and the last segment will “stick out” past 
the end of the Part.

An audio event in Cubasis VST should never play past the end of a Part 
(since you would then hear audio in the Arrangement, that you couldn’t 
“see”). Therefore, Cubasis VST automatically shortens segments that 
would otherwise play past the end of the Part, so that they end exactly 
where the Part ends. This is done automatically when you import the Re-
Cycle file.
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If you have used a very high stretch factor in ReCycle, or if the Cubasis 
VST tempo is drastically different from the original loop tempo, not only 
the last, but a few of the last segments could be affected by the afore-
mentioned problem and will be shortened.

If you later raise the tempo, the shortened segments will become too 
short, since they no longer play to the end of the Part.

• To fix this, delete the existing Part and re-import the ReCycle file, by drag-
ging the file symbol from the Pool to the Arrange window.
In the new Part that appears the length of the last segment(s) will be adjusted 
to fit the current tempo.

If you get clicks during playback

While a sampler or sampling synthesizer is polyphonic, each track in Cu-
basis VST is monophonic, that is, it can only play back one sound at a 
time. This is not ideal for playing many short overlapping sounds, like 
you do when playing ReCycled files.

This fact will normally not cause any problems with drum loops. How-
ever, with other types of material, bass loops etc, the monophonic char-
acter of a Cubasis VST channel might lead to clicks in the transition 
between segments. There are two ways to remedy this:

Using Smooth Segments

• Pull down the Options menu and activate the “Smooth Segments” option 
on the Audio Setup submenu.
Now, Cubasis VST will automatically create small crossfades between consecu-
tive or overlapping audio segments on the same audio channel. In many cases 
this should remove any clicks when playing back ReCycle files.

Importing into “Any” Tracks – Polyphonic playback

Another way of avoiding the problems with monophonic playback of Re-
Cycle files is for Cubasis VST to “simulate” the polyphonic behavior of a 
sampler by splitting up a ReCycle file, so that the “slices” play back on 
more than one channel.

Proceed as follows:
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1. Examine your Arrangement and locate two or more consecutive audio 
channels that you can reserve for a ReCycle file.
How many channels you need for Polyphonic operation depends on the nature 
of the loop. The trick is to completely avoid overlap between segments, since it 
is in the overlap that clicks might occur. If you have no idea what to choose, 
don’t worry, the program will suggest a number for you, see below.

2. Create or select an Audio Track and set it to channel “Any”.
In Tracks set to channel “Any”, each audio segment will play back on its “own” 
channel, much as with MIDI “Any” Tracks.

3. Set the Left Locator to the position where you want the Part to appear.

4. Import the ReCycle file from disk.

5. In the dialog that appears, the program suggests a number of channels 
that ensures no overlap at all. If needed, you can change this.
For example, if you want the file to use channels 1, 2 and 3, specify “1” as the 
start channel and “3” as the number of channels to use.

6. Click “Do it”.
The slices will now alternate between the specified channels, thereby minimiz-
ing the overlap (and thus the clicks).

The drawback of this procedure is that more than one audio channel is 
“used up” by a single file. However, if you run out of audio channels you 
can use the “Export: Audio Tracks…” feature to turn your “multi-chan-
nel” ReCycle Track into one file, that only requires one audio channel, 
see below.



CUBASIS VST
Importing and Exporting Audio 15 – 233

Mixing down to an audio file

The “Export: Audio Tracks…” feature in Cubasis VST allows you to mix 
down any number of audio tracks, complete with effects and mixer au-
tomation, to a new audio file, in mono or stereo.

• The rule is: All audio and VST Instruments you hear on playback will be in-
cluded in the Mixdown file!
However, please note that MIDI Tracks that are not routed to a VST Instrument 
are not included in this type of mixdown. To make a complete mixdown con-
taining both MIDI and audio, you first need to record your MIDI music onto au-
dio Tracks in Cubasis VST, and then proceed with the mixdown.

1. Set up the left and right locator to encompass the area that you want to 
mix down.

2. Set up your Tracks, so that they play back the way you want.
You can use the automation in the VST Channel Mixer window, as well as EQ 
and effects. If you don’t want to include any of these features in the exported 
audio file, you should turn them off while preparing the Tracks, to hear what 
you get.

3. If you want to include the automation, make sure that the Read button is 
activated in the VST Channel Mixer.

4. If you want the mixdown file to be automatically imported back onto a 
specific Track in Cubasis VST, select this Track.
It should be empty and set to stereo or mono, depending on whether you want 
to make a stereo or mono mixdown. 
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5. Pull down the File menu and select “Audio Tracks…” from the Export sub-
menu (or click the “Export Audio” button in the VST Channel Mixer’s Mas-
ter Section).
The Export Audio dialog opens.

6. If you want to automatically import the resulting audio file back into Cu-
basis VST, activate the checkbox “Add created file to current Song”.
This will automatically import the file into the Pool, and place a segment for the 
file in a new Part on the selected Track, starting at the Left Locator. If no suitable 
Track was selected, the program will create a new Track.

7. Select mono or stereo with the radio buttons.

8. Select a file format: AIFF or MP3.

9. If you selected MP3, you need to make two additional settings: encoding 
quality (Fast, Medium or Highest) and bit rate (which determines the au-
dio quality and compression rate of the MP3 file).
You can experiment with different settings to find a suitable balance between 
processing time, audio quality and file size. Generally, 44100Hz (128 Kbit/s) files 
generated with the “Medium” quality, are considered as “standard quality” MP3s.

10. Select a folder and a name for the audio file to be created.
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11. Press the Save button.
The audio is mixed down to an AIFF file with the sample rate used in the Song 
or an MP3 file with the settings you made.

If you have activated “Add created file to current Song”, the file will be 
imported into the Pool and onto an audio Track. You can play it back to 
check the results immediately. Just remember to mute the original 
Tracks, and turn off any EQ and/or effects for the audio channel(s) used 
by the imported Track, so that you really hear the true result.



16
Using VST Instruments
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Introduction
VST Instruments are software synthesizers (or other sound sources) that 
are contained within Cubasis VST. They are played internally via MIDI, 
and their audio outputs appear on separate channels in the VST Chan-
nel Mixer, allowing you to add effects or EQ, just as with Audio Tracks.

Included with Cubasis VST are four Instruments: Neon – a software syn-
thesizer; LM-9 – a drum machine; Universal Sound Module – a GM com-
patible sound module with over 70 MB state of the art sampled sounds; 
and VB-1 – a virtual bass instrument built on real-time physical model-
ling principles. In the following descriptions, Neon will be used as an 
example.

Activating a VST Instrument

1. Pull down the Panels menu and select VST Instruments.
The VST Instruments window opens. This contains up to four “slots”, each with 
a separate VST Instrument. If you have less than four VST Instruments selected, 
there will be a slot at the bottom of the window, labeled “No VST Instrument”.

The VST Instruments window with no VST Instruments selected.

2. Click at the “No VST Instrument” field.
A pop-up menu appears, listing the available VST Instruments.

3. Select “Neon”.
The Neon synthesizer appears in the slot, and a new, empty slot appears below it.

4. Make sure the red button to the left is activated (lit).

The VST Instrument is now activated and ready for use.
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5. Select an unused MIDI Track in the Arrange window.

6. Click in the Output column for the Track.
The Output pop-up menu appears. It will now contain an additional item, with 
the name of the activated VST Instrument.

Playing the VST Instrument

1. In the Arrange window, select a MIDI Track.
This will be used for playing back (and recording) MIDI notes for the Neon syn-
thesizer.

2. Pull down the Output pop-up menu for the Track and select “Neon (V1)”.
Activated VST Instruments are automatically added to the MIDI Output lists. 
“V1” stands for “Virtual Instrument slot 1”, to help you identify the VST Instru-
ments (especially handy if you have activated several VST Instruments of the 
same kind).

• The included Neon is single-timbral, and always in “Omni mode” (it re-
ceives on all MIDI channels). 
Therefore, you don’t have to care about the MIDI channel setting when work-
ing with the Neon. With other VST Instruments, you may need to select a MIDI 
Channel in the Chn column (as when playing any regular MIDI sound source).

3. Try playing your MIDI keyboard.
The incoming MIDI is now sent to the Neon synthesizer. 
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About Latency

Depending on your audio hardware and its ASIO driver, the latency (the 
time it takes for the Instrument to produce a sound when you press a key 
on your MIDI controller) may make it difficult to play the VST Instrument 
with the desired precision timing. 
If this is the case, a workaround is to play and record your parts with an-
other MIDI sound source selected, and then switch to the VST Instrument 
for playback.

Playing VST Instruments from the screen or computer keyboard

If you haven’t got a MIDI keyboard, you can still try out, play and record 
VST instruments (or in fact any MIDI sound source). This is possible with 
the Key Caps Play function on the Panels menu.

This little utility allows you to transmit MIDI data by pressing keys on 
your computer keyboard and/or by clicking on the “keys” on the 
screen. The graphics indicate what pitch each key “plays”. As always, 
MIDI is sent to the selected MIDI Track, just as if you had played a regu-
lar MIDI keyboard.

• When “Computer Keyboard plays Notes” is activated, you can transmit MIDI by 
pressing the keys on your computer keyboard. When this option is deactivated, 
the computer keyboard is used for key commands as usual, but you can still 
click on the keys on screen to transmit MIDI.

• Usually, the keys in the window light up when you play them, to help you find 
your way. You can turn this off by activating “No Screen Redraw” – this will 
make the response slightly faster.
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Selecting Patches and making Settings

1. In the VST Instruments window, try clicking the small arrow icon next to 
the patch name.
A pop-up menu appears, listing the ready-made synth patches included with 
the Neon.

2. Select another patch from the pop-up menu.
This selects another sound. To freely adjust the synth parameters, you need to 
use the Neon’s control panel:

3. Click the Edit button.
The control panel for the VST Instrument appears. In the case of the Neon, this 
resembles the panel of a simple “analog” synthesizer.

The power button, patch and file controls from the VST Instruments window are 
duplicated at the bottom of the control panel.

4. Adjust the synthesizer parameters as desired.
You can also automate the VST Instrument parameters (see page 242).

• You can save and load programs for a VST Instrument in the same way as 
with VST Effect Plug-ins.
See page 208.
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Making Mixer Settings

When you activate a VST Instrument, one or several extra channel strips 
automatically appear in the VST Channel Mixer. This allows you to adjust 
volume and pan, add effects or EQ to the VST Instrument sound, just as 
with Audio Tracks. For general information about how this is done, see 
page 199 in this book.

The Neon channel strips in the VST Channel Mixer.
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Automating a VST Instrument

Automation of VST Instrument parameters is not done using the stan-
dard VST Read/Write automation. Instead, you record parameter 
changes on a regular MIDI Track:

❐ VST Instrument automation uses System Exclusive messages to record pa-
rameter changes. Before you follow the steps below, pull down the Op-
tions menu and make sure “Record SysEx” is activated.

1. Set up a MIDI Track for playback to a VST Instrument as described above.

2. Select another MIDI Track, and set its Output (and possibly MIDI Chan-
nel) to the same values as the first Track.
This is the Track on which you will record the Automation data. You could also 
record the automation on the MIDI Track used for Instrument playback, but we 
recommend that you use a separate Track, to make editing easier.

3. Set up the Locators to encompass the section you want to record.

4. Start recording, and make the parameter changes you want to automate.
The parameter settings are recorded as special System Exclusive messages.

5. Stop recording and play back the recorded Track.
The parameters will change as you recorded them.
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The Neon

The Neon is a simple software synthesizer. It has the following properties:

• The Neon is polyphonic with up to 16 voices. 
However, since each added voice consumes CPU power, the maximum polyph-
ony may be limited by the speed of your computer.

• The Neon receives MIDI in Omni mode (on all MIDI channels).
You don’t need to select a MIDI channel to direct MIDI to the Neon.

• The Neon responds to the following MIDI messages: 
MIDI Note On/Off (velocity governs volume).
Volume.
Pan (remember to pan the two Instrument channels hard Left/Right if you want 
to use MIDI Pan messages).
Pitch Bend (± 2 semitones).
Modulation (vibrato).

Furthermore, all parameters can be automated as described above.
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Neon Parameters:

Parameter Description

Range Selects an octave range for the oscillators, 16, 8 or 4 feet.

Waveform The basic waveform for the oscillators, Triangle, Sawtooth or 
Square.

LFO Speed Governs the speed of the vibrato. The vibrato depth is con-
trolled via MIDI Modulation messages (for example, using the 
Mod Wheel on your MIDI controller).

Osc 2 Detune Allows you to detune the “second oscillator” ± 7 semitones. 
By setting this to a value close to “twelve o’clock”, you will get 
fine detuning, for a warmer, fatter sound.

VCF Cutoff The Cutoff Frequency for the filter, governing the amount of 
high frequencies in the sound. On the Neon, the Cutoff con-
trol also serves as a Depth control for the Filter Envelope (VCF 
Attack, Decay, Sustain, Release), so that the lower the setting 
of the Cutoff parameter, the more will the filter be affected by 
the Filter Envelope.

VCF Resonance The Resonance control for the filter. Raise this for a more hol-
low, pronounced filter effect.

VCF Attack, Decay,
Sustain, Release

The Filter Envelope. Use these parameters to determine how 
the filter should open and close with time, when a note is 
played.

VCA Attack, Decay, 
Sustain, Release

The Amplitude Envelope. Use these parameters to determine 
how the amplitude (volume) should change with time, when 
a note is played.
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VB-1

The VB-1 is a virtual bass instrument built on real-time physical model-
ling principles. This has the following properties:

• VB-1 is polyphonic with up to 4 voices. 

• VB-1 receives MIDI In Omni mode (on all MIDI channels).
You don’t need to select a MIDI channel to direct MIDI to the VB-1.

• VB-1 responds to the following MIDI messages: 
MIDI Note On/Off (velocity governs volume).
Volume.
Pan (remember to pan the two Instrument channels hard Left/Right if you want 
to use MIDI Pan messages).

Volume knob.

Wave Morph knob.

Pick-up position (slide left or 
right to change position).

Pick (slide left or right to 
change position).

Damper switch.
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VB-1 Parameters:

Parameter Description

Volume This regulates the VB-1 volume.

Damper This switch controls the length of time the string vibrates after being 
plucked. 

Pick-up 
position

By dragging the Pick-up left or right you can change the tone. Position-
ing it towards the bridge position produces a hollow sound that empha-
sizes the upper harmonics of the plucked string. When placed towards 
the neck position, the tone is fuller and warmer. 

Pick position This determines where along the length of the string the initial pluck is 
made. This controls the “roundness” of the tone, just like on a real guitar.

Wave Morph This knob selects the basic waveform that is used to drive the plucked 
string model. This parameter can drastically change the sound charac-
ter. The control smoothly morphs through the waves. It is possible to 
create sounds that have no relation to a bass guitar with this control.
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LM-9

The LM-9 is a simple drum machine. It has the following properties:

• LM-9 is polyphonic with up to 9 voices.

• LM-9 receives MIDI in Omni mode (on all MIDI channels).
You don’t need to select a MIDI channel to direct MIDI to LM-9.

• LM-9 responds to the following MIDI messages: 
MIDI Note On/Off (velocity governs volume).

Furthermore, all parameters can be automated as described above.

Volume faders (one for 
each drum sound).

This adjusts the Pan (the position in the stereo image) 
for the individual drums. The setting is applied to the 
currently selected drum, indicated by a lit yellow LED 
over the Pad button.

This sets the global velocity 
sensitivity for LM-9.

Pads (one for each drum sound). Press 
to audition the drum sound assigned 
to the Pad, or to select a sound for 
adjusting pan.

Program switch
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LM-9 Parameters:

Drum sounds

LM-9 comes with two sets of drum sounds; “Acoustic” and “Beat Box”. 
Acoustic features samples of an acoustic drum kit and Beat Box fea-
tures classic analog drum machine sounds. The table below shows how 
the drum sounds are assigned to note values on your MIDI keyboard. 
The mapping is GM compatible:

Switching the sets

Use the Program button to switch between the two supplied drum 
sets, just like you switch between effect programs.

Parameter Description

Velocity This sets the global velocity sensitivity for LM-9. The higher the 
value, the more sensitive LM-9 will be to incoming velocity data. If 
set to “0”, the sounds will play back with a fixed velocity value.

Volume sliders The volume sliders are used to adjust the volume for each individual 
drum sound.

Pad The Pads are used for two things: To audition the individual drum 
sounds, and to select a sound for adjusting pan.

Panorama This is used to position an individual sound in the stereo image. The 
setting applies to the currently selected sound, indicated by a lit yel-
low LED over the Pad button.

Drum sound Note value

Bass C1

Snare D1

Hi-Hat F#1

O-Hi-Hat A#1

Tom 1 D2

Tom 2 B1

Tom 3 A1

Crash C#2

Ride D#2
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Universal Sound Module (USM)

The USM is a General MIDI compatible sound module. As described on 
page 225, General MIDI (GM) is a standard defining a set of sounds in 
MIDI instruments. GM instruments use the same program change num-
bers for the same types of instruments.

So, if you prepared a sequence or MIDI file and want the melody to be 
played by a “piano”, you can use a certain program change command 
embedded into the sequence to automatically select a piano sound in 
any GM compatible sound module. The GM standard, however, does 
not specify in great detail how that piano should sound. It is simply as-
sumes that the manufacturer reproduces an acoustic piano within the 
capabilities of the instrument. A consequence of this is that, depending 
on the GM module used, a Song may sound very different, even though 
the instrument sounds were mapped correctly.

This problem is solved by the Universal Sound Module! Cubasis VST us-
ers can make sure that their music created using the USM will sound ex-
actly the same when played back on another computer, because the 
sound reproduction is no longer hardware based – perfect for InWire 
users! 

❐ InWire and RocketPower are described on page 253.
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• The USM features over 70 MB of sampled waveforms and four stereo out-
puts. 

• The USM is polyphonic with up to 96 voices. 

• The USM receives MIDI in 16 channel Multi mode (simultaneous multi-tim-
bral playback on 16 MIDI channels).
In other words, one USM unit can play up to 16 MIDI Tracks, each with a differ-
ent sound.

• The USM responds to the following MIDI messages: 
MIDI Note On/Off (velocity governs volume).
Volume.
Pan.
Pitch Bend (up to ± 12 semitones).
Modulation (vibrato).

Selecting Sounds

❐ According to the General MIDI Standard, MIDI channel 10 is reserved for 
drums. This cannot be changed.

The USM features 128 different sound patches. Selecting programs is 
done by sending program change messages from the Inspector.

Selecting Outputs

The USM features four stereo outputs, allowing for flexible routing of 
sounds to different effect processors etc. By default, all MIDI channels 
are routed to USM stereo output “1”.

• To select another output, click the “Output” field below the Channel Activ-
ity indicator for the MIDI channel you wish to direct to another output.

This opens a pop-up allowing you to select one of the four stereo outputs.
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USM Parameters:

Parameter Description

Master Volume Sets the master output volume for the USM.

Pitchbend Range Sets the range for incoming Pitchbend messages (selectable 
between 1 to 12 semitones).

LFO Speed Governs the speed of the vibrato. The vibrato depth is con-
trolled via MIDI Modulation messages (for example, using the 
Mod Wheel on your MIDI controller).

MIDI channel activity 
indicators 1-16.

These light up to indicate activity on the corresponding MIDI 
channel.

Output 1-16 Clicking in this field opens a pop-up allowing you to direct the 
corresponding USM MIDI channel to one of the four available 
stereo outputs.



17
InWire and RocketPower



CUBASIS VST
InWire and RocketPower 17 – 253

Introduction

What is RocketPower and InWire?

RocketPower is a system for transferring musical data and managing 
recording sessions over the Internet. Developed by Rocket Networks 
Inc, RocketPower allows you to collaborate with other users of Rocket-
Power applications, anywhere in the world.

InWire is Steinberg’s RocketPower support.

What do I need?

To use InWire, you need the following:

• An internet connection (and a standard web browser application) on the 
computer you use for music work.
While a fast connection is desirable, it isn’t absolutely required.

• A RocketPower application.
In this case, the RocketPower application is of course Cubasis VST!

• The latest version of the RocketControl system installed on your com-
puter.
To download the Rocket software, go to http://www.cubase.net/inwire/ and 
follow the download links and instructions on the page. 

• A Rocket Network account.
This will automatically be created when you fill out the forms to download the 
RocketControl software.

❐ After installing RocketControl, you will find an online manual in pdf (Acro-
bat) format in the RocketControl folder on your hard disk. We recommend 
that you read that document to get detailed information about how the 
Rocket system works, about account options, etc.
This chapter only describes the basic InWire/RocketPower use in Cubasis 
VST.
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Basic Terminology

In Rocket Networks, the following terminology is used:

• Account
In order to use InWire, you need to have a Rocket Networks account. This is your 
“user profile”, and also determines your privileges (there are different types of 
accounts, as described in the Rocket documentation).

• Session
A session is a Rocket Networks project. You can join and contribute to existing 
public sessions, or create a new session (depending on your account type).

• Source Media
This is the audio data, as originally recorded. When you add your own audio re-
cordings to a session, the source media (your recordings) will initially be stored 
locally on your computer.

• Rendering
Renderings are files of different compression rates, created from source media. 
Usually, you and the other session contributors will upload and download com-
pressed renderings of the audio data during work (to save upload and down-
load time). The source media is also considered a rendering, and can be 
uploaded or downloaded as well (e.g. when it’s time for the final mix).
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Setting Rocket Preferences in Cubasis VST

If you pull down the InWire menu in Cubasis VST and select Preferences, 
the Rocket Preferences dialog will open. This allows you to make the fol-
lowing settings:

Setting Description

Download Quality This is where you select the quality of the renderings to receive. 
Usually “Standard” is a good setting (although you may want to 
select “Low” if you have a slow internet connection).
As of this writing, the “No Loss” compression setting isn’t im-
plemented, and should not be selected.

If unavailable take: If the audio files are not available in the preferred Download Qual-
ity, this setting determines which rendering to download instead.

Upload Quality Similarly, this setting determines the quality of the renderings sent 
from your computer when Posting. Again, do not select “No Loss”.
For more about compression rates, see the Rocket documentation.
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Default MIDI Devices Allows you to specify your default General MIDI-compatible de-
vices (such as the Universal Sound Module).

Auto-Allocate MIDI 
channel

If this is activated, MIDI channels will be automatically allocated 
when you receive a Session (useful to avoid channel conflicts 
when collaborating live with other users). If it is deactivated, the 
original MIDI channel assignment (as set by the sender of the 
data) is kept.

Auto-Allocate Audio 
channel

If this is activated, audio channels will be automatically allocated 
when you receive a Session (useful to avoid channel conflicts 
when collaborating live with other users). If it is deactivated, the 
original audio channel assignment (as set by the sender of the 
data) is kept.

Erase Unused before 
Posting

If this is activated, all unused audio files in the Pool are perma-
nently deleted from your hard disk when you Post.
Don’t activate this unless you are absolutely sure you want 
all unused files to be deleted!

Use Coloring and Sort 
by Owner

If this is activated, received Tracks will be organized and colored 
according to their respective owner.

Get all Part Info Data 
on Receive

When this is activated, the Inspector settings for all Parts are in-
cluded when you receive a Session.

Receive Audio 
Channel Settings

If this is activated, stored audio channel settings (volume, pan, 
EQ) are automatically included when you receive a session.

Enable Post/Receive 
automatically

This determines what happens when you enter a Rocket Net-
works session. The options are:
• No : To receive the session (download the files) you will have 

to click the Receive button in the Arrange window.
• Yes – Ask : When you enter a new session, you will be asked 

whether you want to receive the session files or not. This is 
probably the most convenient option to choose.

• Yes – Don’t Ask : When you enter a new session, it will auto-
matically be downloaded.

Setting Description
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Activating RocketPower and joining a Session

To activate RocketPower and join an existing session, proceed as fol-
lows:

❐ In this example, we assume that you selected the “Yes – Ask” option for 
the “Enable Post/Receive Automatically” setting in the Rocket Preferences 
dialog.

1. Start with an empty Song.
This is not required, but it will make things less confusing when you receive the 
session.

2. Click the RocketPower button above the Arrange window Ruler.
The RocketControl application launches

3. In the RocketControl window that appears, make sure your username and 
password are correctly entered, and click Connect.
Now, your default web browser launches and takes you to the Steinberg InWire 
Public Sessions on the Rocket Networks web site.

4. When you’re connected, you will automatically go to the “Welcome 
Lobby” session, which is the default session for InWire users.
You can adjust this in the Account settings on the web page if you like.

• In Cubasis VST, you will now be asked whether you want to receive the ses-
sion or not.
Click No for now.

5. To go to another session, locate it in the session list in the browser, and 
click its Go button.
The session list shows you information about the different sessions. You can 
also get details about the current section by clicking the “Session Details” tab in 
the browser.
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Receiving a project

Once you have found an interesting session to join, click Yes when 
you’re asked whether you want to receive. If you clicked No (or if you 
have turned off the automatic receive function altogether in the Rocket 
Preferences), you can click the Receive button in Cubasis VST (next to 
the RocketPower button) to receive the session at any time.

Now the following will happen:

1. Cubasis VST will ask you to specify a folder for the audio files to be re-
ceived.
This will become the folder for your local version of the session.

2. The files will be downloaded.
After the downloaded renderings have been decompressed, they will appear in 
the Audio Pool in Cubasis VST.

3. An alert appears, telling you to save the Song under a new name.

4. Finally, a Save dialog appears. Go to the folder you specified in step 1 and 
save the Song under a new name.

Now, you can try playing back the Song to hear how it sounds – then, 
it’s your turn to add some music! Proceed with recording audio and 
MIDI, just as usual.

❐ Depending on your account type, it may also be possible to create a new, 
empty session. You could then either start from scratch with an empty Cu-
basis VST Song, or upload an existing Song as a starting point.
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The InWire Settings in the Pool

Some items in the Audio Pool are directly related to InWire:

File list

File pop-up menu

Menu item Description

Quality Clicking in this column for a file brings up a pop-up menu showing 
all available renderings. Selecting a rendering will insert it into the 
Arrange window (after downloading it, if it isn’t available locally 
on your own disk).

Broadcast Clicking in this column for a file brings up a pop-up menu, allow-
ing you to specify which renderings should be posted. Renderings 
shown with a check mark will be uploaded when you Post (see be-
low). To turn Posting on or off for a rendering, select it on the pop-
up menu.

Menu item Description

Delete Low Quality 
Renderings

Selecting this item will delete low quality renderings stored locally 
on your computer. These renderings may be received again by se-
lecting them from the Quality popup menu in the File list.

Get Best Quality Select this to receive the best quality renderings available from 
the server, of all files in the Pool.

Post Best Quality Select this to post the source renderings of all files you own (have 
created yourself) in the Pool.
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Posting

Once you have added something that you’re satisfied with, you can 
Post your changes to the session, to make them available to the other 
Session contributors:

1. Set up the Posting options in the Audio Pool (see above).

2. Pull down the InWire menu and select Post, or click the Post button next to 
the RocketPower button.

Your recorded additions are sent. You can stop the posting by selecting Cancel 
Post from the menu, if needed.

❐ If your additions include audio files in the Sound Designer II format, you 
need to convert these to AIFF files before Posting (see page 150)!
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Disconnecting

When you’re finished working, you disconnect from Rocket Networks 
in the following way:

1. Select the RocketControl application.

2. Pull down the File menu and select Disconnect.
You are disconnected, and the login window appears again.

3. Click the Quit button.
RocketControl quits.

4. Quit the web browser as usual.
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What is QuickTime?

QuickTime is an extension to the Macintosh operating system that al-
lows you to play back movies in a window on your Macintosh.

Cubasis VST supports QuickTime, which means that you can have video 
playing on your screen, synchronized with Cubasis VST’s playback.

What can I do with QuickTime in Cubasis VST?

• You can open a QuickTime movie and play it on your screen, synchronized 
with Cubasis VST’s playback.

• You can import an audio track from a QuickTime movie into Cubasis VST.
This allows you to edit the audio data in the movie, cut out unwanted parts, add 
music, etc.

• You can export audio from Cubasis VST and import it into a QuickTime 
movie.
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Playing a movie in sync with Cubasis VST 

Adding the Movie to the Song

1. Pull down the Options menu and select “Setup...” from the Movie Setup 
submenu.
The Setup Movies dialog opens.

2. Click the “Add Movie” button.
The standard QuickTime file dialog appears. This shows a Preview still image of 
the movie to the left. If there is no Preview you can create one for the selected 
Movie file, using the “Create” button.

3. Locate the movie file, select it and click Open.
This adds the movie to the list in the Setup Movies dialog (and to the Song, see 
page 267).
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Opening the Movie

Once you have added a movie, there are two ways to open it on the 
screen:

• In the Setup Movies dialog, select the movie in the list and click Open 
Movie.

Or:

• Pull down the Windows menu and select the movie directly from the Mov-
ies submenu.
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Playing back

• When you activate playback in Cubasis VST, the movie plays back in sync.
• To turn off synchronized playback, deactivate the “Sync” function in the Movie 

window.
• If “Sync” is deactivated and you activate playback in the movie window, only 

the movie will play.

❐ The audio in the movie is not played back when you play the Movie from 
within Cubasis VST.

Positioning

The positions of Cubasis VST and the movie are completely linked (taking 
the Start and Offset values into account, see below). This means that 
when you Fast Forward, Rewind, Locate etc., the movie will be posi-
tioned accordingly. Also, when you perform the same operation in the 
Movie window, Cubasis VST’s song position will move with the Movie’s.
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Setting Start time and Offset

In the Movie window, you will find two additional settings:

Start

Set this to the time position in the song, when you want the movie 
playback to start.

Offset

This offsets the start position inside the movie itself. For example, if the 
first few seconds of the movie show a black screen, you might want to 
skip this section by adjusting the Offset value.

❐ If you press [Option] and click in the Start or Offset field, the values will be 
shown as meter positions instead (bars.beats.ticks). This is makes it easier 
to match the Start value to a specific position in the Cubasis VST song.

Saving the Movie List

When you save the Song, the list of added Movies is saved with it. This 
does not mean that the actual movies are copied into the Song file, only 
that the program keeps track of which Movies were used and where on 
your hard disk(s) they are located.

The Find Movie Feature

If you open a Song containing movies, and one of the movie titles is 
greyed out in the Setup Movies dialog, this means that the program 
couldn’t find the movie in question. For example, you may have re-
named the movie document, moved it to another folder, etc. To “find” 
the movie again, use the Find Movie feature:

1. Select the greyed-out movie in the Setup Movies dialog.

2. Click the Find Movie button.
A file dialog appears, allowing you to re-find the movie.

3. Locate the movie, select it and click open.
Remember to save the Song if you want to keep the new path to the movie.



CUBASIS VST
18 – 268 Movies

About MovieTracks
MovieTracks is a special utility that allows you to import and export au-
dio data from and to QuickTime movies. This allows you to edit the ex-
isting audio data, add music to a dialogue or add sound to a movie that 
didn’t contain any sound to begin with.

On the following pages, we will first explain how this utility works, and 
then outline an example of its practical use.

❐ For this feature to be available, the file MovieTracks must be in the Cuba-
sis VST folder. The file is automatically placed there during installation; 
just make sure you don’t move or delete it.

Opening a movie in the MovieTracks window

1. Pull down the Options menu and select “MovieTracks…” from the “Movie 
Setup” submenu.
The following window appears.

2. Pull down the “Movie Track Functions” pop-up and select Open Movie.

3. Locate and open the movie.
It appears in the left part of the window, from where you can play it back, like in 
any QuickTime window.

This menu is used for selecting a track 
in an open movie.

This menu contains a number of functions.

This area displays the movie.
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The Controls in the MovieTracks windows

Movie panel

On the left side of the window, a regular QuickTime panel allows you to 
play the movie.

Tracks pop-up

This is used to select one of the Tracks in the movie (the video track, the 
audio track, etc.). Whatever changes you make with switches and sliders 
will only affect the track selected here.

Active checkbox

This is used to turn on/off the selected track. When a track is deacti-
vated, it will not play. When you save the movie you also have the op-
tion of excluding deactivated tracks, see below.

Sliders

These allow you to make adjustments to the track selected with the top 
(Tracks) pop-up. Any changes you make will only affect this track. For 
large changes, drag the handle with the value. For smaller changes, 
click the “+” or “–” buttons.

Name Description

Offset This allows you to make a track start later than the others. This is useful to 
for example make adjustments to a narration or music track that doesn’t 
play “in sync” with the video.

Volume This only applies to audio tracks, and allows you to adjust its playback 
level.

Balance/Pan This only applies to audio tracks and allows you to adjust the stereo bal-
ance of an audio track (left/right).
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Movie Track Functions pop-up

This menu contains the following options:

• Open Movie
This presents you with a regular QuickTime Open dialog, that allows you to 
open any QuickTime movie file you have on your disks.

• Save Movie
This allows you to save the movie, including the changes you have made in 
MovieTracks. See page 273 for details.

• Import Audio
This allows you to add an audio track to your movie. This can either be a sepa-
rate audio file or you can extract the audio from another movie. See page 272 
for details.

• Export Audio
This allows you to export an audio track in a movie into a separate audio file. 
See page 271 for details.

• Remove Track
This removes the selected track from the movie, altogether.
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Extracting Audio Data from Movies (Export Audio)

MovieTracks allows you to export any audio track in a QuickTime movie 
and convert it into a regular audio file that can be imported into Cubasis 
VST.

The file is saved in AIFF format (the standard audio file format on the 
Macintosh). Options in the dialog allow you to control the sample rate 
and bit resolution of the file. The main reason to change any of these 
values is if you want to use the files in a program that requires certain 
sample rates and resolutions (Cubasis VST does, see below).

Proceed as follows:

1. Make sure the correct audio track is selected on the Tracks menu.

2. Pull down the “Movie Track Functions” pop-up and select Export Audio.

3. Specify a location and name for the file and set the following options:

4. Click Save.
The new file is created on your hard disk.

Option Description

Export in original format This saves the file in AIFF format, without changing the sam-
ple rate or bit resolution.

Export and Convert to... This saves the file and adapts its sample rate and resolution 
to the standard values for Cubasis VST. Use this option if you 
want to import the files into Cubasis VST.

Export as: This allows you to select from a number of sample rates and 
from the two possible bit resolutions, using pop-ups.

An audio track selected.
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Adding Audio to Movies (Import Audio)

If you have prepared an audio file in Cubasis VST or other program you 
can import it into an existing movie.

• The file must be in AIFF format (the standard audio file format on the Ma-
cintosh).

• Any sample rate is allowed.
If you like, MovieTracks can convert the sample rate when importing it. See next 
page.

• The file can be in 8 or 16 bit format.

• The file will appear as a new track which gets added to the existing audio 
tracks in the movie file.

Proceed as follows:

1. Pull down the “Movie Track Functions” pop-up and select Import Audio.

2. Fill out the options, as follows:

3. Locate the file and click Open.
The file gets added to the movie as a new track. 

If required, you can now select the track and make adjustments to its 
volume, stereo balance and starting point, as described on page 269.

Option Description

Import in original format This adds the file as a new track, without changing the sam-
ple rate or bit resolution.

Import and Convert to... This adds the file as a new track and adapts the sample rate 
and bit resolution to the existing audio track(s) in the movie.

Import as: This allows you to select from a number of sample rates and 
from the two possible bit resolutions, using pop-ups.
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Saving a Movie

When you save a movie, the following information is included:

• Any track you have imported since you opened it. 
You can decide not to save deactivated tracks, see below.

• Any setting changes you have made to the tracks (offset, volume etc.)

Saving

1. Pull down the “Movie Track Functions” pop-up and select Save Movie.

2. Find a location for the file, enter a name and fill out the options as follows:

3. Click Save.
The new file is created on your hard disk.

Option Description

Save as self contained.../
Save normally...

A self contained movie contains all the information needed 
for playing it back, in one file. A file with dependencies, on the 
other hand, might be “assembled” from other files. Normally, 
you would choose “self contained”. For more information 
about this, see the Apple QuickTime documentation.

Make PC compatible 
movie.

If this movie will ever be played back on a QuickTime equipped 
PC computer, make sure this check box is activated when you 
save.

Disable playback 
optimizations:

When this is activated, editing the movie will be faster, but 
playback may be “jumpier”. If this is the final edit of the 
movie, make sure this option is deactivated.

Only save active Tracks: When this is checked, only the tracks that are activated in the 
MovieTracks window, will be saved.
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Editing the audio for a movie – An example

To get an idea of how the various options in Cubasis VST can be used to 
edit and add audio to a movie, please read the following example:

Let’s say you have recorded a movie with a video camera and trans-
ferred it to your Macintosh computer. This contains some dialogue re-
corded together with the pictures. Now you want to add some 
background music. Proceed as follows:

1. Open the movie in MovieTracks, and export the audio track, using the op-
tion that converts the sample rate set in Cubasis VST.

2. Import the newly created audio file into a Track in Cubasis VST.

3. Set up a movie playback window that plays back the video in sync with the 
Song.

4. Create the music tracks.
If you are using MIDI sound sources (as opposed to audio recordings and VST 
Instruments), you need to record the sound from the MIDI instruments on au-
dio Tracks before you make the final mix.

5. Set up a final mix for all the audio (both the dialog and the music).

6. Use the Export Audio Tracks command in Cubasis VST to convert the en-
tire Arrangement to a single audio file.
Make settings for the audio file according to the specifications on page 272. 
The Export Audio Tracks feature is described on page 233.

7. Use the MovieTracks window to remove the existing audio track from the 
movie and replace it with the file you just created (by importing the new 
file).

8. Make any adjustments you find necessary.

9. Save the movie in self contained format.
It will now play back with new audio, complete with music and edited dialog.
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Saving

Once you have created some music of your own, you’ll probably want to 
save it to your hard disk. When you save your music in Cubasis VST, there 
are three document formats you can use for saving your music: Song, Ar-
rangement or MIDI File. You should only choose MIDI Files if you want 
your music (MIDI only – no audio) to be playable in other sequencers. If 
you want to save your music for further use in Cubasis VST, you should 
use either the Song or the Arrangement format:

Song

When you save a Song, the following is saved:

• All the Arrangements.
• All settings in the dialogs, on the Transport Bar, etc.
• The Pool, all audio settings and audio file references (but not the actual audio 

files themselves).
• The settings in the VST and MIDI Track Mixer windows.

Arrangement

When you save an Arrangement, the following is saved:

• All the things you see in one Arrange window; the Tracks, the Parts, Inspector 
settings, tempo, etc.

• The audio file references for the audio Parts used in the Arrangement.

The Arrangement format is often perfectly adequate for saving a piece 
of music. The pros and cons of both formats are shown in the table on 
the next page:



CUBASIS VST
Saving and Opening 19 – 277

❐ Even though the Song files contain all audio references, they do not con-
tain the actual audio files! If you want to transfer a Song containing audio 
to another computer, you need to move the audio files as well.

Performing the Save

1. Pull down the File Menu and select “Save As...”.
The file dialog appears.

2. Use the standard controls to navigate to the desired folder.

3. Use the file type pop-up to select a format, Song or Arrangement.

4. Type in a name for the file.

5. Click Save.

File Format Advantages Disadvantages

Arrangement • Takes up little disk space.
• Can be saved, and opened in 
another Song, which is an easy way 
to transfer music between different 
Songs.
• Does not contain “unnecessary” 
settings if all you want to save is the 
music.
• Opening an Arrangement does not 
affect settings in dialog boxes and on 
menus, which, in some situations, is 
an advantage.

• Does not contain any audio set-
tings, other than the audio file ref-
erences used in the Arrangement.
• Does not contain a complete 
“snapshot” of the program’s “state”.

Song • Contains the complete Pool and all 
other audio settings.
• Contains more than one 
Arrangement.
• Saves all the settings on all menus, 
in all dialog boxes etc.

• Takes up more disk space than the 
Arrangement file format, even if 
you only have one Arrangement in 
the Song.
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Using “Save”

On the File menu you will find a menu item called “Save”.

• If you have already saved your Song once (using “Save As...”) this menu com-
mand will save your Song without asking for a file name and location. The file 
you save now will simply overwrite the earlier version.

• If you have not yet saved your Song, selecting “Save Song” is the same as select-
ing “Save As...”.

The “Save Song” command can also be executed by pressing 
[Command]-[S] on the computer keyboard.

Opening

Just as with saving, Cubasis VST can open three different file types: 
Songs, Arrangements and MIDI Files. Opening MIDI Files which is useful 
if you import music created in other sequencers, is done with the “Im-
port MIDI File…” command, described later in this chapter. This section 
describes how to open Songs or Arrangements.

1. Select “Open...” from the File menu.
The Open dialog appears.

2. Use the file type pop-up to select which type of file you want to open, Song 
or Arrangement.

3. Navigate to the desired folder.

4. Select the file and click Open.

About opening Songs

There can only be one Song open at a time. If the currently open Song 
contains unsaved changes, you will be asked whether you want to save 
the current Song first. 

About opening Arrangements

If the file is an Arrangement, it will appear as a new window on screen, 
in addition to any Arrange windows already open. You can have up to 
16 Arrangements open at the same time.
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About the default Song

Each time you launch Cubasis VST, a default Song called “Autoload” is 
opened. This makes it possible to customize the default functionality 
and layout of the program:

1. Launch the program. 

2. Set up the program as you want it.
This may include the number and organization of Tracks, MIDI setup, Metro-
nome settings, Audio settings, etc.

3. Select “Save as…” from the File menu.

4. Make sure “Song” is selected on the file type pop-up menu.

5. Navigate to the Cubasis VST program folder.

6. Type in the name “Autoload” (without the quote signs) and click Save.
You will be asked if you want to replace the current Autoload file. Click Yes.

Next time you launch Cubasis VST, you will automatically get your de-
sired setup and layout.

About the New Song command

When you select New Song from the File menu in Cubasis VST, the fol-
lowing happens:

1. If you have unsaved changes in the current Song, you are asked whether 
you want to save it or not.

2. Then, a file creation dialog opens, allowing you to select a folder and spec-
ify a name for your New Song file.

3. An empty Song with the specified name is created, together with a subfolder 
called “XXX.Audio” (where “XXX” is the name of the new Song).

The new Song is set up according to the Autoload Song, with the new 
Audio folder selected as Audio Files Folder. 
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Exporting MIDI Files 

You might want to export an Arrangement as a Standard MIDI File, so 
that it can be loaded into other computer programs or hardware se-
quencers, for example.

❐ A Standard MIDI File contains MIDI data only – no audio. Any Audio Tracks 
in your Arrangement will automatically be excluded from the created 
MIDI file.

1. Mute all the Tracks you don’t want to be included in the MIDI File.

2. Make sure the Song runs at the correct tempo.
The Master button should be activated on the Transport Bar, since the exported 
MIDI File will get the tempo stored in the Master Track.

• The Part Parameters set up in the Inspector (volume, transpose, program 
change, etc.) are automatically converted to “real” Events and values in 
the exported MIDI file.
This way, the MIDI file will play back like the original Cubasis VST Song, as far as 
possible.

3. Pull down the File menu and select “MIDI File...” from the Export submenu.
The file dialog appears.

4. Select a name and location for the file.
If you want to be able to import the MIDI file into PC-based programs, you 
should give it the extension “.MID”.

5. Click Save.

6. In the alert box that appears, specify whether you want the exported MIDI 
file to be of format 0 or 1.
MIDI files of format 0 contain only one Track, that plays back on several MIDI 
channels. In MIDI files of format 1, the Track structure is preserved. 
Which format to select depends on in which applications and devices you want 
to use the MIDI file later – format 1 is the preferred choice, but some sequenc-
ers can only read format 0 files.
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Importing MIDI Files

1. On the File menu, select “MIDI File...” from the Import submenu.
The file dialog appears.

2. Locate the file and select it in the file list.

Cubasis VST recognizes files as MIDI Files if they meet one of two criteria:

• The file is a Macintosh file with the file type “Midi” (the standard file type for 
MIDI File on the Macintosh).

• The file has the extension “MID” (the standard MS-DOS extension for MIDI 
Files).

3. Click Open.

4. In the dialog box that appears, decide if you want the file to appear in a 
new Arrange window or if you want to merge the MIDI File into the current 
Arrangement.
If you choose the latter option, the file will appear in the current Arrangement, 
starting at the Left Locator position.

When importing MIDI Files, the data is automatically split up into 
shorter segments (Parts) to make it easier to edit the music in the 
Arrange window.
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B

Bank Select 97
Bouncing Audio Files 233
Brush Tool 163

C

Cancel 197
Channel

Audio 75
MIDI 92, 173

Clean Lengths 183
Clef 182
Click 74, 109
Clipping

About 80
Indicators 200

Collapse 133
Comment (Score Edit) 187
Controller Display

Key Edit 166
List Edit 176

Controllers
Creating 170
Deleting 129
Editing 171

Convert SDII to AIFF 150
Copy 124, 192
Copyright (Score Edit) 187
Create

Continuous Events 170
Notes 162
Parts 159
Tracks 114

Create File 233
Cut 124, 192
Cut At Locators 125
Cycle

About 107
Recording in 108
Restricting Editing to 190

D

Defragmenting 28
Delay

In Monitoring 44
MIDI to Audio 88
Playing VST Instruments 239
VST Effect 210

Delete
All Events 191
Audio Files (Permanently) 84
Parts 122
Segments 145

Delete Cont. Data 129
Delete Doubles 129
Delete Unused Files 139
Digital Recording 43
Disable Audio 46
Disable Monitor 45
Display Quantize 181
Display Transpose 182
Double Click Opens 160
Drag and Drop 148
Duplicate

Events 164
Parts 119
Segments 144
Tracks 115

E

Edit Solo 192
Editing via MIDI 194
Editors

About 159
Closing, Cancelling Changes 197
Closing, Keeping Changes 197
Opening 160

Effects
About 205
Editing 208
Sends 207
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Enable Monitor 45
Enharmonic Shift 185
EQ Button 204
Equalizer 204
Erase Unused 146
Eraser Tool

Arrange Window 122
Editors 165

Events
Creating in List Edit 173
Duplicating 164
Moving 163
Scrubbing 190
Selecting 163, 189

Expand 133
Export Audio File 233
Export MIDI File 280
Exporting Files and Segments 150

F

Fill 191
Flat Beams 183
Flip Stems 185
Follow Song 192
Freeze Play Parameters 126

G

General MIDI See GM
Ghost Parts 123
Glue Tube tool

Arrangement 121
Score Edit 186

GM
About 13, 225
Names in Inspector 94

GS
About 226
In MIDI Track Mixer 221

I

Import Audio File
Arrangement 228
Pool 149

In/Out Indicators 54
Info Line 191
Input Level Meters 80
Inputs

Activating 72
Selecting for Recording 77

Insert At Locators 125
Insert Effects 205
Inspector 126
Installation 34

J

Joining Notes 186
Joining Parts 121

K

Keep 197
Keep Appended Events 197
Key (Score) 182
Key Caps Play 239
Key Edit

About 161
Creating Events 162

L

Latency
About 41
Monitoring 44
VST Instruments 239

Launch External Wave Editor 156
Levels

Audio 199
MIDI Track Mixer 217

Line Tool 168
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List Edit
About 172
Columns 173
Insert pop-up menu 173
Value 2 Display 176

Load Pool 154
Local On/Off 53
Locators

About 106
Moving Song Position to 107
Setting up the Cycle 107

Loop
About 196
Restricting Editing to 190

M

M Column 116
Master Button 104
Master Track 104
Memory Requirements 26
Meter Position 102
Metronome Dialog 109
Microphone 37
MIDI

About 13
Connecting 47
In/Out Indicators 54
Recording 96
Selecting Sounds 94

MIDI Channel
Setting for Recording 92

MIDI Connector Button 194
MIDI File Import and Export 280
MIDI Input 194
MIDI Output 92
MIDI Thru 53
MIDI to Audio Delay 88

MIDI Track Mixer
About 215
Automating 223
Levels 217
Pan 217

Mixer
Audio (VST Channel Mixer) 199
External 38
MIDI Track Mixer 215

Mixing Down to File 233
Monitoring 44, 79
Mono

Audio Channels 75
Audio Track 76
Master Section 202

Move
Notes 163
Parts 119
Tracks 115

Movies
Exporting Audio from 271
Importing Audio into 272
Playing Back 266
Setting Up 264

MovieTracks 268
MP3 149, 228
Mute

MIDI Track Mixer 218
Track 116
VST Channel Mixer 203

N

Neon Synthesizer 240
New Song 112, 279
No Beams 183
No Overlap 183
Note Info Line 191
Note Tool 184
Number of Channels 43
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O

OMS
Installation 31
Patch Names 55
Settings 51

OMS Patch pop-up menu 94
Open

Arrangement 278
Song 278

Optimizing the Hard Disk 28
Output (MIDI) 92
Overdubbing

Audio 85
MIDI 96

P

Pan
Inspector 127
MIDI Track Mixer 217
VST Channel Mixer 202

Part Display 16
Parts

About 83
Audio-Overlapping 84
Copying 124
Creating 159
Deleting 122
Duplicating 119
Joining 121
MIDI-Overlapping 96
Moving 119
Repeating 122
Resizing 119
Selecting 118

Paste 124, 192
Patch Name pop-up menu 94

Pencil Tool
Arrangement 119
Editors 164, 173
List Edit 176

Pitch Bend
Creating 170
Editing 171

Play Through 
("Direct" Audio Monitoring) 42

Pool See Audio Pool
Position Format 102
Position Slider 103
Precount 109
Prg Setting 97
Printers 33
Program Change

Display Setting 97
Inspector 127
Sending 94

Purge Segments 145

Q

Quantizing 128
Quick Start Song 57
QuickTime See Movies

R

RAM 26
Read Button

MIDI Track Mixer 224
VST Channel Mixer 214

Record SysEx 99
Recording Levels 80
ReCycle Files 229
Repeating Parts 122
Resizing Notes 164
Roland GS 226
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S

Sample Rate 73
Save

Arrangement 276
Pool 154
Song 276

Scissors tool
Arrangement 120
Score Edit 186

Score Edit
Deleting Notes 186
Moving Notes 185
Transposing Notes 185

Scrubbing 190
Segments

About 133
Auditioning 143
Changing Start and End Insets 

144
Creating in Audio Pool 139
Deleting 145
Deleting Unused 145
Dragging into 

Arrangement 151
Duplicating 144
Exporting 150
In the Pool 137
Renaming 144

Select Audio File Folder 78
Selecting

Audio File in Pool 138
Events 163, 189
Parts 118
Segment in Pool 144
Tracks 115

Send Effects 205
Set Aside (Arrangement) 112
Shuffle (Score) 183
Smooth Segments 85, 231

Snap value 117
Solo

Edit Solo 192
MIDI Track Mixer 218
Track 116
VST Channel Mixer 203

Song
Creating 112
Opening 278
Saving 276

Song Position Pointer 102
Spark LE 156
Speaker Icon 190
Speaker Tool

Arrangement 121
Editors 190

Split (Piano) Staff 180
Split At Locators 125
Splitting Notes 186
Staff Mode 180
Start and End Insets

Changing in Audio Pool 144
Stereo

Audio Channels 75
Audio Track 76
Master Section 202

Syncopation 183
System Exclusive 99

T

Tempo 74, 104
Text (Score Edit) 186
Thru

Audio 79
MIDI Setting 53

Ticks 102
Time Signature 74, 104
Title (Score Edit) 187
To Pop-up Menu 190
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Tools
Arrangement 118
Editors 160

Track Mute Events 175
Tracks

About 113
Creating 114
Muting and Soloing 116

Transport Bar
About 101
Hiding and Showing 101

Transpose 127
Transposing Notes (Score) 185

U

Undo Quantize 129
Undo/Redo 12
Universal Sound Module 249

V

VB-1 245
Velocity

Creating Ramp 168
Editing in Key Edit 166
Editing in List Edit 176
Editing via MIDI 194
Inspector Setting 127

Virtual Memory 28
Volume

Inspector 127
MIDI Track Mixer 217
VST Channel Mixer 200

VST Channel Mixer 199

VST Instruments
Activating 237
Automating 242
Editing 240
LM-9 247
Mixing 241
Neon 243
Playing 238
Selecting Patches 240
Universal Sound Module 249
VB-1 245

VST Performance 204

W

Wave Editor 156
Wave Images 142
Write Button

MIDI Track Mixer 223
VST Channel Mixer 213

X

XG
About 226
In MIDI Track Mixer 220

Y

Yamaha XG 226


	Table of Contents
	Introduction
	Welcome!
	About Cubasis VST...
	How you can reach us

	Guided Tour
	What is Cubasis VST?
	What is Digital Audio?
	What is MIDI?
	The Main Windows in Cubasis VST

	Requirements
	Minimum Requirements
	Computer Requirements

	Installation
	Getting the Computer ready
	Preparing the Computer for MIDI and Audio work
	Installing Additional Audio Hardware
	Installing a MIDI Interface
	About Printers
	Installing the Software
	Register your software!
	Installation done! Where do I go next?

	Setting up your System
	Making Settings for Audio work
	Enabling/Disabling Audio
	Setting up for MIDI
	MIDI Settings in Cubasis VST
	OMS : Setting up for General MIDI Patch Names

	Quick Start
	About this Chapter
	Opening the Quick Start Song
	Playing Back
	Muting and Soloing Tracks
	Activating the MIDI Tracks
	Changing the Sound and Level of a MIDI Track
	Setting the Levels of the Audio Tracks
	Adding an Effect
	Using a VST Instrument
	Checking Out the Arrange Window Toolbox
	Closing Up

	Recording Audio
	Preparations
	Selecting and setting up a Track
	Performing the first recording
	Recording more on the same Track
	Recording the Next Track – Overdubbing
	Recording from Play mode – Punch In
	Advanced: Recording Multiple Audio Channels
	If you get Audio Performance Problems

	Recording MIDI
	About this Chapter
	Preparations
	Advanced: Program Change and Bank Select
	Advanced: Recording SysEx Messages

	Playback, Tempo and the Transport Bar
	The Transport Bar
	About Position Values
	Setting the Song Position
	Tempo and Time Signature Handling
	Locators
	About the Cycle

	Arrangement Editing
	About Songs and Arrangements
	About Tracks, Parts and Arranging
	Creating and Managing Tracks
	Mute and Solo
	Working with Parts
	Editing the Arrangement Structure
	Using the Inspector
	Quantizing MIDI notes
	Other MIDI Functions

	Using the Pool
	What is the Pool?
	Opening the Pool
	Viewing Files and Segments
	Customizing the View
	Finding Out how a Segment is used in the Song
	File Operations
	Handling “Missing Files”
	Creating Wave Images and keeping them up to date
	Segment Operations
	Deleting Unused Portions of Audio Files (Erase Unused)
	Importing Files into the Pool
	Exporting Files and Segments
	Dragging from the Pool to the Arrange window
	Saving and Loading the Audio Pool

	Editing Audio
	About the different Audio Editing methods
	Editing in Spark LE

	Editing MIDI
	What can I do with the MIDI Editors?
	Opening an Editor
	About Editor Tools
	Key Edit
	List Edit
	The Score Editor
	Common settings and functions
	Closing the Editor

	Mixing
	Introduction
	Mixing Audio
	Mixing MIDI
	What is GM/GS/XG?

	Importing and Exporting Audio
	Importing audio files into the Arrangement
	Importing Audio using “drag and drop”
	Importing ReCycle Files
	Mixing down to an audio file

	Using VST Instruments
	Introduction
	Activating a VST Instrument
	Playing the VST Instrument
	Selecting Patches and making Settings
	Making Mixer Settings
	Automating a VST Instrument
	The Neon
	VB-1
	LM-9
	Universal Sound Module (USM)

	InWire and RocketPower
	Introduction
	What do I need?
	Basic Terminology
	Setting Rocket Preferences in Cubasis VST
	Activating RocketPower and joining a Session
	Receiving a project
	The InWire Settings in the Pool
	Posting
	Disconnecting

	Movies
	What is QuickTime?
	What can I do with QuickTime in Cubasis VST?
	Playing a movie in sync with Cubasis VST
	About MovieTracks
	Opening a movie in the MovieTracks window
	The Controls in the MovieTracks windows
	Extracting Audio Data from Movies (Export Audio)
	Adding Audio to Movies (Import Audio)
	Saving a Movie
	Editing the audio for a movie – An example

	Saving and Opening
	Saving
	Opening
	Exporting MIDI Files
	Importing MIDI Files

	Index

